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GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — 
Broadcasters — Content creators of every genre — Just finished an incredible project and want to 
share it with the world?
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Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid 3D User’s Guide• 0130-06217-01 • June 2004
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Using This Guide

Congratulations on your purchase of the Avid 3D software. You can use 
Avid 3D to create, customize, and animate 3D content, visual effects, text and 
titling for your productions.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware that 
are covered in the documentation.

This guide is intended for all Avid 3D users, from beginner to advanced. This 
guide contains the conceptual information and task-oriented instructions you 
need to create 3D animation and effects in Avid 3D.
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Symbols and Conventions

Avid 3D documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, 
reminders, recommendations, and strong suggestions.

c A caution means that a specific action you take could 
cause harm to your computer or cause you to lose data.

w A warning describes an action that could cause you 
physical harm. Follow the guidelines in this document 
or on the unit itself when handling electrical 
equipment.

> This symbol indicates menu commands (and 
subcommands) in the order you select them. For 
example, File > Import means to open the File menu 
and then select the Import command.

t This symbol indicates a single-step procedure. 
Multiple arrows in a list indicate that you perform one 
of the actions listed.

Margin tips In the margin, you will find tips that help you perform 
tasks more easily and efficiently.

Italic font Italic font is used to emphasize certain words and to 
indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Bold font Bold indicates a user interaction.

Ctrl+key or mouse action Press and hold the first key while you press the last 
key or perform the mouse action. For example, 
Shift+Alt+C or Ctrl+drag.
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If You Need Help

If you are having trouble using Avid 3D:

1. Retry the action, carefully following the instructions given for that task in 
this guide. It is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after 
the documentation was published in one of two locations:

- If release notes are available, they ship with your application.

- If ReadMe files are available, they are supplied in your Avid 
application folder. ReadMe files are also available from Help.

n Release notes and ReadMe files are also available from the Knowledgebase.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. Visit Avid Online Support at www.avid.com/support. Online support is 
available 24 hours per day, 7 days per week. Search the Knowledgebase to 
find answers, to view error messages, to access troubleshooting tips, to 
download updates, and to read/join online message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

Accessing the Online Library

The Avid 3D Online Library contains all the product documentation in PDF 
format as well as a selection of movies for getting started. Avid recommends 
the movies as your first resource for learning how to use your application.

n You will need Adobe® Acrobat® Reader® installed to view the documentation 
online. You can download the latest version of the Reader from the Adobe® 
Web site.

To access the documentation from the Online Library:

1. Insert the Online Library into the drive.

2. Double-click the Mainmenu file.
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How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local 
Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call Avid Sales 
at 800-949-AVID (800-949-2843).



Chapter 1
Getting Started

Provides information about the various options for starting the Avid 3D 
application and creating your first project.
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Starting Avid 3D

There are several ways to start Avid 3D:

• Using the Windows Start menu.

• Using the command line.

• Using the Avid 3D shortcut on your desktop.

Starting with the Windows Start Menu

If you installed in the default configuration, you can start from the Windows 
Start menu in the lower-left corner of the Windows desktop. To do this:

t Choose Start > All Programs > Avid > Avid 3D.

Starting from the Avid 3D Shortcut
t Start Avid 3D by double-clicking the shortcut on your desktop. 

The shortcut runs a Windows batch file called 3d.bat that sources an 
environment script and then starts the application executable called 
3d.exe. By default, the batch file is located in the c:\Program 
Files\Avid\Avid3D_v1\Application\bin folder.

To modify a shortcut by specifying startup options:

1. Right-click on the shortcut icon and choose Properties. 

2. On the Shortcut tab of the Shortcuts dialog box, add any desired options to 
the command line in the Target text box. Make sure the entire command, 
including the options, are enclosed inside quotation marks.

For more information about the desktop, shortcuts, the Windows Explorer, and 
folder windows, please see your Windows operating system documentation.
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Starting from the Command Line

You can start Avid 3D from the command line. This is useful if you want to 
specify startup options. See “Avid 3D Startup Options” on page 31.

To start from the Avid 3D command line:

1. Open an “SI Command Prompt”. If your Start menu is in its default 
configuration, you can choose Start > All Programs > Avid > Avid 3D > 
Command Prompt.

2. To start without any options, type:

3d

To start from the Windows command line:

t If you use a standard Windows command prompt to start Avid 3D, 
navigate to the Avid 3D program directory (by default, c:\Program 
Files\Avid\Avid3D_v1\Application\bin) and type:

3d.bat

Once Avid 3D has started, you can exit the command prompt window at 
any time.

Avid 3D Startup Options

Startup options can be used when starting Avid 3D from the command line. To 
get a list of command-line options you can use when starting Avid 3D, type:

3d -h

Usage

3d [-autoloadmedia <mediapath>][-autoloadtype <mediatype>]
[-uilang <languageid>][-helplang <languageid>]
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Command Line Options

-autoloadmedia <mediapath>

Set the media path to be loaded upon startup. For use with Avid Xpress 
Pro’s Send To export settings. Do not modify.

-autoloadtype <mediatype>

Set the media type to be loaded upon startup. For use with Avid Xpress 
Pro’s Send To export settings. Do not modify.

-uilang <languageid>

Specifies the language of the Avid 3D user interface: en for English or jp 
for Japanese. 

-helplang <languageid>

Specifies the language for the online help: en for English or jp 
for Japanese. 

Creating the First Project

The first time you run Avid 3D, you are automatically working in an empty 
“Untitled” scene in the AVID3DMEDIA project. 

t To create a new project in which to store your own scenes, choose File > 
New Project from the main menu.

t To add an existing project to your project list, choose File > Project 
Manager from the main menu.

For more information about working with projects and scenes, see “Managing 
Projects and Scenes” on page 35.
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Exiting Avid 3D

After you have completed your work session in Avid 3D, save your work 
and exit.

To exit:

1. Do one of the following:

t Choose File > Exit from the main menu.

t Click the close icon (×) at the far right of the title bar.

t Press Alt+F4.

2. If you have made any changes to the scene, you are prompted to save them 
before exiting. Click one of the following:

t Yes to save your changes. For more information about saving scenes 
in general, see “Saving Scenes” on page 44.

t No to exit without saving.

t Cancel to continue working.
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Chapter 2
Managing Projects and Scenes

In Avid 3D you build scenes that are stored in a folder structure called a project. 
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Types of Projects and Scenes

In Avid 3D you build scenes that are stored in a folder structure called a 
project. The scenes you build will be essentially of two types: a scene that uses 
a fixed camera or a scene that uses a free camera.

Fixed-Camera Scenes

Fixed-camera scenes, not surprisingly, feature a camera that is fixed in place. 
Typically, fixed-camera scenes are already set up with a backplate positioned 
so that the image fills the camera’s field of view. A second camera may be 
available for accurately positioning objects, but the scenes is ultimately 
rendered from the point of view of the fixed camera. Fixed-camera scenes are 
ideal when creating 3D DVEs or animated bugs.

The perspective camera and orthographic camera rigs are just two examples of 
fixed-camera scenes. Both can be found in the object library under Cameras.

Free-Camera Scenes

Free-camera scenes allow unrestricted camera movement within the 3D world. 
All scenes created from the File > New Scene menu are, by default, free-
camera scenes.

Because free cameras can be pointed anywhere, you usually need to keep the 
scene’s surrounding background in mind. The Avid 3D library includes two 
kinds of backgrounds: environments and environment maps.

Environments are spheres, large enough to contain even the most elaborate 
scenes, with an image (such as a starfield or a cloudy sky) projected on their 
interior. You can also illuminate specific areas of environments to achieve a 
particular effect. They can be found under Environments in the object library.

Environment maps are images applied to the scene itself. Unlike 
environments, they do not need illuminating, they can provide their own 
lighting. Environment maps are ideal for creating image-based lighting effects 
or for setting up blue and green screen projects. However, scenes with 
environment maps take longer to render. They are found under Scene > 
Environment in the material and fx library. 
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Projects

In Avid 3D you always work within the structure of a project. Projects are a 
system of folders that contain the scenes that you build and all the external files 
that are referenced in the scenes. A project can contain an unlimited number of 
scenes. Scene files can be recognized by their .scn filename extension.

Projects are used to keep your work organized and provide a level of 
consistency that can be used to simplify production with a team.

The Project Manager

The Project Manager is the tool that lets you manage multiple projects and 
scenes. You can create new projects and scenes, open existing projects and 
scenes, scan your system for projects, and add and remove projects and scenes 
from a list of projects. To work in Avid 3D, you must create a project or open 
an existing one.

To open the Project Manager:

t Choose File > Project Manager from the main menu.

The Project Structure

A project is a system of folders that store and organize the different elements 
of your work.

A set of subfolders are created in every new project. The browser opens by 
default to these folders when opening, saving, importing or exporting specific 
scene elements. Not all the subfolders are used when creating content in 
Avid 3D. The table below lists the folders used by Avid 3D and describes the 
type of files that get stored in them:

Project folder Type of files stored

Audio Audio clips used for synching.

Backup Backed up scene files with the backup version appended to the file 
name. See “Backing Up and Recovering Your Work” on page 47.

dotXSI Exported ascii format dotXSI files (*.xsi).
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Creating a New Project

When you start Avid 3D, the last project you worked with is opened and an 
empty “Untitled” scene is created. If no project exists or you are running 
Avid 3D for the first time, the default project is opened and an empty 
“Untitled” scene is created. You can create a new project at any time while 
working in Avid 3D.

To create a project:

1. Do one of the following:

t If you are already working in Avid 3D and want to create a new 
project, choose File > New Project from the main menu to display 
the New Project dialog box. 

t If the Project Manager is open, click the New Project button to 
display the New Project dialog box.

2. In the Project Name text box, enter a unique name for your project. 

3. In the Location text box, edit the path of the folder to which you would 
like the project to be saved. 

c Store your projects in any convenient location outside the Avid 3D 
directory structure. This way, if you reinstall or upgrade Avid 3D, you do 
not run the risk of deleting your work.

4. In the Project Manager, click New Scene to create a new scene for 
your project.

Models Exported models (*.emdl).

Pictures Texture images and sequences.

Render_Pictures Rendered frames.

Scenes Scene files (*.scn).

Simulation Generated simulation files for particles (*.ptp). Although you can 
save .ptp files anywhere, it is recommended that you use a standard 
location.

System Hidden system folder used to identify the project. If this folder is 
removed or modified, the project will be invalid.

Project folder Type of files stored
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Opening an Existing Project

To open a project:

1. From the main menu, choose File > Project Manager.

All projects stored in the project list are displayed in the Select a Project 
pane of the Project Manager dialog box.

2. Click on a project name in the Select a Project list box.

If you do not find the project you need in the displayed list, click the Scan 
Disk button and select a folder to scan for projects.

3. In the Select a Scene list box, double-click on a scene in the project you 
wish to work on.

Maintaining Project Lists

If you work with numerous individual projects, you may find that sometimes 
some projects are relevant to your work, and others are not. Project lists in the 
Project Manager let you access the projects you need with the click of a mouse.

To build and maintain project lists:

1. Choose File > Project Manager from the main menu to open the 
Project Manager.

2. In the Project List controls, click one of the following:

t Add Project adds a project to the project list.

t Remove from List removes a project from the project list. This does 
not delete the project.

t Scan Disk opens a browser that lets you search for more projects in 
the specified directories.

t Clear List removes all projects from the list. Use this command if 
you want to switch to another list.

t Import List opens a browser that lets you search for a project list file 
containing a list of projects and their associated paths. These project 
names are added to any existing projects in the project list.

t Export List creates an ASCII text file containing the path and name 
of each project currently displayed in the project list. You can then 
use Import List to access and display these projects.
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Managing Invalid Projects

A project can become invalid if it is moved to another location, if its hidden 
system sub-folder is deleted or altered, or if the project folder is renamed. In 
these cases, the Project Manager can no longer identify the project from the 
path information specified in its project list.

The Project Manager does not automatically remove an invalid project from its 
project list. Instead, the project is labelled as Invalid and you can choose to 
delete the project or rescan to locate it and add it back to the project list.

Setting a Default Project

If you work with a particular project most of the time, you can set it as the 
default project. The default project is opened automatically when you start 
Avid 3D. It is also the first project specified in the project list.

To set the default project:

1. Choose File > Project Manager from the main menu.

2. Select the project you want to make the default.

3. Click Set as Default.

Deleting Projects

You cannot delete the project in which you are currently working. To delete 
your current project, you must close it, open another project, then delete the 
project in the Project Manager.

You cannot delete a project that is set as the default project. You must set 
another project as the default, then delete the project in the Project Manager.

To delete a project:

1. Choose File > Project Manager from the main menu.

2. Click the name of the project to be deleted from the Select a Project pane.

3. Click the Delete Project button to delete the selected project.
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Scenes

A scene file contains all the information necessary to identify and position all 
the models and their animation, lights, cameras, textures, etc. for rendering. 
All the elements are compiled into a single file with a .scn extension. 

To save your work during a session, use the File > Save or Save As commands 
to update the existing one or create a new scene in your current project.

Referenced Files in Saved Scenes

Scenes can also reference many external files such as texture images, video 
clips, and audio clips. Some of these referenced files may be located outside of 
your project structure. When you save a scene, the path information that lets 
Avid 3D locate and refer to these external files is saved as well.

Importing Scenes

Scenes are created from scratch in Avid 3D, but you can also import existing 
SOFTIMAGE|XSI scenes. In addition, you can also load scene and object files 
from other 3D or CAD/CAM programs saved to the dotXSI™ or EMDL 
formats and import them into Avid 3D. For more information, see “Importing 
and Exporting Files” on page 135.

Creating Scenes

Each time you start Avid 3D or create a new project, a new scene is automatically 
generated. However, you can also create a new scene at any time while you are 
working. Because you cannot have more than one scene open at a time, you are 
prompted to save the current scene before you can create a new one.

To create a new scene in the current project:

t Choose File > New Scene from the main menu or press Ctrl+N.

If you have modified the scene that is currently open, you are prompted to 
save the changes. 

The new scene is created within the current project and its name appears 
as “Untitled” on the title bar.
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To create a new scene in a different project

1. Choose File > Project Manager from the main menu.

2. Select a project in the Select a Project list box where you want to create 
the new scene.

3. In the Select a Scene list box, make sure New Scene is selected and click 
the New Scene button.

The new scene is created in the selected project and its name appears as 
“Untitled” on the title bar.

Opening Scenes

You can only view one scene at a time in Avid 3D. Before you open a different 
scene, you are prompted to save any changes made to the one that is open. 

As the scene is loaded, Avid 3D looks for all its referenced files using the 
files’ full path names. If any file is not located using this method, Avid 3D 
looks for the file name in the current project folder. If the file isn’t found here, 
the users path, and then the factory path is searched. If the file is still not 
located, then you must manually correct the file’s paths. It is therefore 
important to make sure that all the files you use in a scene are stored in a folder 
that Avid 3D can easily locate. For more information, see “Correcting External 
File Paths for Scenes” on page 46.

To open a scene in a project that is not on your project list:

If you open a scene in a project that is not on your project list, a dialog box 
will prompt you to add the project to your list. Answer Yes or No as you like. 
In addition, the dialog box lets you specify the behavior when opening other 
files in the future:

• Always Ask continues to prompt you to add new projects to your list.

• Always Add New Projects automatically adds projects to your list 
without prompting.

• Never Add New Projects does not add new projects to your list. You can 
still add projects manually using the Project Manager.
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To open a scene from the browser:

1. Choose File > Open from the main menu.

2. In the browser, go to the location of the project file you want to load. You 
can use the Up button to locate folders at higher levels. 

3. Select the scene file to be loaded (its name appears in the File Name text 
box) and click OK.

You can also double-click the scene name and it opens.

To open a scene from the Project Manager:

1. Choose File > Project Manager from the main menu.

2. Select a project from the Select a Project list box.

3. In the Select a Scene list box, double-click on the scene you wish to work 
on or select the scene name and click the Open button.

To open a scene you have recently worked on:

t Choose Find > Recent Scenes from the main menu and select the desired 
scene from the list.

To open a scene by dragging and dropping:

t You can drag and drop Avid 3D scene (*.scn) files from a browser or a 
Windows explorer onto the background of a viewport to load and replace 
the current scene. 

Opening Locked Scenes

When you open a scene file, a temporary “lock” file is created. The lock file is 
deleted when you close the scene.

Anyone else who opens the file in the meantime is given a warning that the file 
is currently in use. The purpose of the lock mechanism is to let you know that 
somebody else is already working on a scene, and to avoid concurrent saving 
which can lead to data lost.

You can still open a “locked” scene, but in this case the scene is loaded as a 
“shared copy” (which is displayed in the Avid 3D window title bar) and any 
changes you make to the file need to be saved under a different name.
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Setting a Scene’s Resolution

To ensure accurate framing and prevent timing problems in your animation, 
you should set the frame format before you begin constructing your scene.

To set the frame format:

1. Click the Inspect Render Options button in the render and preview 
controls. The Render Options dialog box opens.

2. Click the Format tab then click the arrow button to the right of the 
Format text box to select the picture standard for your scene. default is 
the NTSC D1 4:3 standard.

You can also set custom resolutions and frame rates. For more 
information, see “Specifying the Format Options” on page 385.

3. Click OK.

Deleting Scenes

To delete a scene:

1. Choose File > Project Manager. The Project Manager dialog box opens. 

2. Select a project from the Select a Project list box.

3. Click the name of the scene to be deleted from the Select a Scene pane.

4. Click the Delete button to delete the selected scene.

n You cannot delete the scene in which you are currently working. To delete your 
current scene, you must close it, open another scene, then delete the scene in 
the Project Manager.

Saving Scenes

All scenes are saved as a single file with an .scn extension. The scene contains 
any models, 3D objects, lights, cameras, animation, rendering options, 
textures, materials, and effects that you have applied. 
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To save a scene:

1. Choose File > Save from the main menu. 

If the scene has already been named, any changes are saved to the same 
file name. If the scene does not have a name (untitled), the Save Scene 
browser opens.

2. Enter a unique name for your scene in the File Name text box. 

3. Use the path navigation buttons to locate the folder where you want to 
save your scene. It is recommended, however, that you save scenes to the 
Scenes folder of the project.

4. Click OK.

Saving Scenes with a Different Name

In some cases, you may want to create a copy of a scene and save it with a 
different name. This can be helpful when you want to test a more complex 
rendering effect before committing it to the actual scene. 

To save a scene under a different name:

1. Choose File > Save As from the main menu to open the Save As dialog box.

2. Type another name for the scene in the File Name browser and click OK.

The new scene name is displayed on the title bar. The original scene 
remains unchanged in its most recently saved form.

Saving Scenes to a Different Project

You can save a scene from one project to another:

1. Open an Avid 3D scene.

2. Choose File > Save As from the main menu to open the Save As dialog box.

3. Navigate to the location of the new project and save the scene with the 
same name into its Scenes folder.

4. Select the Copy External Files Under Project option. See the next 
section for details.
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Copying Referenced Files Under Project

You can take all the external referenced files and copy them to the current 
project. This is particularly useful when you send project files to other users 
who otherwise cannot access the referenced files themselves. Or, you may 
have saved a scene to a different project and want all the referenced files used 
in that scene to be copied to the new project.

t In the Save As dialog box (choose File > Save As), select Copy External 
Files under Project and click OK. This scans your project and copies any 
referenced files such as textures or audio files used in your scene to the 
new project.

Correcting External File Paths for Scenes

Each time you open or import a scene, Avid 3D attempts to locate the external 
files (such as picture files, audio files, etc.) associated with the scene. You may 
need to update the path of a referenced file or locate missing files in scenes.

To locate and correct missing referenced files in scenes:

1. Choose File > Source Paths from the main menu to open the Inspect 
Source Paths property editor.

All referenced files and their paths are listed. The Resolved Path column 
lists the full paths as interpreted from the relative path entries in the File 
Path column. If a file cannot be found, the word “Invalid” appears in the 
Status column.

2. Click the name of the invalid file and modify its path or file name to 
resolve the error, or click Browse Selected Path to search for the file.

Modifying Multiple File Paths

If you have renamed or moved a directory containing external files, or changed 
your naming convention for referenced files (for example, changing all your 
existing images from clock1.pic, clock2.pic, clock3.pic, etc. to clock01.pic, 
clock02.pic, clock03.pic, etc.), you can modify the file paths of several files at 
once by using the Search and Replace dialog box.

To modify many file paths at once:

1. Choose File > Source Paths from the main menu.

2. Click the Search and Replace All button. 
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3. In the Search and Replace dialog box that opens, choose your settings:

- In the File Category text box, select the type of files whose entries 
you want to modify (for example, All, Image, Audio).

- In the Old String text box, enter the text string to search for in the 
existing path and file names.

- In the New String text box, enter the replacement text.

- Check the Case Sensitive check box if you want to search and replace 
using the specific capitalization you’ve entered.

4. Click OK.

Backing Up and Recovering Your Work

Avid 3D provides a number of ways of recovering your work. In most cases, 
you can easily recover your work if your system crashes through the autosave 
and recovery mechanisms. You also have backup options that let you load 
earlier saved versions of your scene if you want to backtrack and rework some 
of your content.

Autosaving Scene Files

The autosave options in the Data Management property editor lets you activate 
the autosave feature and determine how frequently autosaves are made.

c The autosaved scene file is created and maintained separately from the files 
you save while working. It is deleted when you exit Avid 3D in a normal 
manner. You must still make sure to save your work each time you exit.

The autosaved scene file is maintained in the hidden System folder under 
the active project.

To set the frequency of autosave:

1. From the Options tab in the tools and options panel, click the Data 
Management tab to display the backup settings.

2. Select the Enable Autosave option to activate the autosave function. 

By default, autosave is set to save every 30 minutes, but you can change 
this time span in the Autosave Interval text box.
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Backing Up Saved Scenes

Each time you save your scene, its file is automatically saved in a backup 
folder. This means you can go back and load an earlier version of your scene if 
needed. This can also come in handy if your scene file could not be 
automatically recovered.

The default number of backed-up scenes is four, but you can change this 
number (to a maximum of 100) in the Data Management property editor.

To set backup preferences:

t From the Options tab in the tools and options panel, click the Data 
Management tab and set the number of backups in the Number of Scene 
Backups text box.

t Set backups over a specified number of days in the Number of Backup 
Days to Keep text box. This is useful if you save often and the last backed 
up version does not include the information you need. This option ensures 
that you can retrieve your work from the last backed up versions of the set 
number of previous days.

n Make sure you have enough disk space so that your backup files are created 
successfully.

To reload a scene file from its backup folder:

1. Choose File > Open and navigate to your backup folder. By default, this 
folder is called Backup and is located in your project folder.

This folder contains all your saved scene files. These files are labeled 
(Myscene)_B1, (Myscene)_B2, (Myscene)_B3 etc., with (Myscene)_B1 
being the most recently saved scene.

2. Select the required backup version and click OK to load the scene.
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Recovering Scene Files

After a crash occurs, a dialog box usually opens indicating that your scene file 
has been successfully saved to an autosave or crash backup directory in the 
project’s System folder. 

Avid 3D first tries to load the autosave file (if the autosave option is enabled); 
if not, it falls back on the default crashsave file. You can continue to use the 
scene after restarting Avid 3D.

You can activate the autosave feature from the Data Management property 
editor in the tools and options panel, under Autosave. By default, files are 
saved every 30 minutes.

To recover a scene file after a system crash:

1. Restart Avid 3D after the crash. A dialog box opens asking if you want to 
try to recover the scene. Click Yes.

2. If the scene is recoverable, an untitled scene opens with your latest work 
retrieved from the crashsave or autosave process.

3. Save the scene under a new name and restart Avid 3D.
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Chapter 3
The Avid 3D Interface

The interface is your window to working in the world of Avid 3D. It comprises 
viewports for viewing your scene and several types of panels for accessing 
commands and tools.
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Overview of the Avid 3D Interface

The default layout of the Avid 3D interface is made up of control panels and 
four viewports, many of which can be resized.

Control bar
Displays buttons for
one-click access to

camera, transformation,
and editing controls.

See page 53 for details.

Viewports
Let you view the contents of your 
scene in different ways. You can 
resize, hide, and mute viewports in 
any combination. See “Viewports” 
on page 62 for details.

Library panel
Contains objects, materials, textures, 
images, and video clips you can use 
to create your scene. This panel is 
also home to the scene explorer. See 
“The Library Panel” on page 76 for 
more information.

Title bar
Displays the name of the 
open project and scene.

Menu bar Provides
access to primary

project and editing
commands.

Lower interface controls
(See page 53 for details.)

Tools and Options panel
Provides tools for modifying and animating 
elements in your scene, as well as setting 
user preferences and display and output 
options. See “The Tools and Options Panel” 
on page 78 for more information.
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Lower Interface Controls

The lower portion of the interface gives you access to the timeline and 
playback controls; basic keyframe animation controls; and preview and 
rendering controls, as well as a status line for information.

Control Bar

The control bar gives you quick access to many commands that are in the form of 
buttons. Many of these buttons have associated menu commands or shortcut keys. 

The control bar includes buttons for navigating in the viewports, transforming 
scene elements, selecting scene elements and their various components, 
duplicating and deleting scene elements, undoing and redoing edits, and 
opening the multi-purpose editor for editing properties.

Timeline
Displays the current 
position of your 
animation in time and 
lets you move manually 
between frames. See 
“Using the Timeline” on 
page 270.

Animation controls
Lets you set, remove, edit 
and navigate between 
keyframes. See “Keyframe 
Animation” on page 277.

Playback controls
Lets you play back 
animated scenes. See 
“Playing Animation” on 
page 270.

Rendering and 
Preview Controls
Lets you set up and 
create rendered output 
of your scene. See 
“Output Options” on 
page 381.

Mouse/status line
Displays the current functions of 
your three mouse buttons as well 
as status and error messages 
when applicable.
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Accessing Commands and Tools

In Avid 3D, there are many ways in which you can access commands. Many of 
the tools that are available depend on the context in which you’re working (such 
as the type of object you have selected or the type of view in which you’re 
working). This section describes the different ways in which you get commands.

You can use the mouse for performing basic operations such as manipulating 
objects in a scene, choosing commands, and selecting options in property 
editors. You must use a three-button mouse.

Using Access and Shortcut Keys

Keyboard shortcuts are specific key combinations that perform the equivalent 
of certain menu commands. There are two types of keyboard shortcuts: access 
keys and shortcut keys.

Access keys—The underlined letters you see in many menu names. Pressing 
Alt+[underlined letter] activates its associated command.

n Underlined letters in the menus and menu commands are not displayed by 
default in Windows XP. To display them, open Control Panel > Display > 
Appearance > Effects. Deselect the option called Hide underlined letters for 
keyboard navigation indicators until I press the Alt key.

Navigation controls for changing the 
viewpoint in the viewport—see 
“Navigating in Viewports” on page 71.

Duplicate button 
duplicates the 
selected object.

Selection controls for 
selecting elements in 
various ways—see 
“Selecting” on page 111.

Transform controls for scaling, 
rotating, and translating scene 
elements—see “Transforming 
Objects” on page 117.

Undo and Redo 
controls—see 
“Undoing and 
Redoing Edits” on 
page 58.

Delete button 
deletes the 
selected element.

Multi-purpose editor 
button for editing 
properties—see “The 
Multi-Purpose Editor” 
on page 79.



Accessing Commands and Tools

55

Shortcut keys—Commands that have been mapped to your keyboard. For 
example, pressing Ctrl+[key] activates an associated command.

Shortcut keys, if available, are listed to the right of many menu command names 
and tooltips. Refer to Online Help for a list of all available keyboard shortcuts.

Note that not every menu command has a shortcut or access key.

Using Shortcut Keys to Activate Tools

Shortcut keys are mapped to most of the tools used in Avid 3D, and pressing a 
key activates a specific tool. Once the key is pressed, the mouse pointer changes 
shape to identify the active tool. Any further actions you perform with the 
mouse are then related to that tool. For example, pressing the Z key activates 
the zoom tool so that holding down the left mouse button zooms in and out of 
the scene, and holding down the middle mouse button pans back and forth.

You can move back and forth between different tools quickly by using these 
shortcut keys. Only one tool can be active at a time.

...from the menu bar
Press Alt+underlined letter of the

menu name to open a menu of
commands.

...then, from the menu
Press a key that corresponds to

an underlined letter of a
command name to activate it.

Access keys...

Shortcut keys...

...from the keyboard
Press the key that corresponds to a 
command. Key combinations are 
displayed to the right of their associated 
commands in the main menu.
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Tools can be activated in one of two modes: 

• Sticky—you do not need to hold the key down to keep the tool active.

• Temporary (or supra)—you must keep the key held down for the tool to 
remain active.

Sticky-key Mode

You can activate a tool in this mode by quickly pressing and releasing its supra 
key. The tool remains active until you choose another tool or press another 
supra key to perform a different operation. Pressing a key a second time 
deactivates the tool.

Temporary (Supra) Mode

You can activate a tool in temporary, or supra, mode by holding down its key 
for longer than a quarter of a second. When you hold down a key and drag the 
mouse, the tool is switched off after you release the key. For example, when 
you release the O key after holding it down and dragging the mouse, you 
deactivate the orbit tool. 

Example: Activating Basic Tools

Follow these steps for an example of how to activate and work with the 
commonly used camera manipulation tools (pan and zoom, orbit, dolly).

1. Start Avid 3D and load a scene.

2. In a User view, press and hold the letter O key while dragging with the left 
mouse button to orbit your scene. When you release the O key, Avid 3D 
reverts to the tool you were using before.

3. Quickly press and release the P key. This activates the pan tool in sticky mode.

4. Left-click and drag to pan your scene, hold down the middle mouse button 
to zoom in, and hold down the right mouse button to zoom out.

Notice that when you release the mouse button you are still in zoom and 
pan mode. This is because the tool was activated as sticky: if you quickly 
press and release the key, the tool is activated and remains that way until 
you select another tool.

5. To deactivate the pan tool, press the P key again or press Esc.
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6. Quickly press and release the D key. This activates the dolly tool:

- The left mouse button lets you dolly (zoom in and out) at normal speed.

- The middle mouse button lets you dolly slowly.

- The right mouse button lets dolly quickly.

For information on other camera-manipulation tools, see “Navigating in 
Viewports” on page 71.

7. To activate another tool, press any key or choose a tool from the control 
bar. For example, you can switch to selection mode by pressing the S key 
or by clicking the Select button in the control bar.

Keeping Track of the Active Tool

You will often move back and forth between tools as you work. Here are a few 
ways to keep track of the tool you are working with:

• There are often visual cues within a viewport to indicate the current tool. 
An SRT manipulator appears in the viewport when you are in 
transformation mode, object wireframes change color to indicate the 
active selection tool, and so on.

• When dragging and dropping items from the library, a status bar appears 
in the active viewport and provides information appropriate to the location 
of your mouse pointer.

• In most cases, the mouse pointer changes to indicate the active tool. For 
example, when the orbit tool is active, the pointer turns into an orbit icon.

• The status bar at the bottom of the interface displays which operation is 
mapped to each of the mouse buttons. Always check the status bar for the 
current tool status.

Repeating Commands

You can repeat the last command in general, as well as repeat the last 
command from a specific menu button. For example, this lets you apply an 
operation to the selected object, then select a different object and apply the 
same operation again without digging through menus and submenus.
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To repeat the last command:

t Choose Edit > Repeat command name from the menu bar.

The name of the menu item indicates which command will be repeated. 
Certain categories of command cannot be repeated:

- Selection commands. This allows you to apply a command to selected 
elements, then select other elements and repeat the command.

- Interactive manipulation, for example, using the transform tools (V, 
C, X) or the Move Point tool (M).

- Viewing commands, such as toggling the display of points in a viewport.

- Playback and timeline commands, such as changing frames.

- Camera navigation and viewing commands, such as orbiting, 
zooming, and framing.

- Parameter changes made in a property editor.

When the last command can’t be repeated, Edit > Repeat will repeat the 
previous command instead.

Undoing and Redoing Edits

You can undo most edits made from the Avid 3D interface, such as scaling an 
object or deleting a rig.

To undo an edit:

t Choose Edit > Undo from the menu bar, click the Undo button in the 
control bar, or press Ctrl+Z. 

You can continue to undo actions as far back as the system memory can recall.

Undo does not work on changes in viewport manipulations such as orbit or zoom.

To redo an edit:

t Choose Edit > Redo from the menu bar, click the Redo button in the 
control bar, or press Ctrl+Y. You can invoke one redo command for each 
undo action.
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Viewing Your Work in 3D Space

This section provides some background for those who are not familiar with 3D 
animation. In particular, it introduces the notion of coordinate systems and 
distance units. The four viewports are where you view and manipulate the 
scene elements in 3D space.

Coordinate Systems

Coordinate systems allow any point in three-dimensional space to be 
represented by a triplet of numbers (X, Y, Z).

Cartesian Coordinates

One essential concept that a first-time user of 3D computer graphics should 
understand is the notion of working within a virtual three-dimensional space 
using a two-dimensional user interface.

To represent pictorial reality, 3D computer software uses the classical 
Euclidean/Cartesian mathematical representation of space. To represent the 
geometry of an object, the software uses the Cartesian coordinate system 
based on three perpendicular axes, X, Y, and Z, intersecting at one point. This 
reference point is called the origin. You can find it by looking at the center of 
the grid in any of the 3D windows.

XYZ Axes

To remember the direction of the X, Y, and Z axes, you can use the “right-
hand” rule: hold up your right hand so that your palm is facing you, then 
extend your thumb to the right, hold your index finger up, and point your 
middle finger towards you. Your thumb is pointing in positive X, your index 
finger in positive Y, and your middle finger in positive Z. The opposite 
directions represent negative X, Y, and Z.
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A small icon representing the three axes and their directions is shown in the 
corner of each viewport in the camera, geometry, and spotlight views. The 
icon’s three axes are represented by color-coded vectors: red for X, green for 
Y, and blue for Z. 

n An easy way to remember the color coding is RGB = XYZ. This mnemonic is 
repeated throughout Avid 3D: object centers, visual cues for transformations, 
and so on.

XYZ Coordinates

With the Cartesian coordinate system, you can locate any point in space using 
three coordinates. Positions are measured from a point called the origin, which 
is (0, 0, 0). For example, if X = +2, Y = +1, Z = +3, a point would be located 
to the right of, above, and in front of the origin.

XZ, XY, YZ Planes

Since you are working with a two-dimensional interface, spatial planes are 
used to locate points in three-dimensional space.

The perpendicular axes extend as spatial planes: XZ, XY, and YZ. In the 
viewports, these planes correspond to three of the parallel projection windows: 
Top, Front, and Right.

Location = (2, 1, 3)

Z = 3

Y = 1

X = 2

Origin



Viewing Your Work in 3D Space

61

Imagine that the XZ, XY, and YZ planes are folded together like the top, front, 
and right side of a box.

This helps you keep a sense of orientation when you are working within the 
parallel projection windows.

Global and Local Coordinate Systems

The location of an object in 3D space is defined by a point called its center. 
This location can be described in more than one way or according to more 
than one frame of reference.

For example, the global position is expressed in relation to the scene’s origin. 
The local position is expressed in terms of the center of the object’s parent.

Front

Top

Right
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Distance Units

Throughout Avid 3D, lengths are measured in distance units. How big is a 
distance unit? It is an arbitrary, relative value that can be anything you want: 
one foot, 10 cm, or any other system of measure.

However, it is generally recommended that you avoid making your objects too 
big, too small, or too far from the scene origin. This is because rounding errors 
can accumulate in mathematical calculations, resulting in imprecisions or even 
jittering in object positions. 

As a general rule of thumb, an entire rig should not fit within 1 or 2 units, nor 
exceed 1000 units.

Viewports

The viewing area of the interface contains windows, called viewports, where 
you can view and work on your scene. Each viewport can display different 
types of views. You can display up to four different views in the viewers. 

Viewports can have different geometry views (top, front, right, and user) and 
display types (shaded, wireframe, texture, hidden line, etc.).

A viewport’s menu bar contains a set of controls that allow you to perform 
various functions such as changing views, choosing display types, and resizing 
the viewport.

Scene origin

Object and 
its center

Parent
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Identifying Viewports by Letter

A letter (A, B, C, or D) appears in the upper-left corner of each viewport to 
simplify the way in which they are referenced. A refers to the upper-left viewport, 
B is the upper-right, C is the lower-left, and D is the lower-right viewport.

Muting and Soloing Viewports

When a viewport is muted, it is prevented from displaying its contents. Muting 
a viewport’s neighbors helps speed up its refresh rate.

To mute or solo viewports, do one of the following:

t To solo (view just one viewport), left-click on its letter. Left-click a 
second time to redisplay all viewports.

t To mute a viewport, middle-click on its letter. Middle-click a second time 
to redisplay the viewport.

t Right-click a viewport’s letter to display a menu with mute and 
solo commands.

Letter Identifier button
Identifies the viewport and,

when selected, alternates
between displaying and hiding

(muting) viewport contents.

Views menu
Provides a variety of

specialized ways in which to
view your scene—see page 66.

Display Types menu Specifies 
how visible items in the viewports 
are displayed—see page 68.

Resize button 
Resizes viewports to full-
screen, horizontal, or vertical 
layouts—see page 64.
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Changing the Viewport Color

By default, a viewport background appears in gray. You can modify it to 
display in black or white.

To change the viewport color:

1. Click the Display Options button in the Tools and Options panel.

2. Click the appropriate Background Colors button. 

Resizing Viewports

There are two ways to resize viewports: interactively set them to any size, or 
use the sizing button to set specific sizes.

To resize a viewport interactively:

1. Position the mouse pointer at an intersection of the viewports. You can 
either place the pointer where the four viewports meet or where two 
viewports meet. 

The pointer becomes an arrow indicating in which direction you can 
resize the viewports.
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2. Drag the viewports to whatever size you want. They change size in 
relation to each other.

3. To reset the viewports back to equal sizes, middle-click at the viewport 
intersection.

Resizing Viewports Using Set Sizes

The sizing button in the upper-right corner of each viewport resizes it so that 
the viewport fills the entire screen (full view), a horizontal half-view 
(landscape), or vertical half-view (portrait).

You can easily toggle between these views and reduce the viewport to its 
original size (quarter-view) at any time.

To toggle between a quarter-view (the four viewports) and full view:

t Click the sizing button.

To toggle between a quarter-view and a landscape view (horizontal):

t Middle-click the sizing button.

To toggle between a quarter-view and a portrait view (vertical):

t Ctrl+middle-click the sizing button.

You cannot toggle directly between the landscape and portrait views.

You can also right-click the sizing button to display a pop-up menu that 
includes the following commands:

• Maximize: displays the viewport in full view.

• Horizontal: displays the viewport in landscape view.

• Vertical: displays the viewport in portrait view.

• Reset Size: displays all viewports in quarter-view.

• Reset All: resets all viewports to their default set of views (i.e., Camera, 
Right, Front, Top).
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Displaying the Viewport Grid

When you translate objects in the 3D or camera views, the viewport grid 
provides a visual frame of reference. In the orthogonal views, translation is 
restricted to take place within the plane of the displayed grid. The viewport 
grid is not rendered.

To toggle the viewport grid display, do one of the following:

t To toggle the grid in the viewport your mouse pointer is in, press the G key.

t To toggle the grid in all viewports displaying a camera view, click the 
Show/Hide Grid button in the Display Options panel.

Viewport Views

There are many ways to view and edit your scene in the viewports. 

Camera Views

Camera views let you display your scene in a viewport from the point of view 
of a particular camera.

Selecting a camera from a viewport’s views menu switches the viewpoint to 
that of a “real” camera in your scene. All other views such as User, Top, Front, 
and Right are not associated to an actual camera.

n You can also choose to display the viewpoint of any spotlight in the scene.

Viewpoints

Viewpoints show you the geometry of objects in a scene. You can also choose 
different display types to change the visual appearance of the objects seen in 
viewpoints (see “Display Types” on page 68).
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Top, Front, and Right Views

The top, front, and right views are parallel projection views, called such 
because the object’s projection lines do not converge in these views. Because 
of this, the distance between an object and the camera has no influence on the 
scale of the object. If one object is close to the camera, and an identical object 
is farther away, both appear to be the same size.

The top, front, and right views are orthographic, which orients the camera so it 
is perpendicular (orthogonal) to specific planes:

• The top view faces the XZ plane.

• The front view faces the XY plane.

• The right view faces the YZ plane.

User

The user view is a user-defined viewpoint that shows objects in a scene from a 
virtual camera’s point of view. This view can be either perspective or 
orthographic.

• In the perspective view, objects appear to converge toward a central 
vanishing point, and objects closer to the camera appear larger than those 
farther away.

• In the orthographic view, objects remain in parallel projection with the 
view being perpendicular (orthogonal) to the XY plane in camera space.

Top

Front Right
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The user point of view can be placed at any position and at any angle within the 
global 3D coordinate system. You can orbit, dolly, zoom, and pan in this view.

Spotlight

Spotlight views let you select from a list of spotlights available in the scene. 
Selecting a spotlight from this list switches the point of view in the active 
viewport relative to the chosen spotlight. The point of view is set according to 
the direction of the light cone defined for the chosen spotlight.

Display Types

There are several different ways in which you can display objects in a 
viewport. By default, all objects are displayed in wireframe mode. Some 
display types provide less detail but are less computationally intensive than 
others—and this speeds up your screen refresh.

To set the display type for a specific viewport:

Click the Display 
Type menu to 
choose a display 
type from its menu.
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Here are some examples of several of the available display types. For more 
information on each display type, refer to the Online Help (Help > Avid 3D 
Help) for the Viewport topic.

Outputting Avid 3D Views to an Avid Mojo

Avid Mojo™ is a portable Digital Nonlinear Accelerator that allows you to 
output hardware and software rendered effects from Avid 3D to a monitor in 
real-time. 

When you have an Avid Mojo connected to your Avid 3D workstation, you 
can output content from Avid 3D to a monitor using the Mojo to accelerate the 
display of effects. You can choose a view to output from the Mojo Options tab 
in the tools and display panel.

n You can also output to the Mojo from the flipbook and after rendering—see 
“Loading Animation in the Flipbook” on page 334 and “Rendering Your 
Scene” on page 383.

Wireframe Hidden Line Constant (flat-shaded)

OpenGLTexturedShaded
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To output Avid 3D views to a monitor:

1. Click the Options button in the tools and options panel, then click the 
Mojo Options button in the toolbar that appears to open the Time 
property editor.

2. Choose the Monitor Type to which you’re outputting content. This can 
be either NTSC or PAL.

3. Choose an Avid 3D view to output via the Mojo by setting the View 
Output to one of the following:

- Disabled: nothing is output to the monitor.

- 3D View A: the display in viewport A is output to the monitor.

- 3D View B: the display in viewport B is output to the monitor.

- 3D View C: the display in viewport C is output to the monitor.

- 3D View D: the display in viewport D is output to the monitor.

- 3D Auto A/B/C/D: the viewport that has focus is output to the 
monitor. Click a viewport to give it focus.

- Render View: outputs the rendered image from the render preview 
or, the render view when rendering an image to disk. 

The image/frame is not displayed on the monitor until the last tile 
is rendered.

- The FX View option is not implemented in Avid 3D.

- Image Clip View: the image clip view, as seen in the Texture Clip 
Viewer, is output to the monitor.

Configuring Avid 3D to Output to an Avid Mojo

The following procedure explains how you can configure Avid 3D to output 
to a Mojo.

n If you have installed other Avid products you may already have a Mojo driver 
installed. You must ensure that the most recent driver has been installed.

The driver files for Mojo are called Flamethrower.inf and Flamethrower.sys. 
They are located in the Application\bin subdirectory of the installation path.
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To update your Mojo driver:

1. Close all running sessions of Avid 3D.

2. From the Windows task bar, choose Start > Control Panel > System.

3. On the Hardware tab, click the Device Manager button. In the device 
manager, expand the Sound, video & game controllers node.

4. Double-click Avid Technology Mojo to open its Properties dialog box 
and switch to the Driver tab.

5. Click the Update Driver button.

6. From the Hardware Update Wizard, choose Install from a list or specific 
location and click Next.

7. Choose Don’t Search. I will choose the driver to install. Then click 
Next and choose the latest driver.

If no drivers are listed, click Have Disk. Then Browse to the 
Application\bin subdirectory of the installation path, choose 
Flamethrower.inf, and click OK.

When you first launch Avid 3D with Mojo support, it may request that you 
update your firmware. Simply follow the instructions to perform the update. 
Once the firmware is updated, you’ll need to power the Mojo off and on again 
and restart Avid 3D for the changes to take effect.

n If Avid 3D is installed on the same machine as other applications that support 
Mojo output (such as Avid XpressPro), make sure that those programs use the 
same version of the Mojo driver and firmware as Avid 3D. Programs requiring 
different versions of the Mojo driver cannot co-exist peacefully on the same 
machine.

Navigating in Viewports

A set of viewport navigation controls in the control bar and their 
corresponding shortcut keys let you change the way in which you view your 
scene. You can use these controls and keys to zoom in to and out of a scene, 
frame objects within a viewport, and orbit, track, and dolly the scene.

Camera buttons in the control bar
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Framing Objects in Viewports

Framing commands let you instantly zoom in to or out from selected objects in 
viewport geometry views. You can frame objects in two ways: framing 
selected objects or framing all visible objects in one or all viewports.

To frame all visible objects in a viewport:

t Position the mouse pointer over the viewport and press A.

To frame all visible objects in all viewports:

t Press Shift+A or click the Frame All Objects In All Viewports button on 
the control bar.

To frame all selected objects in a viewport:

t Position the mouse pointer over the viewport and press F.

To frame all selected objects in all viewports:

t Press Shift+F or click the Frame Selected Object In All Viewports 
button on the control bar.

Changing the Viewpoint

You can zoom in to and out of your scene or pan in all 3D views using the 
zoom controls.

Panning and Zooming

To pan and zoom using the camera pan tool:

Click the Camera Pan Tool button on the control bar, or press the P supra key. 
Then do any of the following:

t Press the left mouse button and drag to pan.

t Press the middle button to zoom in.

t Press the right button to zoom out. 

t Click the Camera Pan Tool button or press P again to deactivate pan 
and zoom mode.
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To pan and zoom using the camera zoom tool:

Choose the Camera Zoom Tool button on the control bar, or press the Z supra 
key. Then do any of the following:

t Press the left mouse button and drag to zoom in or out.

t Press the middle button and drag to pan.

t Click the Camera Zoom Tool button or press Z again to deactivate 
zoom mode.

By default, Avid 3D zooms into or out from the center of the view.

n Zooming in or out changes the view angle setting of the camera, the same as 
when you zoom with a real camera. Use the dolly tool if you don’t want to 
change the view angle.

Orbiting

Orbiting is only possible in the perspective views. Orbiting rotates a camera, 
spotlight, or user viewpoint around its point of interest. This lets you study 
your scene’s overall “look” in any angle in any view.

To orbit:

t Click the Camera Orbit Tool button on the control bar, or press the O 
supra key while in User view. 

Dollying and Rolling

You can dolly toward the camera interest in a perspective view or toward the 
center of the viewport in an orthogonal view. Rolling is only possible in the 
perspective views. 

To dolly: 

Click the Camera Dolly Tool button on the control bar, or press the D supra 
key. Then do any of the following:

t Press the left mouse button and drag to dolly.

t Press the middle button to dolly slowly.

t Press the right button to dolly quickly.
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t Click the Camera Dolly Tool button or press D again to deactivate 
dolly mode.

To roll the camera about its Z axis:

Click the Camera Roll Tool button on the control panel or press the L supra 
key, then do any of the following:

t Press the left mouse button and drag to roll.

t Press the middle button to roll slowly.

t Press the right button to roll quickly.

t Click the Camera Roll Tool button or press L again to deactivate 
roll mode.

Resetting Coordinates

You can reset the camera and other viewport views so that their global point of 
origin (X = 0, Y = 0, Z = 0) is in the center of the viewport.

To reset the camera and view coordinates:

t Click the Reset Camera button on the control bar, or position the mouse 
pointer over the viewport and press the R key.

Hiding and Unhiding Objects

You can quickly hide and unhide selected objects in the viewports using the 
Display Options panel or the H shortcut key. This is a quick way to set the 
viewport visibility of a selected element.

n Hiding objects eliminates their visibility both in the viewports and in the 
rendered output.

To hide and redisplay selected objects in the viewports:

1. Do one of the following:

t In any viewport, select the object you want to temporarily hide, 
and press H.
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t From the Display Options panel, click the Show/Hide Selected 
Objects button.

The selected object is hidden in all geometric views but remains 
visible in the explorer (an H will appear on the icon of the hidden 
node). Hidden elements are not rendered in the render region nor do 
they appear in the final output.

2. Pressing H or clicking the Show/Hide Selected Objects button again 
redisplays the hidden object.

If you selected another element or modified the scene after you hid the 
object, pressing H or choosing View > Hide/Unhide Selection again has 
no effect on the hidden element. In this situation, the hidden object can 
only be redisplayed by selecting its node in the explorer and pressing H or 
clicking the Toggle Visibility of Selected Objects button again.

To unhide all hidden objects in the viewports:

t From the Display Options panel, click the Show All Objects button.

Display Filters

In addition to hiding or displaying individual objects, you can use display 
filters to hide or display different types of scene elements, such as lights, 
cameras, curves, control objects, and particles.

To display or hide different types of elements in the viewport:

t Toggle the various Display Filter buttons in the Display Options panel.

Lights

Cameras

Curves and Motion Paths

Particles

Control Objects and Rig Handles
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The Library Panel

The library panel is found on the right side of the Avid 3D interface. It is 
divided into tabs that contain libraries of objects, rigs, clips, particles, and 
other elements that can be used as building blocks for Avid 3D scenes. 

Elements such as objects, models, and rigs can be added to a scene simply by 
dragging an element’s thumbnail into a viewport. Elements such as materials, 
textures, still images, and video clips are added to an object by dragging their 
thumbnails onto an object in the viewport.

For more information about using the elements in the library panel, see “Using 
the Library Panel” on page 98.

The Scene Explorer

The explorer displays the contents of your scene as a list of nodes that expand 
from the top root. You normally use the explorer as an adjunct while working 
in Avid 3D to find or select elements. For example, the scene explorer is a 
useful tool to help you select hidden elements in a scene. You can also rename 
elements using the scene explorer.

To see properties of those selected scene elements, use the multi-purpose 
editor, as described in “The Multi-Purpose Editor” on page 79.

Scene explorer—see
next section on page 76.

Sample Projects library

Object library Model library
Digimation 
Model Bank

Video library

Still Images library

Material and 
Fx library

Video library
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To open the scene explorer:

t In the library panel, click the Scene Explorer tab.

n If the panel is too short and a scroll bar appears on the side, you can see the 
rest of the contents by either scrolling with the scroll bar or panning by 
clicking and dragging up and down in an empty area.

Selecting Scene Elements in the Scene Explorer

Selecting elements in the explorer is quite straightforward. In particular, you 
can select any element, even if it is unselectable or hidden in the 3D views.

• To select a scene element, simply click on its name in the explorer. 
Ctrl+click to multi-select individual nodes.

• To select a range of elements, click on the first element’s name in the 
range, then Shift+click on the last element’s name in the range. These two 
elements, plus all the elements between them, become selected.

Renaming Scene Elements

You can rename elements in your scene using the explorer. You can rename 
lights, cameras, and geometric objects.

Click an item to select it.
Selected items are highlighted.

Rename the selected item by
pressing F2 and entering a

new name.

Click an item to display
those types of elements in

the tree panel below.

Click the Scene Explorer
tab in the library panel to
open the scene explorer.
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To rename scene elements:

t Select the element you want to rename in the scene explorer and press F2. 
Then type a new name for the element.

The Tools and Options Panel

The Tools and Options panel is where you can access many tools used for 
different tasks in a scene, such as transforming elements, animating, or 
deforming objects. As well, you can access a number of options to set up your 
scene, such as for the display in the viewports or output options to determine 
how to render your scene.

• Transform Tools panel: Contains tools that let you translate, rotate, and 
scale objects in your scene. It also includes a number of mode buttons that 
let you specify how objects are transformed. 

For more information, see “Transforming Objects” on page 117.

• Animation Tools panel: Contains tools that let you animate objects in 
different ways, such as by setting keyframes, putting objects on paths, 
constraining them, or using math presets.

For more information, see Chapter 10 “Animating in Avid 3D” on page 261.

• Text Tools panel: Contains tools that let you create and edit text.

For more information, see Chapter 7 “Working with Text and Logos” on 
page 173.

Transform tools

Animation 
tools Text tools

Deformation 
tools

Particle 
tools

Display options

Options
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• Deformation Tools panel: Contains tools that let you deform objects in 
many different ways.

For more information, see Chapter 6 “Modifying Object Geometry” on 
page 139.

• Particle Tools panel: Contains tools that let you create and apply 
particles, forces, and obstacles in your scene.

For more information, see Chapter 11 “Particles” on page 341.

• Display Options panel: Contains tools that let you determine what’s 
displayed or hidden in the viewport. 

For more information, see “Hiding and Unhiding Objects” on page 74 and 
“Viewports” on page 62.

• Options panel: Contains tools that let you set up preferences for different 
aspects of working in Avid 3D, from rendering and time properties to data 
management and the function curve editor. 

For more information on each option, see the Online Help.

The Multi-Purpose Editor

The multi-purpose editor lets you edit properties of any type of scene element. 
You can also open the profile and function curve editors from here. The multi-
purpose editor appears as a floating window. You can resize the window by 
dragging its borders, and move it around the interface by clicking and 
dragging on its title bar.

To open the multi-purpose editor:

1. Select an element in a 3D view or in the scene explorer.

2. Click the Multi-Purpose Editor button on the control bar. 

3. Click the tab that corresponds to the properties you want to edit (or editor 
that you want to use). 

4. Click a node in the tree panel on the left, and its property editor appears in 
the panel on the right.

See “Modifying Properties in Property Editors” on page 80 for information in 
general about editing properties. 
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The following is a summary of the properties and editors available in the 
multi-purpose editor.

• Geometry and Deform properties—see “Basic Scene Elements” on 
page 100 and “Deforming Objects” on page 140.

• Material and Fx properties—see “Materials” on page 238, “Textures” 
on page 245, as well as “Attaching Sprites and Images to Particles” on 
page 374 for using sprites with particles.

• Texture clip viewer—see “Textures” on page 245.

• Profile editor—see “Working with Profiles” on page 162.

• Function curve editor—see “Editing Function Curves” on page 285.

Modifying Properties in Property Editors

Property editors are found throughout Avid 3D—for instance, you can access 
property editors from some buttons in the tools and options panel, where they 
are used to view and change project, scene, and render settings. However, you 
will most likely use property editors to define and modify a scene’s various 
elements. You can find elements’ property editors in the multi-purpose editor.

n You can also modify an object’s properties using the on-screen parameters—see 
“Modifying On-screen Parameters” on page 88 for more information.

Material and Fx 
properties

Geometry and
Deform properties

Texture clip 
viewer

Profile 
editor

Function curve 
editor

Click element name
in the tree to open its
property editor in the

panel on the right.
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To open an element’s property editor:

1. Select the element in a 3D view or in the scene explorer.

2. Open the multi-purpose button by clicking the Multi-Purpose Editor 
button in the control bar. 

See the previous section, “The Multi-Purpose Editor”, for information in 
general about the multi-purpose editor. 

Anatomy of a Property Editor

Property-page controls
For viewing and setting

parameter values for sets
of grouped properties.

Property Page tabs
Switch between sets of grouped 
parameters within a property set.

Parameter Set headers
Click the arrow to expand and

collapse the property set.
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Property Page Controls

n Not all of the options described above are available in every property editor.

Changing Values Using Sliders

To change values using sliders, do one of the following:

t Drag a slider to the right to raise the value or to the left to lower the value 
in the text box.

t Drag a slider to the right or left while pressing the Shift key to make 
finer adjustments.

t Drag a slider to the right or left while pressing the Ctrl key to change the 
value of all the sliders in a color-control group simultaneously.

t Drag with the middle mouse button to have the scene update only when 
you release the mouse button instead of refreshing continuously as you 
drag. This is especially useful when setting values on parameters that may 
take a long time to update.

Check box
Toggles the option so that 
it’s active or inactive. A 
check mark appears in 
the box when it’s active.

Sliders
Let you change values by 
dragging the bar or arrow 
in the slider. “Changing 
Values Using Sliders” on 
page 82 for more 
information.Text boxes

Let you enter values for the
parameters. See “Entering

Values in a Text Box” on
page 83 for more information.

Drop-down lists
Let you select one option 
from several. Click the 
arrow beside the list to 
open its menu.

Animation button
Shows status of animatable

parameters (whether or not the
parameter is animated). You can also

set and remove keys by clicking this
button. See “Keyframe Animation” on

page 277 for more information.

Color box
Opens color editors from which

you can pick or define the colors
you want to use. See “Defining

Color Properties” on page 92 for
more information.
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When you resize a property editor so that there is not enough room to display 
or use a slider effectively, the slider becomes an input box. When you enlarge 
the property editor, the input box becomes a slider again.

Entering Values in a Text Box

There are many ways to enter information in a text box. You can enter 
information the conventional way by using your keyboard. For numeric input, 
you can also use gestural movements and key combinations to increase or 
decrease the parameter values. 

n To move from one text box to the next one in the same property editor, press the 
Tab key. To move back to the previous text box, press Shift+Tab. 

To enter information by typing:

Move the mouse pointer inside the text box and click. The pointer shape 
becomes a text cursor (flashing vertical bar). Any existing text is selected and 
is overwritten as soon as you begin typing.

If you click in the text box a second time, the text is deselected and the cursor 
is placed where you clicked. You can now:

• Use the left- and right-arrow keys on the keyboard to move the cursor to 
the appropriate place in the text box.

• Drag the cursor over the part of the contents you want to replace. The 
selected characters are highlighted. Now type in the text you want.

• Press Shift+left- or right-arrow key to select characters that are to the left 
or right of the cursor. You can delete or replace these characters.

• Double-click to select a word or value so that you can replace it 
completely with the text that you type.

• Right-click to open a pop-up menu and choose the command to Undo, 
Cut, Copy, Paste, Delete, or Select All the contents of the text box.

Sliders become input 
boxes at small sizes. 

Sliders at larger sizes. 
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• Delete characters to the left of the cursor using the Backspace key, or 
delete characters to the right of the cursor using the Delete key.

• To cancel text box input, press the Esc key.

n If you have problems entering decimal values, open the Windows Control Panel 
and make sure that the Regional Settings are set to English (United States).

To enter information by gestural input (scrubbing):

t Click and drag the mouse pointer in a circular motion over a text box that 
supports numeric values. This is known as scrubbing. To increase the 
value, scrub in a clockwise direction; to decrease the value, scrub in a 
counterclockwise direction.

- Press the Shift key while scrubbing to increment or decrement values 
by a factor of 0.1.

- Press the Ctrl key while scrubbing to increment or decrement values 
by a factor of 10.

To enter information by increments, do one of the following:

t Click in the numeric text field and press the square bracket keys ([) and (]) 
to increment and decrement values as follows:

Press this... To do this...

] Increment by 1

[ Decrement by 1

Ctrl+] Increment by 10

Ctrl+[ Decrement by 10

Shift+] Increment by 0.1

Shift+[ Decrement by 0.1
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t Click in the numeric text field and press the arrow keys to increment or 
decrement values as follows:

n If you have a mouse wheel, click in the numeric text field, then roll the wheel 
forward to increment the value or backward to decrement the value.

Relative Input Using Math Operations

All text boxes allow you to input relative values by means of four basic math 
operations (addition, subtraction, multiplication, and division), as well as other 
operators such as linear and random.

To input relative values:

1. Click in a text box to select the value it contains.

2. Enter the number to add, subtract, divide, or multiply.

3. Enter the symbol for the math operator ( + – * / ). You can use only one 
math operator per text box. 

4. Press Enter.

For example, if the selected value in the text box is 10 and you replace this 
value by 5+ and press Enter, the result is 15 because you added 5 to the 
existing value.

When you have multiple elements of similar parameter values, anything you 
enter in a text box is applied to all these parameters:

Press this... To do this...

Ctrl+right-arrow Increment by 10

Ctrl+left-arrow Decrement by 10

Shift+Ctrl+right-arrow Increment by 0.1

Shift+Ctrl+left-arrow Decrement by 0.1
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The following illustrations describe the different ways in which elements can 
be transformed using text box input. For illustrative purposes, the example of 
translation is used, but the concepts apply to any parameter:

Operator Results

value Sets all selected element properties to that value. For example, 
entering an X-axis rotation value of 5 sets all selected objects’ 
rotational values to 5. This is also known as absolute input (see 
the following illustration).

value+ Increments all the selected elements by that value. For example, 
entering 2+ in an X-axis translation parameter shifts all selected 
objects by 2 distance units. Math operations are known as 
relative input.

value- Decrements all the selected elements by that value.

value* Multiplies all the selected elements by that value.

value/ Divides all the selected elements by that value.

l or L(min, max) Creates a linear range through the selection, according to the 
original selection order. For example, L(4,8) when applied to the 
X-axis translation parameter of a group of three cubes causes 
each object to move 4, 6, and 8 distance units along the X axis, 
respectively.

r or R Creates a random value for each selected element, between 0 and 1.

r(x) or r(-x) Creates a random value for each selected element between 0 and 
the value for (x). If r is followed by (–x), a random value between 
0 and the negative value is inserted.

r(min, max) Creates a random value for each selected element within the 
specified range.

g(mean, var) Creates a random value following a normal distribution among 
the selected elements.
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Absolute Input
Entering a numeric value in an XYZ text box 
repositions all selected objects to the specified 
position on their X,Y, or Z axes.

This example: Translation: Y = 3 
(spheres all repositioned to 3 on the Y axis)

Relative Input
Entering (value)+ or (value)– in an XYZ text 
box increases/decreases the relative value of 
each selected object. You can also enter 
(value)* and (value)/ to multiply and divide the 
relative value.

This example: Translation: Y = 3+
(Y value of each selected sphere increased by 
three distance units)

Random Input
Entering a value of R(min,max) in an XYZ text 
box randomly repositions each selected object 
anywhere between the specified minimum and 
maximum values.

This example: Translation: Y = R(0,6)
(spheres randomly repositioned between 0 
and 6 on the Y axis)

Linear Range
Entering a value of L(min,max) in an XYZ text 
box repositions each selected object on a 
linear path between the specified minimum 
and maximum values. The first selected object 
receives the minimum value and last selected 
object receives the maximum value.

This example: Translation: Y = L(0,6)
(spheres repositioned equally on a linear 
range between 0 and 6 on the Y axis)



Chapter 3 The Avid 3D Interface

88

Modifying On-screen Parameters

In addition to marking, editing, and animating parameter values in a property 
editor, you can display parameters directly in viewport B and do all these tasks 
on screen. 

On-screen parameters are displayed for the selected object on a semi-
transparent menu in the upper-right corner of viewport B. For most objects, 
only their Transform parameters appear on-screen; however other objects, 
especially rigs, also have other parameters that can be displayed on-screen.

Displaying On-screen Parameters

To display on-screen parameters in viewport B:

1. Select an object, and its on-screen parameters appear in the upper-right 
corner of viewport B. 

If you multi-select objects, only the parameters for the first object you 
selected are displayed on-screen.

On-screen parameters are 
displayed for the selected rig 
in a semi-transparent menu 
in viewport B.
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2. Click the arrow beside the parameter set name (in this case, Transform) to 
open up the menu of parameters available for that set.

Some objects have on-screen parameters other than the Transform 
parameters. You can find out which objects these are by clicking the 
Scene Explorer tab in the library panel and selecting Objects > 
w. On-screen Params.

To set the size of the font for on-screen parameters:

1. Click the Display Options tab in the tools and options panel. 

2. Select a font size from the On-screen Parameter buttons: small (sm), 
medium (M), or large (L).

Click arrow beside 
parameter set name 
to open menu that 
displays the set’s 
parameters.
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Modifying and Animating the On-screen Parameter Values

You can easily modify the on-screen parameters, as well as animate them. Before 
you modify or key parameter values, you should mark them. Marking parameters 
lets Avid 3D know that you want to modify or key only those parameters. 

All marked parameters’ values are modified when you drag the mouse or are 
keyed when you click the keyframe button in the animation controls. For 
general information on setting keys, see “Setting Keys” on page 278.

To mark parameters, do one of the following:

t Click the parameter name: it turns yellow to indicate that it’s marked. 

t Press Shift+click to mark multiple parameters.

t Press Ctrl+click to toggle the marked state of the parameters. 

To edit parameter values:

Click and drag on a parameter name or its value to modify the value:

• Drag to the left to decrease the value, and drag to the right to increase it. 

• Press Ctrl while you drag for coarse control.

• Press Shift while you drag for fine control.

• Press Ctrl+Shift while you drag for very precise control. 

• Press Alt while you drag to extend beyond the range of the parameter’s 
slider in its property editor (if the slider range is smaller than its total range).

Marked parameters
are displayed in yellow.
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• Double-click on a numeric value to edit it using the keyboard. The current 
value is highlighted, so you can type in a new value. Only the parameter 
you click on is affected even if multiple parameters are marked. 

To animate parameter values, do one of the following:

t Click on the parameter’s animation button to set or remove a key for the 
corresponding parameter.

t Right-click on an animation button to open the animation menu for the 
corresponding parameter. From this menu, you can set or remove keys, 
copy and paste keys between parameters, or move between keys. See 
“Keyframe Animation” on page 277 for more information.

The color of the animation box beside the parameter indicates the following 
information: 

Double-click the value, 
then type in a new one.

Blue: the parameter is animated by 
something other than keys (such as a 
math preset).

Empty: the parameter is not animated.

Red: the parameter has a key at the 
current frame. 

Yellow: the parameter is animated and 
the value has been modified but is not 
yet keyed. 

Green: the parameter is animated and 
the current value is the interpolation 
between keys. 
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Defining Color Properties

There are a number of standard ways of defining color properties, for textures, 
materials, and lighting.

Defining Colors with Sliders

To define a color using the color sliders:

1. Select the color model that best suits your needs. Below the color box, you 
can click on the color model button to toggle between RGB, HLS, and HSV.

2. Do one of the following to set the color:

t Click and drag the sliders to change the strength of each channel 
independently, or type a numerical value directly in the text box 
beside the sliders.

t To move all three sliders at once, hold the Ctrl key down while 
dragging the color sliders. 

t For fine-tuning a single color value, hold down the Shift key while 
dragging the color sliders.

n You can quickly copy a color by clicking a color box and dragging and 
dropping its “color chip” to another color box in the same property page or 
another one. This is especially useful when you want to match ambient or 
diffuse colors among objects.

As you use the color sliders, you will notice that each slider immediately 
updates to show you a gradient of the color you have selected. The slider 
shows you what color will result if you move the slider to a new position.

The specific channel corresponding to a slider depends on the color channel 
you selected; for example, if you selected RGB, the sliders correspond to the 
red, green, and blue channels. The values range between 0 and 1. 

Color slidersColor box Color 
model
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n When you are defining materials, you can type values greater than 1 to 
compensate for transparency and reflectivity.

Defining Colors with the Color Editors

When defining or choosing colors, or to choose one from a viewport, you can 
use one of the two color editors. In the full color editor, you can create and 
modify colors for your materials and lights. This can be useful for creating 
specific palettes to apply consistently to a group of materials. You can also use 
the color picker to pick a color displayed in any viewport, including the Image 
Clip editor.

To select a color using the mini color editor:

1. Click the color box next to the color sliders in a property editor.

2. The mini color editor (below) opens:

To select a color:

t Click in the color spectrum. That color then appears in the color preview 
box (and in the color box of the property editor), while the current color 
remains in the current color box to use as a reference. 

Color box

Changes color 
model.

Color picker copies a
color from anywhere

on the screen.

Opens the full 
color editor.

Color preview box

Color spectrum

Current color box

Slider bar
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To edit a color:

t Use the slider bar at the right or enter a numeric value in the text boxes 
below it. You can also change the color model from RGB to HLS to HSV 
by clicking the > button. 

To pick a color, do one of the following:

t Click the color picker button (the eye dropper) and click anywhere on the 
screen. The color picker takes the color you see on the screen rather than the 
true color of the objects. This tool can be especially useful when trying to 
match a color in a viewport containing a flipbook or the Image Clip editor.

t Click on the browse (...) button to open the full color editor, where you 
can fine-tune and create custom colors.

3. Close the color editor to use the color you created.

To fine-tune a color using the full color editor:

1. In a property editor, click the color box beside the color sliders to open the 
mini color editor.

2. In the mini color editor, click the browse (...) button. The full color 
editor opens. 

Color picker

Current
and Preview
color boxes

Color area

Color views

Slider bar
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To select a color:

t Click in the color area. You can define the color area by selecting a color 
view mode. Each mode offers a variety of spectrums and hues. Once a 
color is selected, the color appears in the preview color box, while the 
previous color remains in the current color box to use as a reference.

To modify a color:

t Use the slider bar at the right of the color editor or enter a numeric value 
in any one of the RGB, HSV, or CMYK fields. As a color is modified, its 
corresponding values are updated.

To pick a color:

t Use the color picker as described on page 94.
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Chapter 4
Avid 3D Basics

No matter what you plan to create in Avid 3D, the basic processes and 
building blocks are the same. The library panel contains most of the raw 
material you will use to create scenes, which you can then manipulate using 
the processes described in this chapter.
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Using the Library Panel

The library panel is where you find objects, textures, image and video clips, 
camera effects, and more—most of the raw material you will be using to create 
scenes in Avid 3D.

Getting content into your scene is simply a matter of dragging an item from a 
library into a viewport or onto a node in the multi-purpose editor. However, the 
type of content you want to use and how you want to apply it determines how 
you should drag and drop. The following is a general guide to Avid 3D’s drag 
and drop rules:

• To add objects, scenes, rigs, and environment effects, drag an item onto an 
empty spot in a viewport.

• To add materials and textures to objects, drag an item onto the object.

• To add light or camera effects, do one of the following:

t Drag an item onto a specific light or camera.

t Drag an item into a viewport. The effect is added to all applicable 
lights, or to the active camera.

• Some rigs use placeholder objects intended for objects you can add later. 
Drag an item onto the placeholder to replace it.

n When dragging and dropping items from the library, a status bar appears in 
the active viewport and provides information appropriate to the location of 
your mouse pointer.

You can also drag and drop files from a Windows explorer or Web browser into 
Avid 3D.
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• Sample Projects Library: Contains preset scenes that you can drag and 
drop directly into a viewport. If you load a sample scene onto an existing 
scene, you are prompted to save or cancel your existing scene. You cannot 
merge the scenes together.

• Object Library: Contains preset elements that you can drag and drop 
directly into a viewport. This includes static and animated objects, lights, 
cameras, object rigs, environments, particle systems, text, and curves.

• Model Library and Digimation® Model Bank™: Contains various 3D 
object models that you can drag and drop directly into a viewport. 

n The Digimation Model Bank is available only if you selected to install it when 
you installed Avid 3D.

• Material and Fx Library: Contains preset elements that you can drag 
and drop onto an appropriate object (objects, particles, lights, or cameras) 
or into a scene (environment maps). Most presets only work with specific 
targets. For example, you can drag and drop materials only onto a 3D 
object in a viewport, or drag and drop particle types only onto particles in 
a viewport. 

• Still Images Library: Contains 2D images and textures that you can drag 
and drop onto a 3D object.

• Video Library: Contains video and audio clips that you can drag and 
drop onto an object (video) or in the scene (audio).
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Basic Scene Elements

Objects

There are several different types of objects available for building Avid 3D 
scenes. While many of them are the objects that will appear in your final 
output, most will not—like a boom microphone or a wind machine on a sound 
stage, these objects remain invisible to the audience but are necessary to create 
a convincing and compelling scene.

Geometric Objects

Geometric objects are objects that can be modified by changing parameters or 
manipulating the components (points or polygons) that make them up. By 
default, most geometric objects are visible when the scene is rendered. There 
are several different types of geometric objects in Avid 3D.

Polygon Meshes

Polygon meshes are quilts of polygons joined at their edges and points.

Curves

Curves are one-dimensional objects that have points but no thickness. They 
are not renderable, but can be used to modify extruded and revolved objects, 
create paths for objects to move along, and so on.

A polygon mesh sphere

A simple curve
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Surfaces

Surfaces are smooth-surfaced objects defined by intersecting curves. As they 
are not created with polygons, polygon-related tools such as clusters cannot be 
used to modify them.

Control Objects

Sometimes referred to as handles, control objects are the non-renderable objects 
that exist to define the properties of rigs, deformations, and other effects.

Nulls

Nulls are simply locations in space that cannot be rendered. However, they are 
often used in rigs for setting constraints and organizing objects in hierarchies.

Lattices

Lattices are like a three-dimensional scaffolding that can be used to deform 
objects. Lattices do not render. They are described in “Lattices” on page 148.

Surfaces allow for smooth 
geometry with relatively few 
control points.

The position of a null is 
represented by this icon.
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Waves

Waves define an animated deformation that you can use to create ripples in 
geometric objects. Waves do not render. They are described in “Waves” on 
page 154.

Particle Clouds

Clouds are icons that control the emission and simulation of particles from a 
geometric object. You can use them to create a variety of particle effects, such 
as fire, water, and smoke. Particles are described in “Particles” on page 341.

Forces

Forces are control objects that define effects to create movement only on 
particles, like gravity, turbulence, a fan, and wind. Forces do not render. They 
are described in “Applying Forces to Particles” on page 366.

Cameras

The camera in Avid 3D is analogous to a physical camera in the real world. It 
defines the view that you can render. For more information on cameras, see 
“Cameras” on page 219.

The wireframe wave icon controls 
the deformation on the surface grid.

A particle cloud

A wind force
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Lights

As in the real world, lights make everything in your 3D scene visible. Each 
light in a scene contributes to the scene’s illumination and affects the way all 
objects’ surfaces appear in the rendered image. You can dramatically change 
the nature and mood of your images by modifying lights and their properties. 
For more information on using lights, see “Lights and Shadows” on page 204.

Primitive Objects

Primitives are basic shapes that you can add to a scene. These primitive shapes 
can form the basis for more complex objects. For example, you can start with a 
sphere and move points on it to create a head. You can then attach eyeballs and 
ears to the head and put the whole head on a body of a character.

There are several different primitive shapes for each geometry type. Each 
primitive shape has parameters that are particular to it—for example, a sphere 
has a radius that you can specify, a cube has a length, a cylinder has both 
height and radius, and so on.

There are also several parameters that are common to all or to several 
primitive shapes: Subdivisions, Start and End Angles, and Close End.

U and V Directions

Objects with more than one dimension (that is, anything other than a curve) 
have their own internal coordinate systems that are used for functions such as 
texturing or subdividing. These coordinate systems use U and V directions in 
the same way that a graph might use X and Y to measure length and height. 
Because U and V directions can be applied to different types of objects, they 
have no strict definition: on a sphere, U and V might refer to latitude and 
longitude; on a two-dimensional disc, they might refer to circumference and 
radius; and on a cylinder they might refer to radius and height.

U, V, and Base Subdivisions

When you get a primitive object, you can specify the number of subdivisions. 
More subdivisions result in more points, thereby giving a heavier geometry 
with more detail. Two-dimensional primitives like grids let you specify the 
number of subdivisions in the U and V directions, while three-dimensional 
primitives let you specify the number for the base as well.
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Start and End Angles

Many primitive objects have Extent settings that let you set the Start and End 
angles. You can use these options to open up the basic primitive shapes, for 
example, to create a hemisphere or take a slice out of a disk.

Open and Closed Ends

Several primitives have one or more Close options that can be used to cap their 
ends. By default these options are on, but you can turn them off to open the ends.

5 U-Subdivisions

3 V-Subdivisions

2 Base-Subdivisions

Torus open in both the U 
and V directions

Cylinder with ends closed Cylinder with top end open Cylinder with both ends 
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Rigs

Rigs are prebuilt collections of objects designed to perform specific tasks. 
Typically, the objects are positioned and constrained in a specific way, and 
specialized parameters are provided to simplify their manipulation. Rigs 
generally include one or more control objects or handles that provide access to 
these parameters. Parameters appear as on-screen parameters, as well as in the 
multi-purpose editor’s Geometry and Deform Properties tab.

n Rig-control nodes appear in the multi-purpose editor with the prefix X3D_.

There are many different kinds of rigs available in the sample projects and 
object libraries. These are just general categorizations; for example, some 
camera rigs are also motion path rigs.

Light Rigs

Light rigs allow you to light your scene in a specific way. Light rigs can be a 
particular arrangement of lights with specific parameters, or renderable 
geometries that simulate real-world light fixtures. See “Lights and Shadows” 
on page 204 for more information on lights.

By default, every new Avid 3D scene has a light rig placed at its center. See 
“The Default Light Rig” on page 207.

All rigs have at least one 
control handle, usually a 
circle or a square. Select 
the handle to access the 
rig’s parameters.

Many control handles 
can also be used to 
control the entire rig’s 
transformation.

Some rig handles include 
controls for the rig’s pitch, 
yaw, and roll—its rotation 
around its local X, Y, and 
Z axes, respectively.

Many rigs have placeholder
objects. You can further

customize a rig by dragging
and dropping objects from
the library panel onto the
placeholder to replace it.

You can also replace
placeholders with other rigs.
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Camera Rigs

Camera rigs can be either fixed-camera or free-camera.

Fixed-camera rigs are typically used for scenes with objects appearing in front 
of a backplate. As the name implies, fixed-camera rigs feature a camera that is 
constrained to one spot, positioned so that the backplate image fills its view. 
You can also create your own fixed-camera rig by dragging a still image or 
video clip and dropping it into a viewport, then selecting Framed Image Clip 
from the dialog box that appears.

Free-camera rigs allow you to move your camera within your scene, usually 
along a motion path.

See “Cameras” on page 219 for more information on cameras.

Motion Path Rigs

Motion path rigs allow you to animate an object along an open or closed path. 
Generally, motion path rigs include placeholder objects that you can replace 
by dragging another object onto them. You can also replace placeholders with 
other rigs.

See “Path Constraints” on page 323 for more information on path animation.

Text Rigs

Text rigs allow you to animate text along paths, or to animate a “follow-the-
leader” sequence with individual letters trailing behind one another in a 
specified manner.

See “Working with Text and Logos” on page 173 for more information on text.

Object Rigs

Object rigs are objects that have been created with control handles for 
specialized functions. For example, the control handle on the book rig allows 
you to set the number of pages in the book, how far its front and back covers 
open, and how the pages turn.
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Digital Video Effects (DVEs)

Digital video effects, or DVEs, are fixed-camera rigs with effects or deforms 
applied to one or more textured objects. These can provide special effects or 
3D transitions between two different images or scenes.

A Word about Models

In 3D computer graphics lingo, a model is a sculpted, three-dimensional entity 
that you manipulate in space. A model could be anything from a fish to a desk 
to a giant robot.

In Avid 3D, models are more than that: they are a powerful way for organizing 
objects in your scenes and projects in a structure. Models act as a container for 
objects, usually hierarchies of objects, and many of their properties. They 
contain not just the objects’ geometry but also the function curves, textures, 
and other properties. They can also contain internal math presets and 
constraints; that is, those presets and constraints that refer only to elements 
within the model’s hierarchy.

Models are like “mini scenes” that can be easily reused in scenes and projects. 
In fact, exporting and importing models is how you can copy data between 
scenes. See “Importing and Exporting Files” on page 135 for more details on 
moving data between scenes.

Every scene contains a model called the Scene_Root, which is the parent of all 
other models. Every object or rig you drag and drop from the library panel 
creates its own model. You can create or import as many models as you like.

In the scene explorer, models are distinguished by special icons, as shown on 
the left. You can change the scene explorer’s scope to show only models, 
which greatly simplifies the representation of your scene. For details on 
changing the scene explorer’s scope, see “The Scene Explorer” on page 76.

Components of Objects

All 3D objects have components that create them: the points and polygons 
that define the shape of 3D objects. You can select and manipulate different 
types of components to change the shape of objects. Clusters are named 
groups of polygons.
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Types of Components

Different geometry types have different types of components.

Points

Points are the most fundamental type of component. They are the vertices of 
polygon meshes as well as the control points of curves, surfaces, and lattices.

Each point defines a location in space. The collection of points determines the 
shape of an object.

Polygons

Not surprisingly, polygons are components of polygon meshes. They are the 
closed, flat shapes that make up the “tiles” of the mesh and are bound by edges.

Points on different 
geometry types: 
polygon mesh, 
curve, surface, 
and lattice.

Selected polygon
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Clusters

A cluster is a named set of polygons that are grouped together for a specific 
purpose. By grouping and naming polygons, it makes it easier to work with 
those same polygons again and again. For example, by grouping all the 
polygons that form an eyebrow, you can easily transform the eyebrow as an 
object instead of trying to reselect the same polygons each time you work with 
it. You can also apply textures to specific clusters instead of an entire object.

You can define as many clusters on an object as you like, and the same 
polygon can belong to a number of different clusters. If you delete a cluster, 
only the cluster definition is deleted; the polygons themselves remain intact.

To create a cluster:

1. Click the Select Tool button in the control bar or press S.

2. Select one or more geometric objects.

3. Click the Select Polygon Tool button in the control bar or press U.

4. Click and drag the mouse pointer across the polygons you want to select.

5. Click the Create/Edit Polygon Clusters button in the control bar.

6. In the dialog box that appears, enter a name for the cluster, then click OK.

For information on selecting objects and polygons, see “Selecting 
Objects” on page 112 and “Selecting Components” on page 114.

To delete clusters:

1. Select one or more geometric objects.

2. Click the Create/Edit Polygon Clusters button in the control bar.

3. A dialog box appears, listing the object’s clusters. Select the clusters to 
add the selection, check the Delete checkbox, then click OK.
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Element Names

All elements have a name. For example, if you create a sphere object, it is 
called sphere by default, but you can rename it if you want.

Element names appear as labels on nodes in the scene explorer.

Valid Names

Avid 3D restricts the valid characters in element names to a–z, A–Z, 0–9, the 
hyphen (-), and the underscore (_). Invalid characters are automatically 
converted to underscores. In addition, element names cannot start with a digit; 
Avid 3D automatically adds an underscore at the beginning.

Namespaces and Unique Names

Namespaces define the scope in which an element name is unique. In order to 
specify an element unambiguously, no two elements can have the same name 
if they are in the same namespace.

Different types of elements have different namespaces:

• The scene is the namespace for models. All models within a scene must 
have unique names. All models within a scene must have unique names, 
even if one model is nested in the hierarchy of another model.

The scene is also the namespace for image sources and clips.

• The model is the namespace for objects. Two separate models, Fluffy and 
Sparky, can each have an object called LeftPaw. However, a single model 
cannot have two objects called LeftPaw. The combination of model name 
and object name uniquely identifies an object in a scene, for example, 
Fluffy.LeftPaw or Sparky.LeftPaw.

The model is also the namespace for audio sources and clips.

Objects and groups that are not in any other model are in the namespace of 
the scene root model.

• The object is the namespace for clusters. For example, two objects called 
LeftPaw and RightPaw can each have a clusters called MiddleClaw.
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Renaming Elements

You can rename certain types of elements in your scene. These types include:

• Objects, including geometric objects, lights, cameras, particle clouds, 
and so on.

• Models.

• Clusters.

• Sources and clips. However, be aware that if you rename a source, any 
clips based on that source are automatically renamed as well.

• Materials and textures.

You cannot rename other types of elements. such as operators and constraints.

To rename an element:

Do one of the following:

t Select an element, then click its node in the multi-purpose editor and 
change the Name parameter.

t Select an element, press F2 in an explorer, and enter a new name.

t In an explorer, click twice on an element (don’t double-click it) and enter 
a new name.

If the new name is not unique in its namespace, a number is appended 
automatically.

Selecting

Selecting is fundamental to any software program. In Avid 3D, you select 
objects, components, and other elements to modify and manipulate them. There 
are many ways to select elements, and this section describes them all in detail.

• Different selection tools allow you to select in different ways.

• You can select objects, components, and properties using different filters 
in the 3D view.

• You can select any node directly in the explorer.

• You can modify the selection using a number of commands.
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What You Can Select

In Avid 3D, you can select any object, component, property, cluster, operator, 
source, clip, and so on; in short, just about anything that can appear in the explorer.

The only thing that you can’t select are individual parameters—parameters are 
marked for animation instead of selected. For more information about 
marking, see “Marking Parameters for Animation” on page 265.

Selected elements are highlighted in the 3D and explorer views. Selected 
components are highlighted in red in the 3D views.

Selecting Objects

When you select an object, the previously-selected objects become deselected 
unless you press the Shift key.

To select an object in the 3D views:

t Use the S key in supra or sticky mode and click on an object.

To select an object in an explorer:

t Click on an object node. Use the left mouse button for node selection.

You can select objects in the scene explorer or multi-purpose editor at any 
time. You do not need to activate a selection tool first.

To select all objects:

Do one of the following:

t Choose Edit > Select All.

t Press Ctrl+A.

Selecting Objects Using the Rectangle Selection Tool

You can use rectangle selection to select objects by dragging diagonally to 
define a rectangle that encompasses them. Any objects that are touched or 
encompassed by the rectangle are selected.

n The rectangle selection tool does not take into account whether an object is 
behind another. As a result, you may select objects you cannot see because 
they are obscured by others in the view.
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To use the rectangle selection tool:

1. Click the Select Tool button in the control bar or press S.

2. Click and drag the mouse pointer diagonally in the viewport to define a 
rectangle around any set of objects in the scene.

Selection and Hierarchies

Hierarchies describe the relationship between objects, usually using a 
combination of parent-child and tree analogies, as you do with a family tree. 
Objects can be associated to each other in a hierarchy for a number of reasons, 
such as to make manipulation easier or to animate children in relation to a parent.

In a hierarchy there is a parent, its children, its grandchildren, and so on. The 
combination of links that can be created is almost infinite.

• A root is a node at the base of either a branch or the entire tree.

• A tree is the whole hierarchy of nodes stemming from a common root.

• A branch is a subtree consisting of a node and all its descendants.

• Nodes with the same parent are called siblings.You can select objects in 
hierarchies in several ways: node, branch, and tree.

When objects are in a hierarchical relationship, you can use the different 
mouse buttons to select a node, a branch, or an entire tree.

Selecting objects in a hierarchy is different from selecting multiple individual 
objects because it respects the hierarchical links that exist between objects in 
your scene.

The type of selection matters for propagation and transformation. For 
example, when you branch-select the parent and translate it, all elements in the 
tree move; however, if you node-select that parent and translate it, the children 
do not move unless their local position parameters are animated. This is 
because local transformations are stored relative to the parent’s center.

Node Selection

Node selection is the simplest way in which an object can be selected. When 
you node-select an object, only it is selected. If you transform a node-selected 
object, its descendants are not affected (although they will update if they have 
animation on their local transformations).
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To node-select objects:

t Left-click an object.

Branch Selection

When you branch-select an object, its descendants “inherit” the selection 
status and are highlighted in light gray. You would branch-select an object 
when you want to transform it and its children as a single unit.

To branch-select objects:

t Middle-click an object.

Tree Selection

You can also tree-select objects. This selects the object’s topmost ancestor in 
branch mode. There is no fundamental difference between branch and tree 
selection; the only difference is which node is the topmost selected one. Tree 
selection is simply a convenience that lets you select an entire hierarchy by 
clicking on any of its objects.

To tree-select objects:

t Right-click on an object.

When you tree-select an object, by default the model node is not selected. This 
makes it easier to animate and set keys on only those parameters that are 
within the model’s namespace (the model itself is in the scene root’s 
namespace). If you want to select the model, you can click its node directly in 
the scene explorer.

Selecting Components

You can select components interactively only in the 3D views.

To select components interactively:

1. Select one or more geometric objects.

2. Do one of the following:

t Click the Select Point Tool button in the control bar, or press T.
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t Click the Select Polygon Tool button in the control bar, or press U.

3. Click a point or polygon.

Selecting Points Using the Rectangle Selection Tool

You can use rectangle selection to select points by dragging diagonally to 
define a rectangle that encompasses them. Any points that are touched or 
encompassed by the rectangle are selected.

n The rectangle selection tool does not take into account whether a point is 
visible. As a result, you may select points you cannot see because they are on 
the opposite side of an object, or are otherwise obscured by objects in the view.

To use the rectangle selection tool:

1. Select one or more geometric objects.

2. Click the Select Point Tool button in the control bar or press T.

3. Click and drag the mouse pointer diagonally in the viewport to define a 
rectangle around any set of points in the scene.

Selecting Polygons Using the Freeform Selection Tool

You can use freeform selection to select polygons by dragging the mouse 
pointer across them. Unlike rectangle selection, the freeform selection tool 
never selects polygons on the opposite side of an object, or that are otherwise 
obscured by objects in the view.

To use the freeform selection tool:

1. Select one or more geometric objects.

2. Click the Select Polygon Tool button in the control bar or press U.

3. Click and drag the mouse pointer across the polygons you want to select.

Selecting Polygons Using the Range Selection Tool

You can use range selection to select polygons by defining two 
endpoints—Avid 3D will select them and the intervening polygons.
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To use the range selection tool:

1. Select a geometric object.

2. Click the Select Polygon Tool button in the control bar or press U.

3. Select a polygon on the object.

4. Click another polygon while pressing and holding the Ctrl and Alt keys.

Selecting Polygons Using the Loop Selection Tool

You can use loop selection to select all the polygons in a U or V direction by 
selecting any two polygons that lie on the same U or V coordinate.

To use the loop selection tool:

1. Select a geometric object.

2. Click the Select Polygon Tool button in the control bar or press U.

3. Select a polygon on the object.

4. Middle-click another polygon at the same U or V coordinate while 
pressing and holding the Alt key.

Selecting Clusters

To select clusters:

1. Select one or more geometric objects.

2. Click the Create/Edit Polygon Clusters button in the control bar.

3. A dialog box appears, listing the object’s clusters. Select the clusters to 
add the selection, then click OK.

Extending the Selection

You can always add elements to the selection by pressing the Shift key while 
you select them. You can also press the Ctrl key while selecting to toggle an 
element’s selection.

In order to extend the selection, the elements must all be of the same type. 
That is, if you have objects selected you can add other objects to the selection, 
but not points, polygons or clusters.
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Deselecting

You can deselect specific objects and components, as well as deselect all 
elements (objects, components, and other things).

To deselect an object:

t With a selection tool active, Ctrl+Shift+click on the object.

t With a selection tool active, Ctrl+click the object. Ctrl+clicking again 
adds the object to the selection.

Use the left mouse button to deselect nodes, the middle mouse button to 
deselect branches, and the right mouse button to deselect trees.

To deselect components:

t With the appropriate component selection tool active, Ctrl+Shift+click on 
the components.

t With a selection tool active, Ctrl+click the component. Ctrl+clicking 
again adds the component to the selection.

To deselect all elements:

Do one of the following:

t Press Ctrl+Shift+A.

t With a selection tool active, click in an empty area of a viewport. This also 
works for components.

Transforming Objects

Transformations include three basic types of operations that manipulate an 
element in 3D space: scaling affects an element’s size, rotation affects an 
element’s orientation, and translation affects an element’s position. 
Transformations are sometimes called SRTs.
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Local versus Global Transformations

There are two types of transformation values: local and global. Local 
transformations are relative to an object’s parent, while global ones are relative 
to the origin of the scene’s global coordinate system. The global 
transformation values are the final result of all the local transformations that 
are propagated down the object hierarchy from parent to child.

When you transform objects in Avid 3D, you are using local 
transformation—this lets you branch-select an object’s parent and move it 
while all objects in the hierarchy keep their relative positions.

n Even if you are transforming the topmost parent in a hierarchy, you are still 
transforming locally—relative to the root of the object’s model.

Transformations and Hierarchies

Transformations are propagated down hierarchies. Each object’s local position 
is stored relative to its parent. It’s as if the parent’s center is the origin of the 
child’s world.

Objects in hierarchies behave differently when they are transformed, depending 
on whether the objects are node-selected or branch-selected. By default:

• If an object is branch-selected, then its children are transformed as well.

• If an object is node-selected, then its children are not transformed unless their 
corresponding local transformations are animated. This is because animation 
on the local transformations is stored relative to the parent’s center.

Centers

All geometric objects have a center. The center defines the object’s position in 
space. The object’s points are stored as offsets from the center, and the local 
transformations of a child are relative to the parent’s center.

Centers are automatically displayed when you select objects. They appear as a 
set of axis indicators with a white circle at the origin.
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Useful Tools for Transformation

Useful tools for transformations in Avid 3D include the transform tools panel, 
the Local Transform property editor, and the snapping feature.

Local Transform Property Editor

Each object has a set of transformation controls found in its Local Transform 
property editor. The Local Transform property editor can be used to modify an 
object’s scaling, rotation, and translation in X, Y, and Z.

To open the Local Transform property editor:

1. Select an object, then open the multi-purpose editor.

2. Click the Local Transform node in the Geometry and Deform 
Properties tab.

Transformation Basics

This section provides some basic information that is common to all 
transformation tools. More details about each specific type of transformation 
is provided in the sections that follow.
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Transforming Interactively

The Scale, Rotate, and Translate tools let you transform objects interactively 
using the mouse in the viewports.

To transform objects interactively:

1. Select the objects to transform, and activate a transformation tool:

- To translate, press V or click the Translate Tool button on the control bar.

- To rotate, press C or click the Rotate Tool button on the control bar.

- To scale, press X or click the Scale Tool button on the control bar.

The corresponding local transformation parameters are automatically marked 
for animation.

2. If desired, you can restrict the interaction to specific axes (see “Specifying 
Axes” on page 120).

3. If desired, you can set the manipulation pivot. The pivot defines the 
position around which elements are rotated or scaled. When translating 
with snapping, the pivot is the position that snaps to the target. See 
“Setting the Manipulation Pivot” on page 121.

4. Click and drag on different parts (handles) of the displayed transformation 
axes to transform the objects in different ways.

For general information about the SRT manipulators, see “Transforming 
Interactively with the SRT Manipulators” on page 122. For specific 
information about each manipulator, such as the handles used by different 
tools, see “Using the Translate Manipulator” on page 125, “Using the Rotate 
Manipulator” on page 126, or “Using the Scale Manipulator” on page 128.

Specifying Axes

When transforming interactively, you can specify which axes are active by 
double-clicking in the 3D views while a transformation tool is active:

• Double-click on a single axis to activate it and deactivate the others.

• If only one axis is currently active, double-click on it to activate all three axes.
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• Shift+double-click on an axis to toggle it on or off individually. (If it is the 
only active axis, it will be deactivated and both of the other two axes will 
be activated).

The marked parameters do not change when you specify axes. For example, if 
you activate only the X axis while translating, the posx, posy, and posz 
parameters all remain marked for animation. This is because the active axes 
affect interaction only.

Setting the Manipulation Pivot

When transforming elements interactively, you can set the pivot used for 
manipulation using the Alt key. The pivot defines the position around which 
elements are rotated or scaled. When translating with snapping, the pivot is the 
position that snaps to the target.

The same pivot is used for all selected elements. The pivot is normally reset 
when you change the selection. However, you can lock and reset the pivot 
position manually.

n When you move the pivot from its default and then scale or rotate objects, the 
position values are automatically compensated while you manipulate the 
objects. This is important to remember if you are animating the objects’ 
transformations: you must set keys on the position parameters as well as the 
scaling or rotation parameters or else you will not get the same results when 
you play back the animation.

To set the manipulation pivot:

t With a transformation tool active, do one of the following:

t Alt+click in a viewport. The pivot snaps to the closest point, edge 
midpoint, polygon midpoint or object center among the selected objects.

t Alt+middle-click to place the pivot freely in the view plane of a 
viewport. You can drag the mouse before releasing the middle mouse 
button to adjust the pivot’s location.

To lock the manipulation pivot:

1. With a transformation tool active, press and hold Alt. The pivot’s icon appears.

1. Click on the triangle below the pivot’s icon. A menu opens.

2. Choose Lock.



Chapter 4 Avid 3D Basics

122

The pivot remains at its current location until you reset it, even if you 
change the selection or activate another tool.

To reset the manipulation pivot:

1. With a transformation tool active, press and hold Alt. The pivot’s icon appears.

2. Click on the triangle below the pivot’s icon. A menu opens.

3. Choose Reset.

The pivot returns to the default location for the current manipulation mode.

Transforming Interactively with the SRT Manipulators

The SRT manipulators let you transform elements interactively by clicking 
and dragging on different parts (handles) of the displayed transformation axes. 
You can also use gestural manipulation or choose the behavior when clicking 
outside of a manipulator.

To use the manipulator handles:

1. Move the mouse pointer over the manipulator handle you want. Different 
tools have different handles:

- For a description of the Translate manipulator handles, see “Using the 
Translate Manipulator” on page 125.

- For a description of the Rotate manipulator handles, see “Using the 
Rotate Manipulator” on page 126.

- For a description of the Scale manipulator handles, see “Using the 
Scale Manipulator” on page 128.

The pointer updates to reflect the axes or plane of manipulation.

2. Click and drag.

Transformation Axes

When you select a transformation tool for a selected object or component, 
Avid 3D displays an icon corresponding to the transformation axes at the 
active pivot position. You can click and drag on different parts of these icons to 
manipulate the object. They also act as visual cues that indicate the object’s 
local X, Y, and Z axes.
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Scaling
The axis on which you 
are scaling turns yellow 
and resizes as you scale 
the object.

The cues representing 
the original size are 
displayed in light gray.

Rotating
The axis on which you 
are rotating turns yellow. 
The sphere rotates as 
you rotate the object.

Translating
The axis on which you 
are translating turns 
yellow and moves as 
you translate the object.

The cues representing 
the original position are 
displayed in light gray.
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Setting Values Numerically

As an alternative to transforming objects interactively, you can enter numerical 
values in the boxes on the object’s Local Transform property editor. Values are 
relative to the object’s parent.

Like other input boxes, you can enter specific or relative values for one or 
more selected objects. See “Entering Values in a Text Box” on page 83 for 
more information.

Transforming Hidden Objects

You cannot transform objects interactively if they are hidden (although you 
can still enter values numerically). This prevents you from accidentally 
making modifications that you cannot see. For more information about hiding 
and unhiding objects, see “Hiding and Unhiding Objects” on page 74.

Translating Objects

Translation changes an object’s position in space. Local translations are performed 
along the axes of the object’s local coordinate system as defined by its center.

To translate objects:

1. Select the objects to translate.

2. Activate the Translate tool by doing one of the following:

t Press the V key.

t Click the Translate Tool button on the control bar.

Object is transformed...

...using the object’s own local 
axes as the reference.
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3. If necessary, change any options:

- You can restrict the translation to specific axes. See “Specifying 
Axes” on page 120.

- Set the pivot as described in “Setting the Manipulation Pivot” on 
page 121.

4. Click and drag on different parts (handles) of the displayed transformation 
axes to translate the objects in different ways, as described in “Using the 
Translate Manipulator” on page 125.

Using the Translate Manipulator

When using SRT manipulators to translate, there are seven handles that you 
can click and drag:

For information about using the SRT manipulators in general, see 
“Transforming Interactively with the SRT Manipulators” on page 122.

Rotating Objects

Rotation changes the orientation of an object. All possible orientations can be 
set with a combination of three angles of rotation: X axis, Y axis, and Z axis. 
Local rotations are performed around the axes of the object’s local coordinate 
system as defined by its center.

Click and drag on a single axis to 
translate along it.

Double-click to toggle between a 
single active axis and all three 
axes, or Shift+double-click to 
toggle activeness of a single axis.

Click and drag between 
two axes to translate 
along the corresponding 
plane.

Click and drag on the center to 
translate in the viewing plane.
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To rotate objects:

1. Select the objects to rotate.

2. Activate the Rotate tool by doing one of the following:

t Press the C key.

t Click the Rotate Tool button on the control bar.

3. If necessary, change any options:

- You can restrict the rotation to specific axes. See “Specifying Axes” 
on page 120.

- You can set a pivot as described in “Setting the Manipulation Pivot” 
on page 121. When rotating, the pivot defines the center of rotation.

4. Click and drag on different parts (handles) of the displayed transformation 
axes to rotate the objects in different ways, as described in “Using the 
Rotate Manipulator” on page 126.

Using the Rotate Manipulator

When using SRT manipulators to rotate, there are three handles that you can 
click and drag:

Click and drag on a single ring to 
rotate around that axis.

Double-click to toggle between a 
single active axis and all three 
axes, or Shift+double-click to 
toggle activeness of a single axis.
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For information about using the SRT manipulators in general, see 
“Transforming Interactively with the SRT Manipulators” on page 122.

Scaling Objects

Scaling changes the size of an object. Unlike translation and rotation values 
which are absolute, scaling values are multipliers. A cube created at a length 
of 5 and scaled with a factor of 2 has a length of 10. Negative scaling turns an 
object inside-out.

When an object is created, its scale is automatically set to 1.0.

Local rotations are performed around the axes of the object’s local coordinate 
system as defined by its center.

To scale objects:

1. Select the objects to scale.

2. Activate the Scale tool by doing one of the following:

t Press the X key.

t Click the Scale Tool button on the control bar.

3. If necessary, change any options:

- You can restrict the scaling to specific axes. See “Specifying Axes” 
on page 120.

- You can set a pivot as described in “Setting the Manipulation Pivot” 
on page 121. When scaling, the pivot defines the center of scaling.

4. Click and drag on different parts (handles) of the displayed transformation 
axes to scale the objects in different ways, as described in “Using the 
Scale Manipulator” on page 128.

n When scaling objects in a hierarchy, Avid 3D uses the local axes of child 
objects when their parent is branch-selected and scaled. This maintains the 
relative shape of the children without deformation.
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Using the Scale Manipulator

When using SRT manipulators to scale, there are seven handles that you can 
click and drag:

For information about using the SRT manipulators in general, see 
“Transforming Interactively with the SRT Manipulators” on page 122.

Transforming with the Bounding-Box Manipulator

As an alternative to using the transformation tools, you can use the bounding 
box manipulator to scale, rotate, and translate objects. The bounding-box 
manipulator has a set of handles that let you interactively manipulate objects 
in the viewports.

To activate the bounding-box manipulator:

1. Select the object.

2. Press the B key.

3. Press the Tab key to alternate between the two types of manipulator 
handles, each of which let you perform different types of operations (see 
the illustration below).

Click and drag on a single axis to 
scale along it.

Double-click to toggle between a 
single active axis and all three 
axes, or Shift+double-click to 
toggle activeness of a single.

Click and drag along the 
diagonal between two axes t
scale both those axes 
uniformly.

Click and drag the center left or right 
to scale all active axes uniformly.
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Mode 1: Scaling

Position the mouse pointer over one of the manipulator’s corners:

• To scale uniformly about the object’s center, click a corner and drag.

• To scale non-uniformly relative to the opposite corner, Shift+click and drag.

• To scale uniformly relative to the opposite corner, Ctrl+click and drag.

Mode 1: Rotating

Position the mouse pointer over one of the manipulator’s edges:

• To rotate about an axis parallel to the picked edge passing through the 
object’s center, click an edge and drag.

• Press the Shift key to rotate relative to the opposite edge.

• Press the Ctrl key to rotate the edge freely.

Drag corner manipulator
to scale the object.

Drag bounding-box edge to
rotate the object on a given axis.

Drag a bounding box
plane to translate the

object along that plane.

Drag the arrow manipulator
to rotate the object freely

along its three axes.

Manipulator mode 1: Scaling, rotating, and translating 

Manipulator mode 2: Rotating only 
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Mode 1: Translating

Position the mouse pointer over one of the manipulator’s sides:

• To translate in any direction along the plane, click the plane and drag.

• To translate perpendicularly to the picked plane, Shift+click and drag.

• To translate freely in any direction, Ctrl+click and drag.

Mode 2: Rotating

• Drag the arrow manipulator to rotate the object freely along its three axes.

Center Manipulation

Center manipulation lets you move the center of an object without moving its 
points. This changes the default pivot point used for rotation and scaling. You 
can transform the center interactively, or you can move it to the geometric 
center of selected points.

You can manipulate the center of any geometric object in Avid 3D except for 
nulls, control objects, or anything else without points.

To transform an object’s center:

1. Select an object.

2. Activate center manipulation mode by clicking the Center Transform 
Mode button on the transform tools panel.

3. Scale, rotate, or translate the center as needed.

4. When you have finished, turn off center manipulation mode by clicking 
the Center Transform Mode button again.

To translate an object’s center to the center of selected points:

1. Select one or more points.

If you select an object, its center moves to the geometric center of all points.

2. Click the Move Center to Selected Points button on the transform 
tools panel.

The object’s center moves to the geometric center of the selected points.
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To translate an object’s center to the center of its bounding box:

1. Select an object, or one or more points.

2. Click the Move Center to Object Bounding Box button on the transform 
tools panel.

The object’s center moves to the center of the bounding box of the object 
or points.

Snapping

Snapping lets you transform elements interactively with precision. When 
snapping is activated, elements jump in discrete increments from their current 
values when translating, rotating, or scaling. You can snap to grid intersections 
or by increments.

To snap to grid intersections:

t Press the Ctrl key while translating an object.

As you drag the mouse, a snap region follows your mouse pointer; 
the element you are manipulating snaps to grid intersections within the 
snap region.

To snap incrementally:

t Do one of the following:

t Press Shift while translating an element to translate in increments of 
one distance unit.

t Press Shift while rotating an element to rotate in increments of 
fifteen degrees.

t Press Ctrl while scaling an element to scale in increments of 0.5 (Shift 
is used for scaling uniformly).

Resetting Transformations

When you reset an object’s transformations, its local scaling, rotation, and 
translation return to the default values. It effectively removes transformations 
applied since the object was created.
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To reset transformations:

1. Select one or more objects.

2. Click one of the following icons from the transform tools panel:

- Reset Scaling sets the objects’ local scaling values to (1, 1, 1).

- Reset Rotation sets the objects’ local rotation values to (0, 0, 0).

- Reset Translation sets the objects’ local position values to (0, 0,0).

- Reset All Transforms resets the scaling, rotation, and translation.

Aligning Objects

You can reposition a group of objects so that the bottom, top, right, left, or 
center of their bounding boxes are aligned.

Aligning the bottoms of objects’ bounding boxes along the X axis, for 
example, is a quick way to position a group of objects onto a flat surface, such 
as a table.

To align objects:

1. Select the objects to be aligned.

2. In the transform tools panel, click the appropriate button for aligning the 
selected objects along a particular axis.

The following examples assume the middle of each object is being aligned 
along the Y axis:

Align Selected Objects - Minimum 
aligns the bottom of all object 
bounding boxes with the object 
whose bounding-box bottom has the 
lowest axis value.
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Duplicating Objects

When you create a copy of an object, you create an independent duplicate of 
the original. The copy bears all the characteristics of the original at its moment 
of duplication, but from that moment on any changes to the original has no 
effect on the copy. Any animation, materials, or textures on the original object 
are also duplicated.

To duplicate one or more objects:

1. In any viewport, select the object(s) to be copied.

- If you’re duplicating a whole hierarchy, branch-select the parent 
object (see “Selection and Hierarchies” on page 113 for more 
information).

- If you’re duplicating a model, select the model node in the scene explorer 
(see “A Word about Models” on page 107 for more information).

2. Click the Duplicate button in the control bar or press Ctrl+D.

Align Selected Objects - Middle 
aligns objects according to the 
average midpoint of all their 
bounding boxes.

Align Selected Objects - Maximum 
aligns the top of all object bounding 
boxes with the object whose 
bounding box top has the highest 
axis value.
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Chapter 5
Importing and Exporting Files

For most projects, you will need to import and export scene data for reuse in 
other scenes or software packages. To do this you will use the import and 
export commands available from the File menu on the main menu bar.
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What Can Be Imported and Exported?

The import commands let you import EMDL models, dotXSI, and EPS files. 
These formats can be used by both SOFTIMAGE|XSI and Avid 3D.

For details on importing EPS files—the encapsulated postscript file format, 
see “Creating Logos” on page 187.

For details on importing WAV or AIFF audio files for synchronizing your 
animation with sound, see “Playing Back Audio with Your Animation” on 
page 276.

The File > Export Model command lets you export EMDL models.

Importing Models and Scenes

You can import models and scenes into Avid 3D in the following formats:

• EMDL—the file format for storing model data.

• dotXSI—the ASCII or binary file format for storing scene data.

Considerations when Importing

When importing a scene or model into Avid 3D, take note of the following to 
help you validate your scene after the import process:

• Timeline Information—An imported scene contains timeline 
information that defines its length according to a start and end frame. A 
scene’s entire frame range is inserted at frame 1 of the timeline. 

• Models —In general, scenes and models are imported as models into the 
current scene model. For more information, see “A Word about Models” 
on page 107.

• Scene Ambience —When you import a model created with a version of 
SOFTIMAGE|XSI previous to 3.0, the scene’s ambience may be changed. 
For more information, see “Scene Ambience” on page 205.
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Importing EMDL Models

You can import a SOFTIMAGE|XSI or Avid 3D model in the EMDL format 
for reuse in any scene.

When you import a model, its data becomes part of your scene. It is as if the 
model was created directly in the scene — there is no live link to the .emdl 
file. You can make any changes you want to the model and its children.

To import an EMDL model:

1. Choose File > Import Model from the main menu.

2. In the Import Model browser, open the folder containing the model you 
wish to import.

3. Select the model file name and click OK.

Image Clips and Imported Models

When you import a model using File > Import Model, the default is to share 
image clips. This means that if any image clips (for example, textures) on the 
model are the same as clips that are already in the scene, then the existing clips 
are automatically reused. This prevents unnecessary image clips from 
accumulating in your scene.

Importing dotXSI Files

To import a dotXSI file:

1. Choose File > Import dotXSI File from the main menu.

2. The Import .xsi browser opens to the current project folder. Navigate to 
the folder that contains the dotXSI file you want to import.

3. Select the file to be imported. Its name appears in the File Name text box.

To select a dotXSI file (.xsi), make sure that the File Types text box is set 
to Exported .xsi Files (*.xsi).

4. Click OK. The imported scene’s contents are added as a model under the 
current scene.
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Exporting Models

The File > Export Model command available from the main menu lets you 
export models from Avid 3D in the EMDL format— the file format used to 
save exported models.

When you export a model, a copy is saved as an independent file. The 
exported model contains only its internal relationships—the export process 
removes constraints, expressions, linked parameters, and any other attributes 
that involve elements that are not children of the model. The file names of 
exported models have an .emdl extension and are saved to the Models folder 
of the project by default.

n Although the Scene_Root is considered a model, you cannot export it as a model.

To export a model:

1. Select the model to be exported.

2. Choose File > Export Model from the main menu.

3. In the Export Model browser, open the folder in which the model is to be 
saved. Under File Name, enter the name of the model to be exported and 
click OK.

Animation of the model’s root is not exported. Only animation of the 
objects within the model is exported.

If the render region is displayed when you export, it will be used as a 
thumbnail for the model in the browser. Note that previous thumbnails are 
not kept when you re-export and overwrite the model file; if the render 
region is not open when you re-export, any existing thumbnail is lost.



Chapter 6
Modifying Object Geometry

There are several ways to modify the geometry of objects in your scene in 
Avid 3D. For example, you can:

• Change the shape of an object by applying a deformation.

• Modify profile curves to change the shape of revolved or extruded objects. 

• Adjust the shape of objects by manipulating or deleting points and polygons. 
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Deforming Objects

Deformations are operations that change a geometric object’s shape by 
moving its points in 3D space. Avid 3D provides several different types of 
deformation that you can apply to objects in your scenes, such as twist, bend, 
and many others.

Working with Deformations

This section describes some generalities that apply to all or most deformations 
in Avid 3D. Each specific type of deformation is described in more detail in 
the sections that follow.

Applying Deformations

In general, you can apply most deformations simply by selecting one or more 
geometric objects and then clicking a button on the Deformation Tools tab of 
the tools and options panel. 
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Modifying Deformation Parameters

Most deformations have parameters that you can modify to alter the effect. 
The specific parameters that are available depend on the type of deformation.

Some of these parameters, such as the amplitude, are available in the on-
screen Deform Controls. This parameter set collects the most-used parameters 
from every deformation you apply to the same object, and displays them 
together. 

Many deformations have other controls that are available only in their specific 
property editors. You can display the deformation’s property editor by selecting 
it on the Geometry and Deform Properties tab of the multi-purpose editor.

Animating Deformations

You can mark and animate many deformation parameters directly. The 
procedure is exactly the same as for any other animatable parameter—see the 
chapter “Animating in Avid 3D” on page 261. This allows you to create very 
simple shape animation, like an animated twist.

Select the deformation 
on the left...

...to display its 
parameters on 
the right.
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Removing Deformations (Resetting Shapes)

After you have applied deformations to an object, you can remove them and 
return the object to its original shape by selecting it and clicking the Reset 
Shape button on the Deformation Tools tab of the tools and options panel. This 
deletes the deformation operators, so you are no longer able to modify the 
deformation parameters.

If you want to temporarily disable the effect of the deformation, you can mute 
it instead of removing it, as described in the next section.

Muting Deformations

All deformations can be muted by activating the Mute parameter in its 
property editor. This temporarily turns off the deformation, preventing it from 
affecting the objects on which it is applied, without removing the deformation 
operator or resetting its parameter values. 

For example, if you applied two different deformations to an object, you can 
mute the second one so you can isolate the effect of the first deformation while 
you adjust its parameters. You can also mute an animated deformation to 
improve interaction as you work on other parts of your scene. You can even 
animate the Mute parameter itself if you want to turn a deformation on and off 
at different frames. 

When an operator is muted, the letter M appears on its icon in the Geometry 
and Deform Properties tab of the multi-purpose editor.

Deformations on Hierarchies

An object with a hierarchy provides more possibilities for deformation 
animation than a single object. You can apply the deformation on the parent 
selected in branch mode (middle-mouse button) or tree mode (right-mouse 
button), in which case the deformation is transmitted to its children as if the 
hierarchy were a single piece.

All objects in the hierarchy share the same deformation operator. Opening the 
property editor of any object and modifying deformation parameters affects all 
objects in the hierarchy, and resetting the shape of any object resets all of them.
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Simple Deformations

There are a variety of simple deformations you can quickly apply to objects. 
The deformation is controlled solely by its parameters and does not involve 
other objects in the scene. 

Simple deformations include:

• Bend

• Bulge

• Push

• Shear

• Taper

• Twist and Vortex

• Shape Jitter

Applying Simple Deformations

You can apply a simple deformation to one or more objects, particle clouds, 
hierarchies, or models.

To apply a simple deformation:

1. Select an object, particle cloud, model, or hierarchy.

2. Choose one of the simple deformations from the Deformation Tools 
panel: Bend, Bulge, Push, Shear, Taper, Twist, Vortex, or Shape Jitter.

3. Adjust and animate the parameters as desired. Refer to Online Help for 
information about every parameter on the deform property page.

Undeformed hat
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Types of Simple Deformations

This section provides a quick visual reference of the effects you can achieve 
with the different types of simple deformation. For a complete description of 
every parameter available for a given deformation, refer to Online Help.

Bend

Bend folds an object. You can specify the axis that gets bent, the angle of the 
bend, the radius over which the bend occurs, the position where the bend 
starts, and the direction of the bend.

Deformed hat

Bend deformation
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Bulge

Bulge pushes an object’s points out from the center. You can specify which 
axes the deformation occurs on, as well as the reference axis, the amplitude, 
and the amplitude’s profile.

Push

Push moves points perpendicularly to the surface each position. You can 
specify the amplitude. 

Bulge deformation

Push deformation
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Shear

Shear pulls the ends of an object in opposite directions. You can specify which 
axes the deformation occurs on, as well as the reference axis, the amplitude, 
and the amplitude’s profile.

Taper

Taper gradually scales an object in one direction. You can specify which axes 
the deformation occurs on, as well as the reference axis, the amplitude, and the 
amplitude’s profile.

Shear deformation

Taper deformation
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Twist and Vortex

Twist progressively rotates an object in one direction. You can specify the axis 
of rotation, the maximum angle, and the angle’s modulating profile.

Vortex is a variation on the Twist deformation, where the amplitude of the 
rotation depends on the radial distance from the axis. The maximum angle occurs 
at the center of the deformation and tapers off toward the edges of the object.

Twist deformation

Vortex deformation
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Shape Jitter

Shape Jitter moves points around randomly over time. You can specify the 
maximal displacement in each axis, the number of repetitions, and the way 
that random values are generated.

Lattices

Lattices make it easy to deform a large amount of geometry at once. They 
allow you to deform objects by warping the 3D space around them. A lattice is 
a control box with a variable resolution, looking rather like scaffolding 
surrounding an object. 

When you move a point on a lattice, its original location in space is mapped to 
its new location. This squashes or stretches the space between points on the 
lattice, and objects that are affected by the lattice become distorted.

Lattice deformations have two parts: 

• A lattice object. You can set the number of subdivisions and other properties.

• A lattice deformation operator on each object deformed by the lattice. 
This operator can be muted. 

Shape jitter deformation
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Creating and Applying Lattices

You can create a lattice and apply it to an object at the same time.

To create and apply a lattice:

1. Select the objects you want to deform.

2. Click the Lattice button on the Deformation Tools panel. A lattice is 
created to fit the object.

3. Open the Lattice property editor by clicking the Multi-Purpose Editor 
button in the control bar to fine-tune the lattice’s parameters.

- You can set the lattice’s subdivisions in each axis; more subdivisions 
give greater resolution for the deformation.

- You can also set the interpolation type along each axis. Curve yields 
smoother deformations than Linear.

Deform objects 
by moving points 
on a lattice

Undeformed Linear 
interpolation

Curve 
interpolation
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4. Deform the lattice in any way. For example, you can select and move 
points or polygons as described in “Manipulating Points and Polygons” 
on page 170, or apply any other deformation to it. As the lattice deforms, 
the object deforms with it.

Quickstretch

Quickstretch is an animated deformation that changes an object’s shape 
automatically, based on its motion. Quickstretch calculates deformations on 
the fly, according to the object’s speed and acceleration. You can make objects 
flex, stretch, and yield, based on their linear and rotational motion.

There are four components of motion used to calculate quickstretch 
deformation: linear velocity, linear acceleration, rotational velocity, and 
rotational acceleration. These motion components are described in more detail 
in “Motion Components” on page 152.

For each motion component, you can apply up to three quickstretch 
deformations: flexing, stretching, and yielding. The different effects of these 
deformation types is described in “Quickstretch Deformation Types” on 
page 153.

Once you have applied quickstretch, you can see the effect by playing back the 
animation or by moving the object around in a geometry view.

Before You Apply Quickstretch

Before you apply quickstretch, there are a couple of things you should check: 
object centers and subdivisions.
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Object Centers

Objects with quickstretch appear to be deformed by some force—whether 
active or inertial—and the location where this force seems to be applied is the 
center of the deformation. Quickstretch uses the object center as the center of 
the deformation. 

Before you apply quickstretch, make sure that the object’s center is located 
where you want the deformation to emanate from. For example, if a building 
faces such a strong wind that it bends a little, the deformation should originate 
from the ground up because you would expect the building to be attached to 
the ground.

Object Subdivisions

Quickstretch looks best with many subdivisions in the deformed object, but 
that can result in a great deal of computation and a heavy scene.

You can use the object’s property editor to change its subdivisions at any time, 
using fewer subdivisions to help you work quickly and then adding more 
subdivisions for the final result.

Quickstretch uses the object center for deforming.
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Applying Quickstretch

To create a quickstretch deformation:

1. Select an object.

2. Click the Quickstretch button in the Deformation Tools panel.

3. Open the QStretch Op property editor by selecting the object and clicking 
the Multi-Purpose Editor button in the control bar.

4. Set the parameters as desired. On the Overview property page, you can 
toggle the three deformation types (Flex, Stretch, and Yield) for each 
motion component (Linear Velocity/Acceleration and Rotational 
Velocity/Acceleration). 

These toggles are also available on the other property pages, which also 
provide finer control over the deformations associated with each motion 
component. See “Motion Components” on page 152 and “Quickstretch 
Deformation Types” on page 153.

Viewing a Quickstretch Deformation

Once you have created a quickstretch deformation, you can view the effect in 
either of the following ways:

• By playing back the animation.

• By using the Translate tool to move the object around in a viewport.

Since motion vectors are computed on the fly during playback of an animated 
sequence, the deformation that occurs is different if you play the animation 
backward!

Similarly, if you jump from one frame to another, a huge deformation may 
occur if the difference in position implies a very large velocity or acceleration. 
In this case, the geometry returns to normal at the next refresh.

Motion Components

Quickstretch uses the following aspects of an object’s motion to deform the object.

• Linear velocity

• Linear acceleration

• Rotational velocity

• Rotational acceleration
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A moving object has speed or velocity. If it is changing speed, then it also has 
acceleration or deceleration. For example, a car moving at a steady 100 km/h 
has a velocity of 100 but an acceleration (and deceleration) of 0.

Velocity and acceleration can each be further divided into two types: linear 
and rotational. For example, a car that moves along a straight line has only a 
linear motion, whereas a ball that spins on the spot has only rotational motion. 
Regardless of the type of motion, the faster the object is moving, the more it 
is deformed.

Quickstretch Deformation Types

Whichever type of motion you give to an object, it can be deformed in one or 
more ways: it can flex, stretch, yield, or do any combination of the three. 

Each of these deformation types can be weighted independently of the others, 
but their effects are additive. Each effect is designed to be tweaked separately 
as much as possible, so that when you use them all together the resulting 
deformation is more predictable. 

Flexing

A flexible object when moving rapidly in one direction appears to bend or flex 
in the direction of the motion, due to the resistance of the air (or water).
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Stretching

In the case of a cartoon “squash and stretch” effect, the object usually elongates 
in the direction of the motion and becomes thinner in the other directions.

Yielding

Yielding simulates the way a moving object might bulge due to the internal 
displacement of its mass.

Waves

Waves are animated deformations that travel in both time and space. You can 
create shock waves, water waves, and other types of natural disturbances with 
wave deformations.
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Wave Control Objects and Wave Operators

There are two basic parts of a wave deformation: the wave control object and 
the wave operator.

Wave Control Objects

The wave control object controls the basic parameters that are intrinsic to the 
wave itself, such as its speed and shape. Each wave control object can be used 
to deform any number of objects in a scene.

The wave control object is represented by a wireframe icon in the viewport; 
there are different icons for the different types of wave. The position of the 
wave control object also defines the “epicenter” of the wave and its orientation 
defines the direction of the waves.

Wave Operators

The wave operator deforms an object or cluster by “attaching” a wave control 
object. It controls the parameters that are specific to how the wave affects a 
particular object, such as the spread of the deformation.

Making Waves

To create and apply a wave to objects:

1. Select one or more objects.

2. Click one of the wave deform buttons on the Deformation Tools panel. 
The different buttons apply presets of different types of wave: circular, 
planar, or spherical. You can change the wave type later as described in 
“Setting the Wave Type” on page 156.

The wave control object is created (as represented by a wireframe icon in 
the viewport) and applied to the selected objects. The wave object is 
automatically placed at the deformed object’s center as a child of the object.

Modifying Wave Control Objects

To set the wave’s basic characteristics such as its shape and speed, use the 
wave object’s Wave property editor (available on the Geometry and Deform 
Properties tab of the multi-purpose editor)—these are described in the sections 
that follow. As you change the various parameters in the editor, you can see 
the effect on an object’s deformation.
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You can also scale, rotate, and translate the wave control object to define its 
center and the direction of the waves.

Setting the Wave Type

The Type parameter on the General tab of the wave property editor controls 
how the wave moves through space. There are three options: circular, planar, 
and spherical. Each type of wave is represented by a different control object in 
the viewport and is shown in the following illustrations.

• Circular—The waves move out from a point in a circular, planar pattern, 
like those from a pebble dropped in still water.

• Planar—The waves move out from a line in a straight, planar pattern, like 
waves hitting a beach or a flag fluttering in the wind.
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• Spherical—The waves move out from a point spherically in all 
directions, like the shock waves of an explosion.

Setting the Displacement Direction

The Displacement Direction determines which way the points of deformed 
objects move when they are displaced:

• Up displaces points along the local Y axis of the wave object.

• Direction displaces points in the direction in which the wave is moving.

• Normal displaces each point perpendicularly to the surface of the 
deformed object at that point.

Setting the Wave Profile

The shape of the wave’s displacement is controlled by the Amplitude Profile 
curve on the Profiles property page of the Wave property editor. You can edit 
the profile using the mouse and the same keyboard commands as the function 
curve editor.



Chapter 6 Modifying Object Geometry

158

Controlling Periodicity

Periodicity allows the wave to repeat continuously. There are two kinds of 
periodicity:

• in Space repeats the shape of the wave’s profile between the first and last 
key points indefinitely. 

• in Time repeats the entire wave effect, including the result of Amplitude 
and Spread as set in the operator’s property editor (not the object’s). 

The wave deformation begins again after the End frame set on the Time 
Control tab of the operator’s property editor.

Controlling Speed

You can control the velocity and acceleration at which the wave profile moves 
through space using the Velocity and Acceleration parameters in the wave 
control object’s property editor. You can even use a negative velocity to make 
the wave move backward.

Controlling Falloff

You can make the strength of the wave effect fall off after a certain vertical 
distance from the wave control object. The effect decays linearly between the 
Vertical Falloff Start and End values as measured along the wave’s local Y axis.

Transforming the Wave Control Object

Translations and rotations may be applied to wave control objects in the same 
manner as ordinary objects. The wave’s effect on objects changes in the 
obvious way. For example, if you move a circular wave along a grid, you 
change the point from which the wave emanates.

You can apply scaling as well. The wave control object changes shape 
accordingly, but the wave’s effect on objects changes only in the following ways: 

• For scaling in X and Y, the effect appears as if the profile curve were 
scaled correspondingly.

• Scaling in Z does not change the effects of circular or spherical waves, but 
it does change the Z-extents for planar waves. The planar-wave control 
object makes this quite clear. 
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Modifying Wave Operators

The wave operator deforms an object or cluster by “attaching” a wave control 
object. The wave operator is a deformation node that controls the parameters 
that are specific to how the wave affects a particular object, such as the 
amplitude and spread of the deformation. By default, both the amplitude and 
spread are animated with a function curve.

n To make sure that the wave operator gets re-evaluated to update the object’s 
deformation at every frame, at least one of its parameters must be animated. A 
single keyframe (that is, a flat, constant-value fcurve) is enough.

By default, both the Amplitude and Spread parameters are animated, so the 
wave operator will be re-evaluated unless you remove the animation.

Controlling Amplitude

Amplitude provides an overall scaling factor for the wave profile’s height 
over time. By default it starts at 0, rises sharply to 1, and then decays slowly 
back to 0. This corresponds to a wave rising rapidly on a surface and then 
slowly receding back to nothing.

High amplitude Low amplitude
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Controlling Spread

Spread gives an overall inverse scaling factor to the X values of the wave 
profile. For example, a value of 0.5 stretches the profile by 2 horizontally, 
which has the effect of spreading the wave. 

By default, the spread is the constant value 1. Certain types of waves, such as 
water waves, spread out as they move. For such waves, you should edit the 
spread function curve to start at 1 and end at a smaller value such as 0.5.

Controlling the Start and End

The options on the Time Control tab of the Wave Op property editor control 
the time span of the wave effect:

• Start offset is the first frame for which the wave begins to affect the object.

• End is the last frame for which the wave affects the object.

Wave spreads out over time
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Deforming by Curves

Deformation by curve distorts an object by remapping one of its axes to any 
curve you pick. You can animate the object in the deformed space defined by 
the curve, and any changes you make to the shape of the curve are reflected in 
the deformed object.

To deform an object by a curve:

1. Select the geometric object to be deformed.

2. Click one of the Deform by Curve buttons on the Deformation Tools tab 
of the tools and options panel. The two buttons apply different presets of 
the deform by curve operator that result in different orientations, but you 
can always adjust the orientation no matter which one you choose.

A picking session starts.

3. Pick a curve in your scene. You can click on a curve in a viewport or in the 
scene explorer.

The object is immediately deformed by the curve.

4. Adjust the deformation’s parameters. The basic parameters are available 
in the on-screen Deform Controls, but all parameters are available in the 
Curve Deform property editor on the Geometry and Deformation 
Properties tab of the multi-purpose editor. 

- Specify which Axis of the object you want to follow the curve.

- Use the Scaling Along parameters to adjust the size of the object with 
respect to the curve.
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- Adjust the Roll to spin the object around the length of the curve until 
it is oriented correctly.

- Use the Translation Along parameters to adjust the position of the 
object with respect to the curve. For example, you can animate 
Translation Along Curve (called Pos On Curve in the on-screen 
parameter display) to make the object snake along the curve. 

n Using the Scale, Rotate, or Translate tools on the curve affects the deformed 
object as well.

Working with Profiles

Several types of object in Avid 3D are generated from one or more profile 
curves by revolution or extrusion. You can modify the profile curves to change 
the shape of the generated objects.

Overview of Profiles

Here’s a quick overview of working with profile curves and generated object 
in Avid 3D:

1. Add an object with profiles by dragging it from the Obj. w Profile section 
of the object library and dropping it into your scene.
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2. Display one of its profile curves in the profile editor as described in 
“Displaying Curves in the Profile Editor” on page 164.

3. Use the profile editor to modify the curve as described in “Modifying 
Curves in the Profile Editor” on page 165. You can add, remove, and 
transform points. As you modify the curve, the generated object is updated.
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Displaying Curves in the Profile Editor

The Profile Editor tab of the multi-purpose editor lists the profile curves 
associated with the selected object. You can select a curve to edit from this list, 
as well as select a curve from a viewport or the scene explorer.

To display a curve in the profile editor:

1. Select a curve and click the Profile Editor tab of the multi-purpose editor. 
You can do this in either of the following ways:

t Select an object with profiles. On the Profile Editor tab of the multi-
purpose editor, select the curve you want to edit. This deselects the 
object—if you later want to work on a different profile of the same 
object, simply select the object again. 

t Select a curve in a viewport or the scene explorer, and click the 
Profile Editor tab of the multi-purpose editor. 

Select the curve to edit.
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2. By default, the profile editor displays the front view of the selected curve. 
If the curve is lying flat in the ground plane, then you may need to orbit 
the camera (press O or use the Camera Orbit Tool button in the control bar 
of the main window). 

In fact, you can use any of the camera control buttons or shortcuts in the 
profile editor to orbit, dolly, pan, zoom, roll, frame, and reset the camera. 
You can also press G while the mouse pointer is over the profile editor to 
toggle the grid on or off. 

Modifying Curves in the Profile Editor

You can modify curves in the profile editor by adding and removing points, as 
well as changing the position of points by moving or transforming them. 
When changing the position of points, you have the option of affecting nearby 
points proportionally. As you modify the curve, the object that is generated by 
that curve is updated automatically. 

n To edit the curve, it must be selected. If you change the selection, you must re-
select the curve before you can edit it again. 

You can also use the following tools to edit curves in the viewports.

Linear and Smooth Curves

There are two types or curves you may encounter in Avid 3D: linear and smooth.

• Linear curves are polylines, with points joined by straight segments.
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• Smooth curves are, technically speaking, cubic NURBS (non-uniform 
rational B-splines). Unlike Bézier curves, the curve does not pass through 
the control points but rather is a weighted interpolation between the 
control points. Moving points further apart or closer together influences 
the shape of the curve.

Adding Points

To add points to a curve:

1. Activate the Add Point tool by pressing the I key or clicking the Add 
Point Tool button in the profile editor. 

2. Do one of the following:

t To add a point between two existing points, click somewhere close to 
the segment joining the two points.

t To add a point at the end of the curve, middle-click.

Before releasing the mouse button, you can drag the mouse to adjust the 
position of the new point.

Moving control points influence 
the shape of the curve as it is 
interpolated between them.
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3. Continue adding new points as desired. 

When you have finished, exit the tool by right-clicking, pressing Esc, or 
activating another tool.

Removing Points

To remove points from a curve:

1. Activate the Delete Point tool by pressing Backspace or clicking the 
Delete Point Tool button in the profile editor. 

2. Click on a point to remove it.

3. Continue removing points as desired. 

When you have finished, exit the tool by pressing Esc or activating 
another tool.

Moving Points

You can use the Move Point tool to move the single point under the mouse 
pointer as described below. This lets you quickly move points one at a time 
without the need to select each point first.

When using the Move Point tool, you have the option of affecting nearby 
points proportionally as described in “Editing Proportionally” on page 168. As 
an alternative to moving points one at a time, you can transform selected 
points as described in “Transforming Points” on page 168.

To move points on a curve:

1. Activate the Move Point tool by pressing M or clicking the Move Point 
Tool button in the profile editor. 

2. Place the mouse pointer over a point, then click and drag the point to a 
new position before releasing the mouse button.

- Use the left mouse button to drag freely in the view.

- Use the middle mouse button to drag vertically.

- Use the right mouse button to drag horizontally.

3. Continue moving points as desired. 

When you have finished, exit the tool by pressing Esc or activating 
another tool.
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Transforming Points

You can transform selected points in the same way you transform objects. This 
allows you to move one or more points at the same time.

When transforming points, you have the option of affecting nearby points 
proportionally as described in “Editing Proportionally” on page 168. As an 
alternative to selecting points, you can move points individually without 
selecting them first as described in “Moving Points” on page 167.

To transform points:

1. Select some points using the Select Point tool (press T or click the Select 
Point Tool button in the profile editor). 

2. Activate a transform tool using the buttons on the control bar of the main 
window or the corresponding keyboard shortcut (V for Translate, C for 
Rotate, or X for Scale).

3. Use the manipulator to transform the points.

You can use the Ctrl key to snap to the grid or scale in increments, or the 
Shift key to translate and rotate in increments or scale uniformly.

By default, points are rotated relative to the object’s center; that is, 
rotating points spins them around the object’s center. Points are scaled 
about their local center—scaling a single point has no visible effect, but 
scaling a group of points moves them away from or toward their average 
location. However, you can use the Alt key to set the center of 
manipulation. 

For more details about transforming, see “Transformation Basics” on 
page 119. 

Editing Proportionally

When moving or transforming points, you have the option of affecting nearby 
points as well. The strength of the effect falls off proportionally with the 
distance from the points you are manipulating: points that are closer are 
affected more strongly than points that are farther away. 



Working with Profiles

169

The strength of the effect is indicated by the color of the points. Points that 
will be affected strongly are highlighted in bright red, while points that will be 
affected less strongly are darker red. Points that will not be affected at all are 
blue. This highlighting is displayed in the views when: 

• Proportional editing is on, one or more points are selected, and a 
transformation tool is active.

• Proportional editing is on, the Move Point tool is active, and you click and 
hold the mouse button down over a point.

To activate or deactivate proportional editing:

t Click the Proportional Mode button in the profile editor.

This setting affects point manipulation in the viewports as well as in the 
profile editor.

To adjust the proportional radius:

t Do one of the following:

t In the profile editor, click the plus (+) button to increase the radius or 
the minus (–) button to decrease it. 

t While proportional mode is on, and either a transformation tool or the 
Move Point tool is active, press R and drag the mouse in a view to the 
left to decrease the radius or to the right to increase it. 
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Modifying Points and Polygons

In addition to applying deformations and modifying profile curves, you can 
modify points and polygons directly in the viewports. You can manipulate 
components by scaling, rotating, translating, and moving, as well as delete 
components.

Manipulating Points and Polygons

You can manipulate components in various ways:

• You can transform points, polygons, and clusters by selecting and scaling, 
rotating, and translating them.

• You can move points one at a time without the need to select them 
individually.

• When transforming or moving points, you have the option of affecting 
nearby points proportionally as described in “Editing Proportionally” on 
page 168.

Transforming Points and Polygons

You can transform selected points, polygons, and clusters in the same way you 
transform objects. 

By default, components are rotated relative to the object’s center; that is, 
rotating them spins them around the object’s center. Components are scaled 
about their local center—scaling a single point has no visible effect, but 
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scaling a polygon or a group of points moves the vertices away from or toward 
their average location. However, you can use the Alt key to set the center of 
manipulation. 

You can use the Ctrl to snap to the grid or scale in increments, and the Shift 
key to translate and rotate in increments or scale uniformly.

For more details about transforming, see “Transformation Basics” on page 119.

To transform points or polygons:

1. Select some points using the Select Point tool (press T or click the Select 
Point Tool button in the control bar). 

2. Activate a transform tool using the buttons on the control bar of the main 
window or the corresponding keyboard shortcut (V for Translate, C for 
Rotate, or X for Scale).

3. Use the manipulator to transform the points.

Moving Points

You can use the Move Point tool to move the single point under the mouse 
pointer. This lets you quickly move points one at a time without the need to 
select each point first.

To move points on a curve:

1. Select a geometric object.

2. Activate the Move Point tool by pressing M (or clicking the Move Point 
Tool button in the profile editor). 

3. Place the mouse pointer over a point, then click and drag the point to a 
new position before releasing the mouse button.

- Use the left mouse button to drag freely in the view.

- Use the middle mouse button to drag vertically.

- Use the right mouse button to drag horizontally.

4. Continue moving points as desired. 

When you have finished, exit the tool by pressing Esc or activating 
another tool.
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Resetting Shapes

After you have manipulated components, you can return an object to its 
original shape by selecting it and clicking the Reset Shape button on the 
Deformation Tools tab of the tools and options panel.

Deleting Points and Polygons

You can delete points and polygons by selecting them and pressing Delete. 
Deleting removes polygons, leaving empty holes in the object.

• When points are deleted, any polygons that share those points are 
also deleted.

• When polygons are deleted, any points that are no longer attached to a 
polygon are also deleted.

Deleting selected 
point

Deleting selected 
polygons



Chapter 7
Working with Text and Logos

Avid 3D allows you to add text and logos to your scenes. There are features 
for editing and formatting, extruding and beveling, applying materials and 
textures, as well as advanced controls. You can even quickly set up a “follow-
the-leader” animation by creating a text rig.
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About Text and Logos

Text and logos are ordinary geometric objects in Avid 3D. You can transform 
and animate them, apply materials and textures to them, deform them, or even 
use them as particle emitters. 

After you add text and logo objects to your scene, you can find them in the 
Geometry section of the scene explorer together with all the other geometric 
objects. They are also listed in the Text section of the scene explorer—if your 
scene contains many objects, this lets you find text and logos quickly because 
it does not list any other type of object.

In addition, text and logos rely on curves. These curves are generated from the 
font in the case of text, or imported from a drawing program in the case of 
logos. By default they are hidden in 3D views, but they can be found in the 
Curves, Paths section of the scene explorer. 

Do not delete these curves, because Avid 3D needs them to generate the solid 
objects. If you delete the curves, the corresponding text or logo is removed 
from your scene.

Text 
Logo 

Logo curve
Text curve
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Overview of Text and Logos

The processes of creating text and logos involve many similar steps, and are 
quickly outlined in the sections below. Each step is described in more detail in 
later sections.

Overview of Text

Here is a quick overview of the process of creating and working with text:

1. Add a text object to your scene, and then edit and format it as described in 
“Creating and Editing Text” on page 179.

2. Adjust the extrusion and beveling as described in “Extruding and 
Beveling Text and Logos” on page 188.

3. Apply materials and textures to the various parts of the text as described in 
“Applying Materials and Textures to Text and Logos” on page 191.
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4. If desired, modify the text further as described in “Advanced Text and 
Logo Controls” on page 192. For example, you can control the 
smoothness and density of the mesh, change the tessellation method, 
adjust the mitering and rounding, and so on. 

5. Do anything else you like with the text. For example, you can transform 
and animate it, as well as deform it.

6. If you want to create a “follow-the-leader” style animation, see “Creating 
a Text Rig” on page 200.

Overview of Logos

Here is a quick overview of the process of creating and working with logos:

1. Import an EPS file into your scene as described in “Creating Logos” on 
page 187.
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2. Adjust the extrusion and beveling as described in “Extruding and 
Beveling Text and Logos” on page 188.

3. Apply materials and textures to the various parts of the logo as described 
in “Applying Materials and Textures to Text and Logos” on page 191.

4. If desired, modify the logo further as described in “Advanced Text and 
Logo Controls” on page 192. For example, you can control the 
smoothness and density of the mesh, change the tessellation method, 
adjust the mitering and rounding, and so on. If you want to animate 
different portions separately, you should explode the mesh. 
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5. Do anything else you like with the logo. For example, you can transform 
and animate it, as well as deform it.
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Creating and Editing Text

Creating and editing text is a multi-step process:

1. Add a text object to your scene as described in “Creating Text” on 
page 179.

2. Edit and format the text string as described in “Editing and Formatting 
Text” on page 181.

3. Adjust the size and spacing of the text using the on-screen parameters as 
described in “Controlling Size and Spacing of Text” on page 186.

Creating Text

There are two ways to create text in Avid 3D: 

• Using the Text Tools tab of the Tools and Options panel. This method 
allows you to choose between a single line of text and multiple lines. 

• By dragging an item from the Text section of the object library. This lets 
you create a text rig, or add a text object to another object rig.
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Creating Text with Text Tools

Using the Text Tools tab of the Tools and Options panel, you can create a 
single line of text or multiple lines.

To create text with text tools:

1. In the Tools and Options panel, click the Text Tools tab.

2. Do one of the following:

t To create a single line of text, click the Create Single-Line Text 
Block button.

t To create text that can break across multiple lines, click the Create 
Multi-Line Text Block button.

A new text object is created in your scene. By default, it is named 
polymsh, but you can rename as described in “Element Names” on 
page 110. 

The Text property editor opens, where you can edit and format your text 
as described in “Editing and Formatting Text” on page 181.

Single-Line Multi-Line
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Creating Text with the Object Library

Using the object library, you can drag a predefined text rig into your scene. For 
example, you can get a rig that reveals text gradually or that deforms text on a 
curve. You can also drag and drop text onto an existing rig in your scene.

To create text with the object library:

1. If you want to replace an element in an existing rig with text, select the 
element first.

2. In the library panel, click the Object Library tab.

3. Display the Text section.

4. Drag and drop an element into a viewport.

You can now open the Text property editor to edit and format the 
text—see “Editing and Formatting Text” on page 181.

For information about using rigs in general, see “Rigs” on page 105. For 
information about using the Text - Character Anim. Offset Rig, see 
“Creating a Text Rig” on page 200.

Editing and Formatting Text

You edit and format text using the Text property editor. The Text property 
editor is automatically displayed in a floating window when you create text 
using the Text Tools tab of the Tools and Options panel, but not when you drag 
a text item from the object library.
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At any time, you can display the Text property editor within the multi-purpose 
editor to change the text or its formatting.

To display the Text property editor:

1. Make sure the text object is selected—note that if you dragged an item 
from the object library, the model that contains the text object is initially 
selected instead.

You can select the text object by simply clicking on any part of the text in 
a viewport, or by using the Text section of the scene explorer.

2. Open the multi-purpose editor.

3. On the Geometry and Deform Properties tab, select the Text property.

The Text property editor appears in the right pane of the multi-purpose 
editor.

Typing Text

You can type text into the editing pane of the Text property editor in the same 
way as you would type text in any simple word processor. Use the items on the 
Edit menu to undo, cut, copy, paste, or clear.

Select Text 
property first.

Import or save 
RTF files.

Undo, cut, copy, 
paste, or clear.

Set line 
attributes.

Set font 
attributes.

Apply changes manually
or automatically.

Edit text 
here.
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As you type, the text in the scene may update automatically depending on 
whether Auto is on or off:

• If Auto is on, the 3D views update automatically as you type. Note that 
there is still a small delay before the scene updates, to make sure that you 
have finished typing.

• If Auto is off, the 3D views do not update automatically. Instead, click 
Apply to see the result of your changes. 

By leaving Auto off, you avoid delays that may occur as Avid 3D tries to 
update heavy geometry as you type, particularly when there are extrusions 
and bevels.

n For Single-Line text, you can also apply changes manually by pressing Enter. 
However with Multi-Line Text, pressing Enter starts a new line.

Automatically update 
3D views as you type.

Click to update 3D 
views manually.

To do this... Do this 

Select the entire contents of the editing pane. Ctrl+A

Select a word in the history or editing pane. Double-click on the word.

Select a line in the history or editing pane. Triple-click on the line.

Move selected text. Drag to new location.

Copy selected text. Ctrl+drag to new location.

Cut selected text to the clipboard. Ctrl+X

Copy selected text to the clipboard. Ctrl+C

Paste text from the clipboard. Ctrl+V

Undo the last edit. 

n Make sure that the editing pane has focus, 
that is, that you can see the blinking cursor. 
Otherwise you may undo the last action 
performed in the main window.

Ctrl+Z or Alt+Backspace

Redo the last undo, or repeat the last edit. Ctrl+Y

Go to the next/previous word. Ctrl+right/left arrow

Go to the beginning of the text. Ctrl+Home
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n If the text you type overwrites existing text, it’s probably because you have 
accidentally pressed the Insert key. Press the Insert key again to turn overtype 
mode off.

Setting Font Attributes

Font attributes include the typeface, size, weight (bold or regular), and angle 
(italic or roman). As with most word processors, you can change the attributes 
for selected characters or for new characters. New characters use the formatting 
of the previous character, unless you change the font attributes explicitly.

n Make sure that the font you select is installed on all machines on which you 
intend to work with or render the scene. Otherwise, the typeface will be 
automatically replaced by a default.

Go to the end of the text. Ctrl+End

Extend the selection. Shift+arrow keys, 
Ctrl+Shift+arrow keys

Select from the cursor to the beginning of the line. Shift+Home

Select from the cursor to the end of the line. Shift+End

Select from the cursor to the beginning of the script. Ctrl+Shift+Home

Select from the cursor to the end of the script. Ctrl+Shift+End

Toggle overtype mode on or off. Insert

To do this... Do this 

Typeface 
Select any TrueType or OpenType 

font installed on your computer.

Point Size Italic

Bold
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Setting Line Attributes

The line alignment options control how the text characters are aligned with the 
3D object’s center. When editing Multi-Line text, you can set these options on 
individual lines.

Importing RTF Files

You can import text saved as an RTF (rich text format) file. After you import 
an RTF file, you can still modify the text in the editing pane. Avid 3D does not 
store a reference to the RTF file on disk; modifying the original RTF with a 
word processor does not affect the scene.

n Not all attributes of the rich text format are supported. Any formatting that is 
not supported is ignored.

To import an RTF file:

1. Create a text object as described in “Creating Text” on page 179.

2. In the Text property editor, choose File > Open.

3. Use the browser to find and select an RTF file.

Saving RTF Files

You can save the contents of the editing pane as an RTF file to use in another 
application or import into a different scene.

To save an RTF file:

t Choose one of the following commands from the Text property editor’s 
command bar:

- File > Save. If you have previously saved the contents of the editing 
pane, it is saved again with the same name and the previous version is 
overwritten on disk. Otherwise, a browser opens for you to specify a 
path and file name.

- File > Save As. A browser opens for you to specify a path and file name.

Left Right

Center
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Controlling Size and Spacing of Text

You control the size and spacing of text with the on-screen Text Block parameters.

To control the size and spacing of text:

1. Make sure the text object is selected—note that if you dragged an item 
from the object library, the model that contains the text object is initially 
selected instead.

You can select the text object by simply clicking on any part of the text in 
a viewport, or by using the Text section of the scene explorer.

2. In the Text Block on-screen parameter set, adjust either or both of the 
following parameters:

- Spacing controls the distance between individual characters. A value 
of 0.0 represents the default spacing defined by the font, and larger 
values spread the characters further apart. To space characters closer 
together, either Alt+drag to the left to set negative values or enter 
negative values numerically.

- Size Ratio controls the ratio of points to distance units. Lower values 
mean fewer points per unit (larger text size) and higher values mean 
more points per unit (smaller text size).
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Creating Logos

You can create logos by importing curves saved as EPS (encapsulated 
PostScript) files from a drawing program into Avid 3D. Before you import a 
file, you should prepare it first.

Preparing EPS Files for Import

There are some restrictions on the files you can import. Follow these guidelines:

• Make sure the file contains only curves. Convert text and other elements 
to outlines.

• Save as version 8 or previous.

• Do not include a TIFF preview header.

• Make sure that any curves that define exterior contours or interior holes 
are closed.

• Make sure that there are no completely overlapping curves. Overlapping 
curves may cause Avid 3D to fill in curves that are meant to be holes, or 
not fill in curves that are meant to be outer contours.

• Avoid intersecting curves. Intersecting curves create partially overlapping 
polygons, which may produce undesirable shading.

Importing Curves

There are several ways to import .eps files into Avid 3D:

t Choose File > Import EPS File, and then use the Import EPS dialog box 
to find and select a file to import.

t Drag a file from Windows Explorer or a folder window and drop it into 
the background of a viewport in Avid 3D.
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t Drag a thumbnail from the Logos section of the model library and drop it 
into the background of a viewport in Avid 3D.

When you import a curve in any of these ways, a 3D geometric object is 
created by extruding the curve. The geometric object is named polymsh by 
default, but you can rename it as described in “Element Names” on page 110.

Extruding and Beveling Text and Logos

You can control the extrusion and the beveling for both text and logos using 
the on-screen parameter sets: Text Block for text or EPS Extrusion for 
imported curves.

To display the Text Block or EPS Extrusion on-screen parameters:

t Make sure the text or logo object is selected—note that if you dragged an 
item from the object library, the model that contains the text or logo object 
is initially selected instead.

You can select the text or logo object by simply clicking on any part of it 
in a viewport, or by using the Text section of the scene explorer.

n These parameters, in addition to others, are also available in the Curve to 
Mesh Converter property editor. See “Advanced Text and Logo Controls” on 
page 192.

Extruding

You can control the extrusion depth and the number of subdivisions using the 
on-screen parameters:

• Depth controls the length of the extrusion in distance units. For flat, 
planar shapes, set this parameter to 0.0.
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• Subdivisions controls the number of times that the object is subdivided by 
extra points and edges along its depth. Higher values require more 
memory and longer processing times. 

In many cases, you can leave this parameter at the default value of 0. 
However, you should increase this value in certain situations. For example 
if you intend to deform the object along its depth, then you should 
increase the subdivisions so that the object deforms more smoothly. In 
addition, if you extrude the object by an extremely long depth, then you 
should subdivide the object to avoid shading problems that can occur with 
very long and thin polygons.

Beveling

You can apply a bevel using the preset buttons on the Text Tools tab of the 
Tools and Options panel, and then adjust it using the on-screen parameters.

To apply a bevel:

1. Select a text or logo object.

2. On the Text Tools tab of the Tools and Options panel, click the button for 
one of the preset Bevel styles (top two rows). 

The object is beveled with the selected profile and the default depth 
and height.

n If you dragged text from the object library instead of using the Text Tools tab, 
it might be using a custom curve for the bevel profile. You can edit the curve in 
the profile editor to change the shape of the bevel. See “Working with 
Profiles” on page 162. 

Subdivisions = 2

Depth

Side view of 
extruded text 
or logo
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3. If desired, toggle the front or back bevels on or off (bottom row). 

4. In the on-screen parameters, adjust the size of the bevel as desired:

- Bevel Depth controls how much the bevel protrudes from the 
base mesh. 

The bevel profile is automatically scaled so that the width of its 
bounding box equals this value. 

- Bevel Scale is a factor that modifies the profile curve in the direction 
orthogonal to the Depth, squashing or stretching the profile. 

If your curves have small, thin features and sharp, closely-spaced 
corners, then don’t set this value too high.

n To remove a bevel, set Bevel Depth to 0.0.

Bevel style

Toggle front/back

Side view of a beveled corner

Bevel Scale is a factor 
applied to the profile.

Bevel profile
starts here.

Bevel profile ends here.

Profile curve is scaled 
to fit the Bevel Depth.
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Applying Materials and Textures to Text and Logos

Text and logos contain five predefined clusters corresponding to the Front, 
FrontBevel, Extrusion (sides), BackBevel, and Back, in addition to the entire 
object. These clusters let you easily apply different materials and textures to 
the various sections of an object. For information about applying materials and 
textures to clusters, see “Textures and Materials” on page 233.

Note that these clusters are always present, even if the object has no depth or is 
not beveled. For example, applying a material to FrontBevel and BackBevel 
has no apparent effect when Bevel Depth is 0.0 because those clusters are 
empty. However, increasing the bevel depth will reveal the material on the 
beveled sections.

In addition to applying a material and texture to a specific cluster, you can 
apply a preset combination of materials and textures to all these clusters at 
once. Simply drag a preset from the Text section of the Material and Fx 
Library onto your text or logo. The presets in this section have different 
materials and textures applied to the predefined clusters. Note that some of 
these presets can only be seen when rendered.

As an alternative to the predefined clusters, you can create clusters for each 
character or island as described in “Creating Clusters” on page 193. This can 
be useful if you want different characters or sections of your logo to have 
different materials and textures.
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Advanced Text and Logo Controls

In addition to the options that are available in the on-screen parameters and on 
the Text Tools tab of the Tools and Options panel, there are several advanced 
options available in the Curve to Mesh Converter property editor. Although 
you might not need these options in every case, they can be very valuable in 
some situations. 

To display the Curve to Mesh Converter property editor:

1. Make sure the text or logo object is selected—note that if you dragged an 
item from the Object Library, the model that contains the object is initially 
selected instead.

You can select the text or logo object by simply clicking on any part of it 
in a viewport, or by using the Text section of the scene explorer.

2. Open the multi-purpose editor.

3. On the Geometry and Deform Properties tab, select the Curve to Mesh 
Converter property. 

The Curve to Mesh Converter property editor appears in the right pane of 
the multi-purpose editor.
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Controlling the Steps

The Step options control how many edges are created for every span in the 
underlying text or EPS curves. You can control the values for the exterior 
Contours and the interior Holes separately. Higher values produce smoother, 
more accurate curves but require more memory and longer processing times.

Offsetting Curves

Use the Offset slider to offset the input curves. Positive values enlarge the 
curves and negative values shrink them. Values are in distance units. 

Creating Clusters

You can automatically create clusters to help with texturing different sections 
of the text or logo object.

Creating Clusters per Island/Character

You can automatically create polygon clusters based on separate characters 
when converting text, or based on the disconnected islands created by separate 
outer contour curves when converting curves. This makes it easier, for example, 
to apply a separate material or texture to each character or section of a logo.

In the case of text, each cluster is given a name corresponding to its position 
and its character, for example, Char_1_A, Char_2_B, and so on. In the case of 
logos, the clusters are named Face_1, Face2, and so on.

If you change the resulting polygon mesh structure by modifying text or 
adding curves after creating island/character clusters, the clusters are not 
updated automatically. If the resulting number of polygon islands is different, 
then you must re-create the clusters again.

Steps = 3 produces smooth but 
dense geometry

Steps = 1 produces light but 
blocky geometry
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To create clusters per island/character:

t Click Per Island/Character under Create Polygon Clusters on the 
Geometry tab of the Curve to Mesh Converter property editor.

Creating Clusters Along the Depth

By default, Avid 3D creates clusters corresponding to the Front, FrontBevel, 
Extrusion, BackBevel, and Back whenever you create text or import curves. 
However, you can also create these clusters manually, for example, if you 
loaded a scene or model that contains extruded text or EPS curves but doesn’t 
have these clusters predefined. 

To create clusters along the depth:

t Click Per Section Along Depth under Create Polygon Clusters on the 
Geometry tab of the Curve to Mesh Converter property editor.

Exploding the Mesh

You can explode a text or logo object into a hierarchy of separate polygon 
mesh objects. There is one new object for each “island” of polygons (or for 
each character, if using text) and all objects are parented under a common null. 
This is useful, for example, if you want to animate each character or section of 
a logo flying into place separately. 

In the case of text, the objects are named after their position and characters for 
example, Char_1_A, Char_2_B, and so on. In the case of logos, the objects are 
named Face_1, Face2, and so on. For information about manipulating objects 
in hierarchies, see “Selection and Hierarchies” on page 113 and 
“Transformations and Hierarchies” on page 118. 

A modeling relation exists between the unexploded mesh and the extracted 
objects, so modifying the options on the Curve to Mesh Converter property 
editor affects the extracted objects as well. You cannot delete the original text 
or logo object without deleting the exploded hierarchy, but you can hide the 
original as described in “Hiding and Unhiding Objects” on page 74 if you do 
not want it to be visible. 

If you change the number of polygon islands in the original, for example, by 
modifying the text after exploding, you should re-explode the mesh.
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To explode text or logos:

t Choose Explode Mesh into Separate Parts on the Geometry tab of the 
Curve to Mesh Converter property editor.

Each island of polygons (or character) is automatically extracted and 
parented under a new null object. The null object is selected in branch mode.

Tessellating

Tesselation is the process of tiling the curves’ shapes with polygons. In the 
Tessellation Method box on the Geometry tab of the Curve to Mesh Converter 
property editor, there are three different tesselation methods: 

• Delaunay generates a mesh composed entirely of triangular polygons. 
This method gives consistent and predictable results, and is useful when 
objects are to be deformed.

• Minimum Polygon Count uses the least number of polygons possible. 
This is the default method. It keeps the geometry light but it gives poor 
results if the object is deformed. 

• Medial Axis creates concentric contour lines along the medial axes 
(averages between the input boundary curves), interpolating from one 
boundary shape to the next. This method creates mainly quadrilateral 
polygons (that is, quads) with some triangles. It can be useful when 
objects are to be deformed. 

Minimum Polygon Count

The Minimum Polygon Count tesselation method uses the least number of 
polygons possible. For a single contour curve with no holes, this results in 
exactly one polygon. When holes are present, there are multiple polygons and 
their shapes are not predictable. 

In general, Minimum Polygon Count creates irregularly shaped n-sided 
polygons. For this reason, it is best used when you need to keep the geometry 
light on simple objects that will not be deformed. 



Chapter 7 Working with Text and Logos

196

Delaunay

The Delaunay tesselation method generates a mesh composed entirely of 
triangular polygons. This method gives consistent and predictable results, and 
in particular, it does not give different results if the curves are rotated. It is 
useful when objects are to be deformed. 

With this method, there are several options for fine-tuning the tesselation further.

To set the Minimum Angle of polygons:

t Turn Minimum Angle on and then adjust the slider.

If a triangle contains an angle that is smaller than this value, it gets 
replaced by better-shaped ones. Eliminating small-angled triangles gives a 
more uniform OpenGL shading and is more suited for deformations.

Zero holes yield 
one polygon.

One hole yields 
two polygons.

Two holes yield 
three polygons.

Minimum Polygon Count yields irregular polygons.

Delaunay yields triangles.

Minimum Angle = 20
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To set the Maximum Area of polygons:

t Turn Maximum Area on and then adjust the slider.

If a triangle is larger than this value, it gets replaced by smaller ones. 
This allows the polygon mesh to be deformed more smoothly.

Medial Axis

The Medial Axis tesselation method creates concentric contour lines along the 
medial axes (averages between the input boundary curves), morphing from 
one boundary shape to the next. This method creates mainly quads with some 
triangles, so it is well-suited for subdivision surfaces.

Controlling the Extrusion

The Extrusion box on the Extrude/Bevel tab of the Curve to Mesh Converter 
property editor contains several parameters for controlling the extrusion:

• Length is the same as Depth in the on-screen parameters. See 
“Extruding” on page 188.

• Subdivisions is the same as in the on-screen parameters.

• Direction controls the direction of the extrusion (Forward or Backward) 
with respect to the front side of the polygons when the extrusion depth is 0.0. 

Maximum Area = 10

Medial axis runs between 
opposite boundaries.

Medial Axis yields quads and triangles.
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Controlling the Beveling

The Bevel box on the Extrude/Bevel tab of the Curve to Mesh Converter 
property editor contains several parameters for controlling the beveling.

Controlling the Size and Direction of the Bevel

Several options in the Bevel box on the Extrude/Bevel tab of the Curve to 
Mesh Converter property editor control the size and direction of the bevel: 

• Depth is the same as Bevel Depth in the on-screen parameters. See 
“Beveling” on page 189.

• Height Scaling is the same as Bevel Scaling in the on-screen parameters. 

• Proportionally Smaller for Holes in the Options box further scales the 
bevel profile applied to holes. This is useful to avoid overlapping 
geometry when holes are small compared to the bevel size. 

• Interior controls the direction of the bevel. 

- When this option is on, the front and back are beveled outward. As a 
result, the silhouette matches the original curves but polygons may 
intersect or interpenetrate in narrow areas when the bevel depth is high.

- When this option is off, the sides of the tube are beveled outward. In 
some cases, this may distort the object’s outline or cause separate islands 
of polygons (such as characters in text) to collide with each other. 

• The options in the Sides box allow you to bevel the Front or Back 
individually. These are equivalent to the buttons on the Text Tools tab of 
the Tools and Options panel. 

Mitering and Rounding

Mitering creates sharp corners, like at the corners of a picture frame.

• Create Hard Edges turns mitering on and off. It creates hard edges at 
sharp corners, as well as around the contour of the bevel. 

• Discontinuity Angle sets the threshold for mitering sharp corners. Adjacent 
polygons whose dihedral angle is greater than this value are mitered. 
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Mitering can sometimes produce ugly results with extremely sharp angles. In 
these situations, you can round the corners instead. 

• Use the Convex and Concave sliders in the Corner Mitering box to define 
the minimum threshold for mitering convex and concave angles in 
degrees. Angles that are sharper than these values are rounded. A value 
of 0 is equivalent to turning rounding off. 

• Use Roundness Subdivisions to control the smoothness of the rounding. 
Higher values produce smoother arcs with denser geometry. A value of 0 
creates a flattened effect like a sawn-off corner. 

Controlling the Bevel Profile

The options in the Profile Curve box control the style and the accuracy of the 
bevel profile:

• Curve is the name of the profile style. To change the profile, click the 
Browse button (...) and choose a different preset. 

• Sampling Step is the number of subdivisions per segment of the profile 
curve. Higher values produce heavier, denser geometry that follows the 
curve more smoothly and accurately. 

Sharp corners
are mitered.

Flat corners are 
not mitered.

Mitering can produce a 
poor effect on extremely 
sharp corners. 

Convex controls 
which convexities 
are rounded. 

Concave controls 
which concavities 
are rounded. 

Flatter angles are 
not rounded.

Roundness 
Subdivisions 
controls the 
smoothness of the 
rounding. 
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Creating a Text Rig

A text rig allows you to easily create “follow-the-leader” style animation. 

To create a text rig:

1. Create a text object, and modify it as you wish (edit, format, bevel, etc.).

Make sure that you are completely satisfied with it before continuing, 
because the next step freezes the text into separate geometric objects and 
you will no longer be able to modify the text or its properties.

2. Make sure the text is still selected, and click Create Text Rig on the Text 
Tools tab of the Tools and Options panel.

The text is replaced by separate objects for each character, all set up to 
play follow-the-leader. These objects can be found in the Geometry 
section of the scene explorer, not the Text section.

Alternatively, you can click the wizard button under Text - Character 
Anim. Offset Rig in the Text section of the object library. If you do this 
when no text is selected, or if you drag the preset into the scene instead of 
using the button, you are prompted to create, edit, and format a new text 
object before proceeding. 

3. If desired, select the second or later character and modify its offset. The 
FrameOffset controls the delay by which the character follows the 
previous one, and the other parameters affect the difference in translation, 
rotation, and scaling in each axis. Modifying one character’s 
transformation offset affects all subsequent characters. 

Wizard 
button
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4. Select the first character and key its initial transformation values. 

5. Change the frame and change the first character’s transformation.

6. Set a key on the corresponding transformation parameters. As soon as you 
do this, the subsequent characters begin to follow.

7. Continue transforming the first character and keying its values. Make sure 
you leave enough frames after the last keyframe for the rest of the 
characters to catch up. 

8. Once you have finished, play back your animation.
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Chapter 8
Lights and Cameras

Lights and cameras work together with the objects in your scene to provide 
you with your final images. Just like in real life, you can’t record what’s in a 
scene without a camera—and your camera can’t see anything without lights to 
illuminate the scene.
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Lights and Shadows

Without lights, it doesn’t really matter what your scene looks like—you won’t 
be able to see it, plain and simple!

Each light in a scene contributes to the scene’s illumination and affects the 
way all objects’ surfaces appear in the rendered image. You can dramatically 
change the nature and mood of your images by modifying lights and their 
properties. You can add lights directly or you can work with lights from 
imported scenes.

Properties

Every light in a scene is defined by a set of properties. Most of these properties 
are common to all types of light. These properties are referred to as the light’s 
rendering properties, as they determine its appearance when rendered.

You can also create different kinds of shadows through the light properties. 
For more information about shadows, see “Creating Shadows” on page 214.

Types of Lights

There’s a light for every occasion, and you can create and position several 
different kinds:
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Scene Ambience

Scene ambience simulates a certain amount of indirect light, coming from no 
particular source, that is applied to all objects in the scene. It is a simple 
approximation of the indirect lighting that normally bounces around an 
environment and illuminates objects to a certain extent. 

Directional

Also referred to as infinite lights, 
directional lights simulate light 
sources that are infinitely far from 
objects in the scene. They have no 
position associated with them, only a 
direction. All objects are lit by 
parallel light rays.

Point

Point lights casts rays in all 
directions from the position of the 
light. They are similar to light bulbs, 
whose light rays emanate from the 
bulb in all directions.

Spot

Spotlights cast rays in a cone-shape, 
simulating real spotlights. This is 
useful for lighting a specific object 
or area. The manipulators can be 
used to edit the light cone’s length, 
width, and falloff points.
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The effect of ambience on the scene is to brighten or darken all objects to a 
certain degree. The scene’s ambient color is multiplied with an object’s 
ambient color to produce the object’s final ambient component. If the scene 
ambience is set to black, nothing can alter the ambient color of an object 
except, of course, a light.

n The scene ambience is not controlled by a light, but is a property applied to the 
entire scene. It does, however, affect the final look of directly illuminated 
objects to a certain extent.

For best results, ambience should be set to 0 (or close to it) in scenes with 
environment maps. These maps create indirect lighting, but much more 
realistically, so ambience is unnecessary. For more information about 
environment maps, see “Environment Maps” on page 259.

For more information on an object’s ambient color, see “Surface Color” on 
page 239.

To edit a scene’s ambient color:

1. Open the multi-purpose editor. Click the Material and Fx Properties tab, 
then select the Ambient node.

2. Edit the scene’s ambient value as desired using the color sliders. Keep this 
value dark or low so as not to affect your scene’s lighting in an 
unpredictable way.

Setting a Realistic Ambient Color

Perhaps the most realistic way to set a scene’s ambient color is to match a 
color from an image from the scene you use for compositing.

To set a realistic ambient color:

1. Do one of the following:

t Display the image in a library, if it is available.

t Place the image in a scene by dragging it into a viewport and creating 
a floating image clip. Set the display type to Textured Decal.

2. In the multi-purpose editor, click the Material and Fx Properties tab, then 
select the Ambient node.

3. In the Ambient Lighting property editor, click the color box to open the 
color editor.
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4. From the color editor, select the color picker; the cursor changes to an 
eye-dropper.

5. Use the color picker to select the ambient color from the image to be used 
for compositing. For best results, choose an ambient color you find in the 
shadows of an image.

6. Close the color editor to accept the chosen color as the new ambient 
lighting color.

n There are some color range limitations to safely output for TV or film. 
For example, true blacks and full reds aren’t supported by NTSC and some 
other formats.

Creating Lights

Each of the light types available from the library panel creates a new light. 
Each type of light simulates a different real-world light source.

The Default Light Rig

When you create a new scene in Avid 3D, a default light rig is created at the 
same time. The light rig contains three spotlights:

• A key light, which is the main source of light from the rig.

• A back light, which highlights the edges of your objects.

• A fill light, which illuminates the shadows created by the key light.

You can edit the lights’ properties and positions by clicking the rig’s control 
handle to display its on-screen parameters.

You can also delete the rig by selecting any of the rig’s elements and pressing 
Delete. You can add the light rig to a scene at any time by dragging the light 
rig object from the lights library on the library panel into a viewport.
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Adding Lights

You can add several types of lights to your scene. Once you have added a light, 
you can set its properties.

To create a new light:

1. Choose Lights from the object library to display the camera effect thumbnails.

2. Drag a thumbnail onto an empty area in a viewport. The light object is 
created in the scene.

A new light is added to the scene and positioned at the origin. For a 
description of the different types of lights, see “Types of Lights” on page 204.

To open the light’s property editor, select the light and open the multi-
purpose editor.

You can select and manipulate lights as you would any other object. For more 
information on how to set a light’s properties, see “Setting Light Properties” 
on page 209.

For a complete description of all the light properties, refer to Online Help.

Manipulating Lights

You can translate, rotate, and scale lights as you would any other object. 
However, scaling a light only affects the size of the icon and does not change 
any of the light properties.

Manipulating Spotlights

Spotlights have a third set of manipulators that let you control their start and 
end falloff, as well as their spread and cone angles.

To display the spotlight manipulators, do one of the following:

t Click the Spot Light Cone Tool button in the Transform Tools panel of 
the tools and options panel.

t Press the B key then press Tab until the manipulators are displayed.

For more information about manipulating spotlights, see “Setting a Spotlight” 
on page 213.
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Setting Light Properties

Every light is defined by a light shader, which describes the light’s color, 
falloff, and other settings. All light sources have a light shader (by default, the 
built-in soft_light shader).

You can edit a light shader’s properties in the light’s property editor. The 
properties you can define depend on the particular shader: they include the 
light color, attenuations, and spotlight directions.

You can also animate a light’s properties so that the values change over time. 
For example, you can make a light gradually change color or grow dim. For 
more information on how to do this, see “Keyframe Animation” on page 277.

Setting a Light’s Color

The color of a light controls the color of the rays emitted by the light. The final 
result depends on both the color of the light and the color of objects.

For example, a red object reflects red light, but absorbs blue and green light. 
On the other hand, a yellow object reflects both red and green light, but 
absorbs blue light. If you illuminate a yellow object with a blue light, it 
appears dark. Objects illuminated by white light appear in their natural colors.

n When you define the color of an object’s material, you should work with a 
white light because colored light sources affect the material’s appearance. You 
can color your light source afterward to achieve the final look of the scene.

To set a light’s color, do one of the following:

t To set the color of a single light, drag a light color from the Material and 
Fx library onto the light.

t To set the color of every light in the scene, drag a light color from the 
Material and Fx library onto the background of a viewport.

To edit a light’s color:

1. Select a light and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, select the light’s shader node.

2. In the light shader’s property editor, set a color for the light.
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The current color is shown in the box to the left of the color sliders and 
under the light shader’s name. You can set the color using the color sliders 
or by opening the Color editor. You can also toggle between the RGB, 
HSV, and HLS color channels.

3. Do one of the following:

t Drag the color sliders to change the strength of each red, green, and 
blue channel independently, or type a numerical value directly in the 
space provided. 

The slider values range between 0 and 1, but you can enter higher 
values yourself. Hold the Ctrl key to move all sliders at once.

t Click the color box to the left of the sliders to open the Color editor. 
For information on using the color editor, see “Defining Color 
Properties” on page 92.

Setting the Light’s Intensity

The intensity of a light is controlled indirectly through the strength of its 
separate color channels. If you want to adjust the strength of a light without 
changing its color, you can use the HSV or HLS color models and adjust 
V (value) or L (lightness).

Click on the RGB button beneath the color box of a light’s property editor. To 
set values higher than 1 for a stronger light, type directly in the box to the left 
of the slider.

Click the color box to open the 
color editor. Click the RGB button 
to define the light color using the 
RGBA, HSV, or HLS color models.

The intensity slider defines how 
bright or strong the light is.
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Setting a Light’s Falloff

Falloff refers to the diminishing of a light’s intensity over distance, also called 
attenuation. This mimics the way light behaves naturally. These options are 
available only with point lights and spotlights.

You can set the distance at which the light begins to diminish, as well as the 
distance at which the falloff is complete (darkness). This means you can set 
the values so the falloff affects only those features you want. In addition, you 
can control how quickly or slowly the light diminishes.

You can set the falloff value using the light’s property editor or its 
3D manipulators.

To set the falloff from a property editor:

1. Select a light and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, select the light’s shader node.

2. In the light shader’s property editor, select the Light Falloff option.

3. Set the required Start Falloff and End Falloff distance values in the 
Attenuation controls.

4. Under Mode in the Light Attenuation section, choose a type of falloff:

- Linear falloff is sharper and less realistic. When selected, the 
Exponent parameter is automatically set to 1.

Falloff
Start and End Falloff values. Using a point light, umbra = 0; bottom 
corner of chess board is 0; top, left corner is 10.

Start falloff = 0
End falloff = 4

Start falloff = 0
End falloff = 8

Start falloff = 6
End falloff = 8
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- Use Light Exponent falloff is an inverse square falloff, which is 
more natural and realistic. 

This option uses the value in the Exponent field to determine the 
falloff. The default value is 2. A high value such as 5 causes light to 
fall off very quickly, whereas a smaller value such as 0.1 makes the 
falloff more gradual. 

To set the falloff using 3D manipulators:

1. Select the spotlight or point light for which you want to set the falloff.

2. Press B to display the light’s 3D manipulators.

3. Press Tab until the light’s start and end falloff manipulators appear.

4. The exterior cone-angle control displays a light blue start falloff disc (if 
falloff is already activated, you see this before displaying the 3D 
manipulators).

5. Ctrl+click the disc at the base of the white cone angle cone to activate 
the falloff.

6. Click and drag this disk toward or away from the light to set the Start value.

7. The exterior Cone Spread control also displays a magenta end falloff disk 
at its base. Click and drag this disk toward or away from the light to set the 
End value.

8. Shift+click and drag either disk to increase or decrease both Start and End 
Falloff values simultaneously. The distance between the planes of each 
disk remains the same.

9. To deactivate falloff, Ctrl+click either the start or end falloff disk.

The lower circle represents
the End Falloff point.

The top circle represents the
Start Falloff point.
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Setting a Spotlight

Spotlights are actually simple rigs made up of two separate parts: the spotlight 
itself and its interest, a null that the spotlight always points toward. A spotlight 
casts its rays in a cone aimed at its interest. Spotlights have special options that 
control the size and shape of the cone. You can set these options using the 
property editors for the spotlight’s shader and the spotlight itself, or the 
spotlight’s 3D manipulators.

To set the cone and spread angles from a property editor:

1. Select a spotlight and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, select the light’s shader node.

2. In the light shader’s property editor, set the Spread. This is the angle in 
degrees of the inner, solid cone of full-intensity light.

3. Click the Light node, then set the Cone Angle. This is the angle in degrees 
of the exterior cone light. The cone defines the maximum spread of light.

The yellow line indicates 
the light’s spread angle.

The white line indicates 
the cone angle.

The inner, solid cone 
corresponds to the 
spotlight’s Spread Angle.

The white wireframe 
outline corresponds to the 
spotlight’s Cone Angle.
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To set the cone and spread angles using 3D manipulators:

1. Select a spotlight.

2. Press B to display the light’s manipulators.

3. Press Tab until the spotlight’s cone and spread-angle manipulators appear.

4. The exterior wireframe cone controls the light’s cone angle. Click the 
edge of the cone and drag outward or inward to interactively increase or 
decrease the Cone Angle value, respectively.

5. The interior yellow shaded cone controls the light’s spread angle. Click 
the edge of the cone and drag outward or inward to interactively set the 
Cone Spread value.

6. Shift+click and drag the edge of either cone to increase or decrease both 
angles simultaneously. The distance between the angles of each cone 
remains the same.

Viewing from the Spotlight 

The Spot Light view in a 3D view lets you select from a list of spotlights 
available in the scene. A spotlight view is useful to see what objects a spotlight 
is lighting and from what angle.

Selecting a spotlight from the view menu switches the point of view in the 
active viewport relative to the chosen spotlight. The point of view is set 
according to the direction of the light cone defined for the chosen spotlight. 
Changing the view from the 3D view directly affects the spotlight’s position or 
cone angle.

For more information about other viewpoints, see “Viewing Your Work in 3D 
Space” on page 59.

Creating Shadows

If you want your scene to have a more realistic look, you can create shadows 
that appear to be cast by the objects in your scene. Shadows can make all the 
difference in a scene: a lack of them can create a sterile environment, whereas 
the right amount can make the same scene delightfully moody. 

Shadows are controlled independently for each light source. This means that a 
scene can have some lights casting shadows and others not.
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To create shadows:

1. Select a light and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, select the light shader’s node.

2. In the light shader’s property editor, select Shadows Enabled.

3. Set the Umbra value with its slider.

This defines a transparency factor on the umbra (main) area of the shadow 
(default 0.75). It controls how the shadow blends with the material on 
which it is cast to create a more realistic shadow.

The more lights used to generate shadows, the longer the scene takes to render.

Creating a Volumic Light

Ask anyone who directs mystery TV shows, and they’ll tell you that you can 
get a lot of mileage out of a spotlight and a fog machine. You can give your 
spotlights—and by extension your scene—a feeling of space and texture by 
making them volumic. Volumic lights are a great way to add a feeling of 
realism, drama, or fantasy to a scene.

To create a volumic light:

1. Select the spotlight that you want to make volumic.

2. From the Materials and Fx library, choose Light > Volumic, then do one 
of the following:

t Drag a volumic effect onto an empty area in a viewport. The volumic 
effect is applied to all visible spotlights in the scene.

t Drag a volumic effect onto a spotlight. The effect is applied to that 
spotlight only.

To modify a volumic light’s property:

1. Select a spotlight that has a volumic effect. Open the multi-purpose editor, 
then click the Material and Fx Properties tab. Click the Volumic node.

2. Do any of the following:

t Adjust the Reflectance parameter to simulate the volume’s reflectivity. 
A low value (0.5) simulates a volumic effect with low reflectivity, such 
as dust. A higher value (greater than 2) creates a reflective volume, such 
as dense smoke.
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t You can set the distance from the light source at which the volumic 
effect begins by using the Min Distance slider.

t Set the volumic light’s Shard parameters. They are disabled by 
default, but you can activate shards, and set their intensity, 
complexity, and resolution.

Refer to the Online Help for details on the different volumic light parameters.

Creating a Lens Flare

Lens flares occur when a light (usually point) source hits the camera’s lens at a 
small enough angle to show lens “aberrations.” You can add several different 
types of lens flares to your scene.

To create a lens flare:

1. Select the light with which you want to create a flare.

2. From the Materials and Fx library, choose Light > Flares, then do one of 
the following:

t Drag a flare onto an empty area in a viewport. The flare effect is 
applied to all visible lights in the scene.

t Drag a flare onto a light. The flare effect is applied to that light only.

To modify a lens flare’s property:

1. Select a light that has a lens flare. Open the multi-purpose editor, then 
click the Material and Fx Properties tab. Click the Flare node.

2. Do any of the following:

t On the Flare tab, edit the flare’s size, brightness, and aspect ratio.
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t On the Glow tab, define its glow properties.

t On the Star tab, define its star rays and their properties. You can edit 
the number of rays, their length (red arrow), and width (blue arrows).

Refer to the Online Help for details on the different lens flare parameters.

All three images above use the same flare type. The left image is a default 
flare.The middle one uses increased Size and Brightness values.

Notice how the flare’s colors become more saturated. The image on the right 
“squashes” the effect by editing its Aspect Ratio value.

The image on the left is the default glow of a flare (no stars). The middle one 
shows a glow with a higher brightness value and larger size (glow radius). 
The image on the right shows the same glow but with almost no falloff.

The image on the left shows a default lens flare with the Star property on. 
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Creating a Glow Effect

You can quickly create a glow effect to any object or group of objects directly 
from the material and fx library. The glow can be applied to any object in a 
scene and deactivated or rendered with the click of a mouse.

n Glows are post-process; that is, they are added to the scene only after 
rendering is completed.

To create a glow:

1. Select the object to which you want to apply a glow effect.

2. Create a render region in a viewport (press Q).

3. From the Materials and Fx library, choose Objects > Glow, then drag a 
glow onto an object. The glow effect is applied to the object.

To modify a glow’s property:

t Select an object with a glow. Open the multi-purpose editor, then click the 
Material and Fx Properties tab. Click the Glow node.

You can determine the color of the glow by adjusting the RGB sliders. 
You can also set the size and texture noise of the effect from the Size and 
Noise tabs.
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For more information on glow properties, refer to Online Help.

Cameras

The best way to make an audience see what you want them to see is to get the 
camera to do the work. The camera in Avid 3D is similar to a physical camera 
in the real world. It defines the view that you can render.

Most scenes in Avid 3D have only one camera. However, some rigs may have 
a fixed camera (from which the scene is rendered) and a second, freely 
movable camera (to allow you to see the scene from different angles). For 
information on the types of camera rigs available in Avid 3D, see “Camera 
Rigs” on page 106.

You can increase the size of the glow (above right) as well as 
alter its noise-level amplitude (below).

Default glow

0.1 Amplitude 0.5 Amplitude 0.9 Amplitude
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Cameras versus Viewpoints

Cameras are different from viewpoints. A viewpoint allows you to see a scene 
in a viewport in a specific way. You can choose from four default viewpoints 
in a viewport: User, Front, Top, and Right. You can also choose a camera view 
in a viewport to see what the camera sees. For more information about 
selecting views, see “Viewport Views” on page 66.

In many ways, cameras and viewpoints are similar, except that viewpoints are 
not actual objects: they are only tools for viewing your scene. You cannot 
animate a viewpoint, nor can you render from a viewpoint as you can from 
a camera.

How Cameras Are Set Up

Cameras are actually simple rigs made up of two separate parts: the camera 
itself and the camera interest, a null that the camera always points toward. 
Each of these elements is viewable in the viewports.

The Camera

The camera is the camera is the camera. In the viewports, it is represented by a 
wireframe control object of a camera which is, for rendering purposes, 
invisible, but it allows you to manipulate the camera in 3D space. The camera 
has a directional constraint to the camera interest.

The Camera Interest

The camera’s interest—what the camera is always looking at—is represented 
by a null in the scene. You can translate and animate the null, as you would 
any other object, to change the camera’s interest.

Camera Interest

Camera
Camera Direction Arrows
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Camera Direction

The camera icon displays a blue and a green arrow. The blue arrow shows 
where the camera is “looking”; that is, the direction the lens is facing. The 
green arrow shows the camera’s up direction. You can change a camera’s up 
direction by modifying its Roll parameter.

To change a camera’s roll:

1. Select the camera in the scene explorer or in a viewport, then open the 
multi-purpose editor.

2. Open the camera’s Direction Cns property editor.

3. Make sure the Roll property is set to Active.

4. Set the Roll parameter.

You can also click the Camera Roll button in the control bar or press the 
L key to interactively change the roll on a viewport’s camera.

For more information on how to animate a camera roll, see “Animating 
Cameras” on page 227.

The Active Camera

Some procedures in Avid 3D refer to the active camera. The active camera is 
the camera whose view is displayed in viewport B. If viewport B is not set to a 
camera view, then the active camera is the the one named Camera.

Making Cameras Visible

The default camera in Avid 3D is a perspective camera. When you first create 
a scene, the entire default camera and its interest are hidden. 

To make the default camera visible:

t In the scene explorer, set the scope to Cameras, select the Camera node, 
and press H to display the camera. You can display the camera’s interest 
the same way. If you want to display the entire rig, tree-select either node 
and press H.
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Working with Cameras

You’ll probably want to move your camera around a bit to capture just the 
right angles. You may also need to switch back and forth between different 
cameras, if possible, to compare points of view.

Selecting Cameras and Camera Interests

Cameras or their interests can be tricky to select. Luckily, there are several 
ways to select either or both.

To select a camera or camera interest:

t Do one of the following:

t Locate the camera or interest in a 3D view and click it to select.

t From the Animation Tools panel, click the Select Active Camera or 
Select Active Camera Interest button. This selects the camera used 
in viewport B.

t From the scene explorer, choose Cameras. This changes the scope of 
the scene explorer so that it only shows the cameras and camera 
interests in your scene. Select a camera or interest from the list.

n To select the entire camera rig, tree-select the camera or its interest.

Selecting Camera Views

Camera views let you display your scene in a viewport from the point of view 
of a particular camera. If you have more than one camera in your scene, you 
can display a different camera view in each viewport. 

Choosing a camera from a viewport’s views menu switches the viewpoint to 
that of a “real” camera in your scene. Every camera in your scene is available 
from any viewport views menu. All other views such as User, Top, Front, and 
Right are orthogonal viewpoints and are not associated to an actual camera.
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Camera Safe Areas

To ensure that you are framing your scene without potentially cutting off 
important scene elements, you can display a camera’s safe area.

To toggle display of the camera’s safe area in a viewport:

t In the Display Options panel, click the Show/Hide Safe Area button.

Positioning Cameras

Once you select a camera, you can translate, rotate, and scale it as you would 
any other object. However, scaling a camera only affects the size of the icon 
and does not change any of the camera properties.

Generally, the most intuitive way of positioning cameras is to set a viewport to 
a camera view and then use the viewport navigation tools to change the 
camera’s position. As you navigate in the viewport, the camera is subject to 
any and all transformations that are necessary to keep its interest in the center 
of its focal view. 

Below is a list of available navigation tools. For more information about 
navigating in 3D views, see “Navigating in Viewports” on page 71.

Aside from the user-created 
cameras, you can select a 
predefined orthographic view.

Choose a camera from the list to 
switch the viewport to that camera’s 
view.

Navigation Tool Description

Pan & Zoom Zooms into and out of the scene or pans in all viewports.

Orbit Rotates the camera around its point of interest.

Dolly Moves the camera towards or away from its interest.



Chapter 8 Lights and Cameras

224

n When you position the camera from a camera view, using the Frame (F) and 
Frame All (A) commands change the camera’s position.

Undoing/Redoing Camera Moves

Since positioning cameras is often a process of trial and error, you’ll probably 
find yourself wanting to undo and redo camera moves. Camera moves are 
stored separately from other actions; therefore, the standard undo and redo 
functions (Ctrl+Z and Ctrl+Y) have no effect on camera moves.

• Press Alt+Z to undo the last camera move.

• Press Alt+Y to redo the last undone camera move.

Resetting Camera Position

If you’ve zoomed in and out too much and the perspective on your camera is in 
need of a reset or refresh, press R. This resets the camera in the viewport in 
which the cursor is.

Setting Camera Properties

The Camera Property Editor

The Camera property editor contains every parameter needed to define how a 
camera “sees” your scene.

To open the camera property editor:

t Select a camera whose properties you want to edit and open the multi-
purpose editor. In the Geometry and Deform Properties tab, click the 
second Camera node.

Roll Rolls the camera about its Z axis. 

Note: You cannot keyframe camera roll from a 3D view. 
Instead, you have to do it from the camera’s constraints property 
editor. For more information about keying camera roll, see 
“Animating a Camera Roll” on page 228.

Navigation Tool Description
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Setting the Field of View

The field of view is the angular measurement of how much the camera can see 
at any one time. By changing the field of view, you can distort the perspective 
to give a narrow, peephole effect or a wide, fish-eye effect.

n Field of View settings have no effect on orthographic cameras. Instead, you 
can adjust the Ortho Height parameter to include more or less of the scene in 
the camera’s view.

To set the field of view:

1. Select a camera and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, click the second Camera node.

2. In the Field of View section, select whether you want to specify the 
Vertical or Horizontal field of view. Avid 3D calculates the other 
dimension using the aspect ratio.

3. Set Angle to the desired value in degrees.
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Selecting a Projection Method

You can easily change any camera from an orthographic to a perspective projection.

To select a projection:

1. Select a camera and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, click the second Camera node.

2. In the property editor, you can select one of two projection methods:

- Orthographic: all camera rays are parallel and objects do not change 
size as they change distance from the camera. 

This projection is useful for images requiring a “pseudo-3D” look.

Using the same camera in the same location, the Vertical field of view is 
much smaller, thus making only a small part of the building visible. 

The camera’s Vertical field of view was made large enough to accommodate 
the entire building. The Horizontal field of view was automatically calculated 
based on the aspect ratio. 
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n Field of View settings have no effect on orthographic cameras. Instead, you 
can adjust the Ortho Height parameter to include more or less of the scene in 
the camera’s view.

- (Default) Perspective: the projection simulates depth. This 
projection is useful for simulating a physical camera.

Animating Cameras

You can animate a camera’s interest to make the camera follow a path or 
object. You can also animate the camera itself to create a camera roll.

Animating the Camera Interest

Animating a camera’s interest is the easiest way to keep any action in the 
scene in frame. The two most basic ways to do this are to set the interest on a 
path or to constrain it to an object in the scene.

To animate the interest with a path:

1. Create a curve by dragging a curve object from the Object Library into a 
viewport.

2. Edit the curve as desired—see “Modifying Points and Polygons” on page 170.

3. Select the camera’s interest or click the Select Active Camera Interest 
button in the Animation Tools panel.

4. Click the Set Object on Motion Path button in the Animation Tools panel.

5. Pick the curve to use as the path. Keys are created at each end of the path 
(corresponding to the first and last frames on the timeline range), and the 
interest’s intermediate position along the path is interpolated.

For more information on how to create and edit path animation, see “Path 
Constraints” on page 323.
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To animate the interest with a constraint:

1. Select the camera’s interest or click the Select Active Camera Interest 
button in the Animation Tools panel.

2. From the Animation Tools panel, click the Position Constraint button 
then click on the object to which you would like the camera interest to 
remained constrained.

For more information on how to define position constraints, see “Position 
Constraints” on page 320.

Animating a Camera Roll

Although you can use the L key to roll a camera, you cannot mark it for 
animation as you would the scaling, rotation, or translation controls. Instead, 
you must open the camera constraint’s property editor and mark the Roll 
parameter from there.

To animate a camera roll:

1. Select a camera and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, click the Direction Cns node.

2. Use the Roll parameter to control how much you want the camera to roll. 
A negative value makes the camera roll to the left and a positive value 
makes the camera roll to the right.

3. You can adjust the Roll slider and key the parameter by clicking the 
parameter’s animation icon (little green box).

n If you wish to further edit the roll of your camera, you can edit the Roll 
parameter’s function curve. To do this, click the Function Curve Editor tab on 
the multi-purpose editor to open the animation editor and navigate the 

The parameter’s animation icon indicates how the 
parameter has been marked or keyed: 

Red indicates the parameter value is keyed at the 
current frame.

Green indicates that the parameter is keyed but the 
current frame is not a keyframe.

Yellow indicates that the parameter’s value has been 
changed but not yet keyed.
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animation tree to select the roll’s function curve. For more information on 
working in the animation editor, see “Working in the Function Curve Editor” 
on page 286.

4. To remove all animation from the Roll parameter, right-click the 
animation icon and choose Remove Animation.

Camera Effects

In real life, there are many different kinds of cameras and lenses. In 
photography you can change the lens on a camera to get a certain kind of 
shot—and the same holds true in Avid 3D, where you can change your 
camera’s rendering properties by applying camera effects.

Depth of Field

To add a sense of realism to a scene, you can add some depth of field, which is 
an effect that simulates a plane of maximum sharpness and blurs objects in 
front of, close to, or beyond this plane.

High Depth of Field
With a far depth of field setting, 
only objects farther from the 
camera are in focus.

Low Depth of Field
With a near depth of field, only objects 
close to the camera are in focus.
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Fisheye

The fisheye effect simulates a fisheye lens on a camera. That is, it presents a 
wide-angle image with by distorting it. The farther away from the center of the 
camera’s viewing plane, the more distorted the image.

Z-Depth

The z-depth effect renders a greyscale image, with the shades of gray varying 
according to the surface's distance from the camera. The brightness increases 
from black to white as the distance is increased.

Applying a Camera Effect

Camera effects can be applied to any selectable camera in the scene. Effects 
cannot be applied to the predefined camera views (User, Top, Front, Right).

Applying an effect to a camera will delete any existing camera effect.

To apply an effect to a camera:

1. Choose Scene > Camera from the Material and Fx Library to display the 
camera effect thumbnails.

2. Do one of the following:

t Drag a thumbnail onto an empty area in a viewport. The camera effect 
is applied to the camera that is currently active in viewport B.

t Drag a thumbnail onto a camera in any viewport, or onto a camera 
node in an explorer.

n Applying the None effect clears any existing effect from the camera.
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Editing a Camera Effect

All camera effects have parameters that can be modified to give you exactly 
the look you want for your scene. You can find a camera’s effect parameters on 
its property page.

To edit a camera effect:

t Select a camera and open the multi-purpose editor. In the Geometry and 
Deform Properties tab, click the second Camera node.

Refer to the Online Help for details on the different camera effect parameters.
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Chapter 9
Textures and Materials

While an object’s geometry determines its shape, its surface appearance 
determines how it looks, and can even suggest how it feels. This is where 
textures and materials come in.

An object’s appearance is a combination of its material (its color, transparency, 
reflectiveness and other attributes) and its texture (its applied surface 
appearance). These properties work together to make your objects seem as real 
or as unreal as you like.
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Previewing with the Render Region

Finessing textures and materials can sometimes be a process of trial and error, 
and you’ll probably want to keep track of your progress. While the viewports’ 
Textured display is helpful, it isn’t as detailed as a render—but doing a full 
render with every change you make can become a repetitive and time-
consuming task.

You can view a rendering of any part of your scene quickly and easily using a 
render region. Rather than repeatedly setting up and launching a preview 
render, you can simply draw a render region over any viewport and see how 
your scene will appear in the final render as you make changes.

Because the render region uses the same renderer as the final render, you can 
set the region to render your previews at final output quality. This gives you a 
very accurate preview of what your final rendered scene will look like.

You can resize and move a render region, select objects and elements within 
the region, as well as modify its properties to optimize your preview. Whatever 
is displayed inside that region is continuously updated as you make changes to 
the rendering properties of the objects. Only this area is refreshed when 
changing object, camera, and light properties, when adjusting rendering 
options, or when applying textures.

When the render region is refreshed, a series of tiles starts filling in the region 
with the rendered image. Each time you change properties that affect the 
appearance of objects in your scene, the region is automatically refreshed. You 
do not have to wait for the region to finish refreshing to make more changes to 
your scene—a change simply interrupts the current refresh and restarts it to 
include the updates you have just made.

Creating a Render Region

You can draw a rectangular region of any size around the objects you want 
rendered interactively within any of the four viewports. You can draw only one 
render region at a time in any viewport. A region can render any view 
displayed in a viewport: User, Top, Front, Right, spotlights, and camera views.
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To create a render region:

1. Click the Render Region tool in the rendering and preview controls or 
press Q to activate the render region mode.

The mouse pointer shows a square with a sphere in it to indicate that you 
are in region mode. You can now define a region in any viewport.

n To delete the current render region, press Q to activate the render region tool 
and click in any viewport.

2. Drag the mouse pointer diagonally across the viewport to create the render 
region. The region is drawn as a box with a yellow border and blue 
resizing handles.

3. As soon as you release the mouse button, the region is drawn and 
whatever is displayed in that region is rendered.

The render appears as a series of tiles that fill up the region. Each tile is 
outlined with an angled bracket at each corner, signifying which tiles are 
being updated at each refresh. When you make a change that affects the 
visual appearance of the scene, only the part of the scene shown in the 
render region is rendered.

If you wish to start over, simply draw a new region anywhere you like.

4. Deactivate the render region mode by either pressing Q again or Esc.

Moving and Resizing a Render Region

You can resize and reposition the region in the viewport by dragging its 
border. The mouse pointer changes to indicate the type of action you can 
perform with the region. The placement and size of the render region are 
limited by the layout and size of the viewports themselves.

To move a region:

1. Position the pointer on the border of the render region’s bounding box. 
The pointer changes to a four-way directional arrow.

2. Click and drag the pointer in any direction to reposition the region. Once 
positioned, release the mouse button and the region is refreshed.
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To resize a region:

1. Position the pointer over one of the blue squares on the corners or borders 
of the render region. The pointer changes to a directional arrow.

2. Click and drag the pointer to resize the region. Release the mouse button 
and the region is refreshed.

Hiding the Render Region

Planning to make several consecutive changes to your scene and you don’t want 
render region refreshes to launch one after another? Try hiding the region:

To hide the render region:

t Press Shift+Q to hide the render region. Pressing Shift+Q again redisplays 
the region identical to how it was defined prior to hiding.

Closing the Render Region

Once a render region has been defined, and the render region tool is still 
active, click anywhere on the screen to close the region. You do not have to 
wait until the region has finished rendering.

Dragging a new render region over an existing one closes the original region 
and renders the new one.

n Deactivate the render region mode by either pressing Q or Esc.

Setting Render Region Options

The render region renders the scene in the same way as a final output render. 
As such, the rendering options you set for the render region give you a very 
accurate preview of what your final rendered scene will look like.

These rendering options are a subset of the global rendering options, but they 
affect only the render region and are not used for the final render.

Previewing the changes you make to your scene in a render region is an 
interactive process. To speed up the “tune-preview-retune” cycle, use the 
region’s rendering options to optimize the display.
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To change the render region display mode:

t In the tools and options panel, click the Options tab, then click the Render 
Region Options tab.

You can change the Display Mode setting to display the alpha channel, 
z-depth, and other options.

To set the accuracy of the region:

You can quickly set the rendering accuracy (sampling level) with the slider on 
the right side of the region border:

1. Position the pointer over the blue rectangle on the right side of the region 
border. The Max Sample slider appears.

2. Drag the slider down to decrease the maximum sample level and increase 
the render speed in the region.

Tracking Objects with the Render Region

Rather than always adjusting your render region’s size and location while you 
are working in a scene, you can set the render region to track an object, 
hierarchy, group of objects, or even a part of an object (cluster).

To set the render region to track an object:

1. Select an object in any viewport. 

2. In the tools and options panel, click the Options tab, then click the Render 
Region Options tab and select Track Selection.

3. If necessary, open a render region in the viewport in which you wish to 
track the selection.

As the object moves, the render region follows it. If the object changes size, 
the render region is recalculated to fit around it.
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Materials

In the real world, an object’s appearance is determined by two things: what it’s 
made of and its color. These determine how light reacts when it strikes the 
object’s surface, which, in turn, determines how we see it. For example:

• A ball might absorb all the colors of the spectrum except red, which 
bounces back to our eyes; therefore, we perceive the ball as being red.

• Some light is absorbed by clear glass, some is bounced back, but most 
passes through it; therefore, we perceive glass as being transparent and 
slightly reflective.

• Mirrors absorb some light, but most is bounced back; therefore, we 
perceive very little of the mirror’s own color and more of the surrounding 
area’s reflected light.

In Avid 3D, you can define an object’s color, its transparency (how much light 
passes through it), and its reflectivity (how much light bounces back). By 
adjusting these settings you can make an object appear to be made of almost 
anything: glass, metal, plastic, and more. Appropriately, this combination of 
parameters is referred to as an object’s material.

Applying Materials

The material and fx library includes a wide selection of colors and materials 
that you can apply to your objects. They are divided into two categories:

• Colors applies color to an object, with no transparency or reflectiveness.

• Surfaces, Glass, and Base Materials apply colors, transparency, and 
reflectiveness to simulate substances like metal, plastic, porcelain, and glass.

To apply a material to an object:

t Drag a material from the Material and Fx Library in the library panel onto 
the object.

If the object has clusters defined, a dialog box appears in order to provide 
you with the option of applying the material to selected clusters. For more 
information on applying materials to clusters, see “Applying Materials 
and Textures to Polygons” on page 248.

Once you have applied a material, you can edit its attributes to get exactly the 
look you want.
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Surface Color

You can create a very specific color for an object by defining its specular, 
diffuse, and ambient colors separately in the object’s material property editor.

• The diffuse color is the color that the light scatters equally in all 
directions so that the surface appears to have the same brightness from all 
viewing angles. It usually contributes the most to an object’s overall 
appearance and it can be considered the “main” color of the surface.

• The specular color is the color of shiny highlights on the surface. It is 
usually set to white or to a brighter shade of the diffuse color. The size of 
the highlight depends on the defined Specular Decay value.

• The ambient color appears on areas that are shielded from light but are 
still visible due to an ambient light, which is a non-directional light that 
pervades the entire scene. 

n For more realistic results, you may want to make the Ambient color identical 
to the Diffuse color and let the scene’s Ambient Lighting color control the 
ambient value.

To edit an object’s surface color properties:

1. Select the object.

2. In the multi-purpose editor, click the Material and Fx Properties tab. 
Select the object’s material node, or a cluster’s material node.

Specular

Ambient

Diffuse
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Transparency

The material’s Transparency parameters control an object’s transparency. The 
more transparent an object is, the more you can see through it.

This icon represents an 
object’s material node.

This icon represents a 
cluster’s material node.

If the object’s material was originally dragged 
from the library, its name appears as the property 
editor title; otherwise, the default title is “Phong.”

Textures override 
surface color 
properties. If a 
texture were 
applied to this 
object, these 
icons would be 
red and the color 
sliders would be 
unavailable.

75% transparency 70% transparency with 30% reflection
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As an object becomes more transparent, its other surface parameters, such as 
those related to diffuse, ambient, and specular areas of illumination, become 
less visible. If an object’s material is fully transparent, its other material 
attributes are not visible at all. You can compensate for this by increasing the 
attributes’ values, such as changing specular color values that were 1 on an 
opaque object to 10 or higher on a transparent object.

Setting Transparency Values

You adjust transparency by modifying the Transparency options in the 
material’s property editor. Transparency values usually range from 0 to 1, with 
a value of 0 representing no transparency and 1 making the object completely 
transparent. For a transparent surface such as glass, a value of 0.9 is more 
convincing than a value of 1.

To set a material’s transparency value:

1. Select the object.

2. In the multi-purpose editor, click the Material and Fx Properties tab. 
Select the object’s material node, or a cluster’s material node.

3. Use the Transparency property’s color sliders to set the transparency value.

n Although you can only drag a color parameter’s slider to a maximum value of 
1, you can increase the values by typing higher numbers in the parameter’s 
text box.

Enables transparency

Defines how much of each color channel 
will pass through the surface. The average 
of the R, G, and B values (equivalent to the 
Luminance and Value values in the HLS 
and HSV color models) defines the 
transparency value.

Determines the smoothness of the 
surface. A Frost value of 0 is glossy; the 
higher the value the more diffuse, or 
"frosted," the effect.

Determines the number of times the light ray 
is sampled during rendering. A high value is 
smoother but takes longer to render.

Textures applied with transparency active 
override transparency color properties. If a 
such a texture were applied to this object, 
this icon would be red and the color sliders 
would be unavailable.



Chapter 9 Textures and Materials

242

Refraction

When transparency is incorporated into an object’s surface definition, you can 
also define the refraction value. Refraction is the bending of light rays as they 
pass from one transparent medium to another, such as from air to glass or water.

n The use of refraction increases the scene’s render time.

You can set the refraction by modifying the Transparency options in the 
material’s property editor. The default refraction value is 1, which represents the 
density of air. This value allows light rays to pass straight through a transparent 
surface without bending. Higher values make the light rays bend, while values 
less than 1 makes light rays bend in the opposite direction, simulating light 
passing from air into an even less dense material (such as a vacuum).

Refractive index values usually vary between 0 and 2, but you can type in 
higher values as needed.

To set a material’s refractive index value:

1. Select the object.

2. In the multi-purpose editor, click the Material and Fx Properties tab. 
Select the object’s material node, or a cluster’s material node.

3. Ensure that Transparency Enable is active.

4. Enter the Index of Refraction value.

n You can enter the actual physical refraction values for real matter and the 
behavior of light passing through it will be simulated.

Refraction value of 0.9 Refraction value of 1.1
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The following table lists some common transparent materials and their 
refractive value:

Reflectivity

As you may suspect, a material’s Reflection parameters control an object’s 
reflectivity. The more reflective an object is, the more other objects in the 
scene appear as reflections on the object’s surface.

Material Refractive Value

Air 1.00

Ice 1.31

Water 1.33

Acetone 1.36

Alcohol 1.39

Glass 1.50–1.89

Polystyrene 1.55

Emerald 1.57

Topaz 1.61

Ruby/Sapphire 1.77

Crystal 2.00

Diamond 2.42

No reflectivity in ball’s material 35% reflectivity



Chapter 9 Textures and Materials

244

As an object becomes more reflective, its other surface parameters, such as 
those related to diffuse, ambient, and specular areas of illumination, become 
less visible. If an object’s material is fully reflective, its other material 
attributes are not visible at all.

n As you increase an object’s reflectivity, you can keep its other surface 
attributes visible by drastically raising their values. For example, a specular 
highlight that was set to 1 on a non-reflective object could be set to 1000 on a 
highly reflective object.

Setting Reflection Values

You adjust reflectivity by modifying the Reflection options in the material’s 
property editor. Reflection values usually range from 0 to 1, with 0 
representing no reflectivity and 1 representing complete reflectivity, giving the 
object a perfectly mirrored surface.

To set a material’s reflectivity value:

1. Select the object.

2. In the multi-purpose editor, click the Material and Fx Properties tab. 
Select the object’s material node, or a cluster’s material node.

3. Use the Reflection property’s color sliders to set the reflectivity value.

n Although you can only drag a color parameter’s slider to a maximum value of 
1, you can increase the values by typing higher numbers in the parameter’s 
text box.

Enables reflection

Defines how much of each color channel is 
absorbed by the surface. The average of 
the R, G, and B values (equivalent to the 
Luminance and Value values in the HLS 
and HSV color models) defines the 
reflectivity value.

Determines the smoothness of the 
surface. A Gloss value of 0 is glossy; the 
higher the value the more diffuse, or 
"frosted," the effect.

Determines the number of times the light ray 
is sampled during rendering. A high value is 
smoother but takes longer to render.
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Textures

Textures apply an image or “feel” to an object’s surface. Textures fall into two 
categories: 2D (images and videos) and 3D (procedural). Both kinds of 
textures have a myriad of uses. You can:

• Apply textures to an entire object.

• Use video files to create animated textures.

• Use textures to simulate reflections and complex geometry as well as 
control object transparency.

• Animate all texture properties.

2D Textures

2D textures are images that can be wrapped around an object’s surface, much 
like a piece of paper that’s wrapped around an object. To use a 2D texture, you 
start with any type of picture file (JPEG, GIF, TIFF, PSD, etc.) or video file 
(AVI, QuickTime, or AAF). Picture and video files must contain data that 
describe all the pixels in an image, RGB, or RGBA data. Preinstalled 2D 
textures can be found in the still images and video libraries in the library panel.

n When using TIFF files as 2D textures, make sure to save them without LZW 
compression. LZW-compressed TIFFs are not supported by the renderer and 
will not render correctly.

2D textures are “wrapped around” objects.
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3D Textures

3D textures are solid “procedural” textures. Procedural means that they are 
mathematically calculated at points in 3D space—not wrapped around a 
surface like 2D textures. In other words, unlike 2D textures, 3D textures are 
projected “into” objects rather than onto them. 

This means they can be used to represent substances having internal structure, 
like the rings and knots of wood or the veins in rocks or marble. Preinstalled 
3D textures can be found in the material and fx library in the library panel.

Applying Textures

To apply a texture to an object:

t Drag a texture from the Material and Fx, Still Images, or Video library on 
the library panel onto the object.

If the texture has an alpha channel defined, a dialog box appears in order 
to provide you with the option of using the alpha channel as a 
transparency map or a bump map. For more information on using textures 
as maps, see “Using Textures as Maps” on page 254.

If the object has clusters defined, a dialog box appears in order to provide 
you with the option of applying the texture to selected clusters. For more 
information on applying textures to clusters, see “Applying Materials and 
Textures to Polygons” on page 248.

n You can quickly create a textured grid by dragging a still image or video clip 
from the library panel into a viewport. When the dialog box appears, select 
Floating Image Plate. An appropriately sized grid is created and the image or 
video is applied as a texture.

3D textures are applied throughout an object.
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Viewing Textures

You can view an object’s 2D textures in the multi-purpose editor.

To view 2D textures:

1. Select an object.

2. In the multi-purpose editor, select the Texture Clip Viewer tab.

The explorer on the left lists all of the 2D textures applied to the object. 
Click a texture’s node to see it in the right pane.

Repeating and Tiling a Texture

Most textures can be repeated to create a wallpaper-like pattern by tiling the 
texture repeatedly. When a picture is repeated, its edges should be absolutely 
symmetrical; if not, you’ll see seams.

A texture’s Repeats parameters are available from its property editor, in the 
Material and Fx Properties tab of the multi-purpose editor. You can define the 
number of texture repetitions in X, Y, and Z. For example, a value of 2 in X 
and Y shrinks the texture so it fits onto the object four times. You can also use 
the Alternate U and Alternate V parameters to control how the repeated 
textures are oriented.

Alternate U Options

Alternate V Options
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If you have a Texture display type active in the viewport, you can see the results 
of any changes immediately. You can also view the results in the render region.

If you are working with a 3D texture, you can also define its tiling in the Z axis.

Removing Textures

To remove a texture:

t Drag a color item from the Materials and Fx library in the library panel 
onto the object or cluster.

n Deleting a texture does not remove the texture support from the object.

Applying Materials and Textures to Polygons

You can assign a material or texture locally to selections of polygons and/or 
polygon clusters on a polygon mesh object. If you choose the latter, a cluster is 
created from the selection. The cluster’s local material always overrides the 
one assigned to the entire object.

Polygon mesh object 
with global material 
assigned.

Object with specific 
polygons selected.

Local material 
assigned to 
selected polygons.
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In the multi-purpose editor’s explorer, a cluster’s material or texture appears 
under its own node when the object is selected.

To assign a texture or a material to polygons or polygon clusters:

1. Select one or more polygons or polygon clusters.

2. Drag a material or texture from the library panel to the selected polygons 
or clusters.

Managing Cluster Overlap

Although assigning materials to polygon clusters is a simple task, it can get 
tricky when clusters overlap. Fortunately, Avid 3D has a mechanism for 
dealing with materials on overlapping polygon clusters. When you assign a 
material to a cluster or polygon selection that overlaps another cluster, the 
dialog box shown below appears.

The object’s material
is here.

The clusters’ textures
are here.

The clusters’
materials are here.
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Each option results in a different outcome. For example, if you start with the 
grid shown below and apply a surface shader to the selected cluster:

• Choosing Yes removes the area of overlap from the selected cluster.

• Choosing No removes the area of overlap from the existing cluster.

The grid shown 
left has two 
clusters. The 
unselected 
cluster has a local 
material (red) applied to it, 
while the selected cluster 
does not.

When you apply a 
local material to 
the selected 
cluster, specifying 
that the overlap 
be removed from the selected 
cluster produces the results 
shown here. Polygons where the 
clusters overlap are removed from the 
selected cluster.

When you apply a 
local material to 
the selected 
cluster, specifying 
that the overlap be 
removed from the existing 
cluster produces the results 
shown here. Polygons where the 
clusters overlap are removed from the 
existing cluster.
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• Choosing Cancel allows the clusters to overlap.

Changing the Display Order for Overlapping Clusters

Each cluster that you create is assigned a sort order value. When clusters with 
local materials overlap, this value controls the order in which they’re drawn. 
The lower a cluster’s sort order value, the earlier it’s drawn. Thus the cluster 
with the highest sort order value is always drawn on top of any other 
overlapping clusters.

n When you open scenes created using a version of SOFTIMAGE|XSI where sort 
order was not assigned to clusters, all of the clusters in the scene are assigned 
a sort order value based on the order in which they were loaded from the file.

Since each newly created cluster is automatically given the highest sort order 
value in the scene, the last cluster created is drawn on top by default. However, 
you can change any cluster’s sort order value to control where it is drawn 
relative to the clusters that it overlaps and those that overlap it.

When you apply a 
local material to 
the selected 
cluster, specifying 
that the overlap 
be allowed produces the 
results shown here. The last 
material applied (blue in this case) 
is displayed.
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To change a cluster’s sort order value:

1. Select the cluster and click its node in the Geometry and Deform 
Properties tab in the multi-purpose editor.

2. Change the cluster’s Sort Order value.

The cluster is now drawn below those with a higher sort order value and 
above those with a lower sort order value.

n If you assign the same sort order value to multiple clusters, they are drawn 
according to their internal order within the scene file. To avoid any confusion 
about which cluster’s material will be displayed, it’s best that each one has a 
unique sort order value.

When you change the green cluster’s 
sort order value to 99, it is drawn below 
both the red and blue 
clusters. However, the 
blue cluster is still drawn 
on top of the red one 
because it has a higher 
sort order value.

The grid shown here has three 
overlapping polygon clusters, each with 
its own material. Each 
one of the clusters also 
has a unique sort order 
value:

100 for the red cluster
102 for the blue cluster
104 for the green cluster
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Texture Projections and Supports

Whenever you apply a texture to an object, a texture support object is also 
created and appears around the object. 

Texture supports let you control the way the texture is projected on the object. 
For example, if you choose a cylindrical object and a cylindrical mapping 
type, the texture support wraps around the cylinder and defines a cylindrical 
shape from which the texture is projected.

To toggle the visibility of texture supports:

t Click the Show/Hide Control Objects and Rig Handles button in the 
Display Options panel.

Scaling, Rotating, and Translating the Texture Support Object

You can interactively transform a texture-support object directly in a viewport 
using the scale, rotate, and translate commands from the keyboard (X, C, and 
V keys) or the Local Transform property editor. The texture is constrained to 
the support so that when you rotate or scale the support, it also affects the 
texture. For example, if you enlarge the texture support, the texture image is 
also enlarged.

You can also animate these transformations with keyframes.

The dark green (white when 
selected) lines represent the 
type of texture projection 

Dragging the red, yellow and 
green manipulators allows you 
to translate or scale the texture 
across the object’s surface in 
the U or V directions.
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Modifying the Texture’s Projection

You can change how the texture is projected onto an object through the texture 
support’s property editor.

To modify the texture’s projection:

1. Select the texture support in a viewport.

2. In the multi-purpose editor, click the Geometry and Deform Properties 
tab, then select the Texture Support node.

Using Textures as Maps

You can use textures to precisely control a variety of your objects’ attributes: 
bumps and ridges, transparency, and environment. Using textures to drive 
these attributes lets you clearly define where they are applied and to what 
degree. The texture acts as a map that the attribute follows.

• Bump Maps simulate relief on objects by perturbing the surface shading 
according to an image map. The result is the illusion of bumps, ridges, and 
imperfections, but with no change to the objects’ geometry.

• Displacement Maps, though similar to bump maps, actually perturb 
objects’ rendered geometry according to an image map. This creates 
bumps, ridges, and other surface variations that cast shadows that 
correctly follow the displacement.

• Transparency Maps make an object’s surface transparent or opaque, 
according to an image map. This is useful for “cutting holes” in otherwise 
solid surfaces without modifying the surfaces’ geometry.

You can change the projection type to 
suit an object that has been 
deformed or otherwise modified, or to 
create a particular texturing effect.

Determines the object’s local plane 
on which the texture will be projected.

Rotates and flips the texture by 
exchanging the U and V directions of 
the texture coordinates.
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• Environment Maps use their source images to surround the scene with a 
simulated environment, which shows up as reflections on the surfaces of 
reflective objects. They can also be used to create backgrounds or light scenes.

Bump Maps

Although real surfaces can be perfectly smooth, you are more likely to 
encounter surfaces with flaws, bumps, and ridges. One of the most basic ways 
to create these types of “bumps” on a surface is to use a bump map.

On an object, bump maps are used as regularly as textures. They are necessary 
when you want your object to look realistic. Although bump maps do not change 
the geometry of an object, they do perturb the direction of reflected light rays. 
This affects the shading, giving the illusion of a pattern being embossed on the 
surface. Bump maps, like texture maps, require a texture projection.

Upper left: The dragonfly’s body is textured with a bug-like texture, but the 
bump mapping is set to 0 (top left), which makes the effect unapparent. 

Lower left: Bump mapping is on and the Bump Factor is set to 20. A positive 
value bumps outward and a negative one bumps inward.

Texture Used

Bump Factor 0

Bump Factor 20
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Selecting a Bump Map Image

When you create or select an image to use as a bump map, remember that 
grayscale or black-and-white images are easier to work with. That’s because 
you can quickly identify how the bump map will appear on the target surface. 
Black areas of the image create ridges, while white areas create indentations.

Creating a Bump Map

To create a bump map:

1. Drag a texture from the Material and Fx, Still Images, or Video library on 
the library panel onto the object.

If the texture has an alpha channel defined, a dialog box appears in order 
to provide you with the option of using the alpha channel as a 
transparency map or a bump map. Select the Bump option then click OK.

Because the texture is a white 
circle, each repeat creates an 
indentation, while the 
surrounding black area is 
raised.

Because the texture is a 
black circle, each repeat 
creates a raised area, 
while the surrounding 
white area is indented.

Bump map texture 
repeated 5 times 
in X and Y.

Wireframe object showing 
light position.

Bump map texture 
repeated 5 times 
in X and Y.
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If the object has clusters defined, a dialog box appears in order to provide 
you with the option of applying the texture to selected clusters. For more 
information on applying textures to clusters, see “Applying Materials and 
Textures to Polygons” on page 248.

2. In the multi-purpose editor, click the Material and Fx Properties tab. 
Click the texture’s node to open its property editor. 

3. Use the Bump Mapping parameters to enable and modify the texture’s 
bump map properties.

Displacement Maps

In addition to bump maps, you can also use displacement maps which, unlike 
bump maps, distort the geometry of an object to create ripples, ridges, or just 
plain bumps during rendering. Unlike regular bump mapping that “fakes” the 
look of real texture, the edges are visibly raised and can cast shadows that 
follow the displacement effect. Displacement affects the geometry of the 
object during the rendering process.

Enables bump mapping.

Enables using the image’s alpha 
channel for the bump map. 
Otherwise, the image itself is used 
for the bump map.

The degree of the bumps. A 
negative value embosses the bump 
into the object’s surface.

Controls the smoothness of the bumps in U, V, 
and depth. The higher the number, the 
smoother the bumps.

Bump mapDisplacement map
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Transparency Maps

You can use a picture to define areas of transparency on your object. The alpha 
channel or RGB intensity of the picture file is used and a factor is applied to 
map a pattern of varying degrees of transparency on the object’s material.

To apply a texture with transparency:

1. Apply a texture to a cluster or object, as described in “Applying Textures” 
on page 246.

2. Adjust the transparency settings as described in “Setting Transparency 
Values” on page 241.

The illustration above shows the 
wing as it was modeled. Once the 
wing texture is applied as a 
transparency map, you can see 
through the wing (right) although it 
doesn’t actually have hundreds of 
tiny holes to see through.

Texture used

Wing model
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Environment Maps

Environment maps are used mainly to create an environment that completely 
encompasses a scene. Environment maps are unique because they don’t have 
to be applied to an object, but they still simulate a geometric object’s 
characteristics. In a certain sense, they are textures that encompass an entire 
scene’s background, rather than any single object. Furthermore, the 
environment map is reflected on object’s surfaces and adds to the scene’s 
ambient color and light.

To create a background with an environment map:

1. From the Material and Fx library on the library panel, choose Scene > 
Environment. Drag an item from the library onto the background in a viewport.

2. In the multi-purpose editor, click the Material and Fx Properties tab, 
then click the Environment node.

3. From the Environment Mode list, choose a mode for mapping the image:

- Spherical maps the image spherically around the scene.

- Cylindrical maps the image cylindrically around the scene.

- Cubic Strip takes an image in which the faces of a cube are laid out 
horizontally, side by side, and maps it in a cubic shape around the scene.

- Cube Cross takes an image in which a cube has been unfolded to 
look like a cross and maps it in a cubic shape around the scene.

- Cube Cross Sideways is a cubic cross, but rotated 90 degrees.

4. Adjust the Background parameter to control the degree to which the 
image appears as the scene’s background.

5. Adjust the Transformation settings, if necessary, to transform the 
environment map image.
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Using Environment Maps to Light a Scene

Like the environments in the object library, environment maps surrounds the 
scene with an image. However, environment maps have a set of parameters 
that allow you to control the image’s contribution to the scene’s lighting and 
reflections, meaning that you can light your scenes with environment maps. 
This makes them ideally suited for green screens, blue screens, and image-
based lighting effects. However, this added functionality comes at a cost of 
increased render times.

To light a scene using an environment map:

1. Apply an environment map to the scene as described in “Environment 
Maps” on page 259.

2. In the multi-purpose editor, click the Material and Fx Properties tab, 
then click the Environment node.

3. Adjust the Reflection parameter to control the intensity of the reflected 
environment map. Higher values create brighter reflections.

4. Adjust the Image parameter to control the intensity of the image’s 
contribution to the scene’s lighting.



Chapter 10
Animating in Avid 3D

Animation makes scene elements move or change over time. In Avid 3D, 
everything can be animated, from text moving and rotating across the screen to 
its color changing from red to blue, and much more.
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What Can You Animate?

You’ve figured out what you need for your scene and put all the elements in 
place. Now it’s time to animate!

But what can you animate?

The answer to that question is “everything.” Animating in Avid 3D means 
changing the value of a parameter over time—and since almost every aspect of 
an Avid 3D scene is described by parameters, the possibilities are limitless. 
The only thing you can’t animate are global rendering options.

You can identify animatable parameters in property editors by the animation 
button to the left of the parameter name (see “The Animation Button” on 
page 266).

Animatable parameters fall into four categories:

• Motion: This is probably the most common form of animation you’ll do. 
This involves displacing an object from one point to another (known as 
translation), or rotating it.

• Geometry: You can animate an object’s structure by changing values 
such as U and V subdivision, radius, length, or scale. You can also use 
animated deformations to bend, twist, and contort your object.

• Appearance: Material (including color), textures, and transparency are 
just some of the parameters controlling appearance that can be changed 
over time.

• Behavior: Constraints and paths are used to control an object’s animation. 
These use parameters whose values can be changed over time; for 
instance, changing an offset value can vary how closely an object follows 
a path over time.

Animation Basics

Setting the Scene’s Frame Format and Rate

In animation, the smallest unit of time is the amount required to display a 
single frame. The speed at which frames are displayed, or the frame rate, is 
always determined by how the final animation will be viewed.
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For example, in North America, television plays at 30 fps (frames per second) 
with the NTSC format, while in most of Europe it plays at 25 fps with the PAL 
format. Film, on the other hand, plays at 24 fps. Most traditional animation is 
shot “on twos,” which means each individual image is held for two frames. So, 
practically speaking, television animation shot for NTSC on twos runs at 15 
fps, though the video itself plays at 30 fps.

n If you are compositing your animation with other video footage, it’s usually 
best for the animation to be at the same frame rate as the footage.

When you change the timing of the animation, you change the way that the 
actions look. This means that the timing that looked correct while you were 
previewing it in Avid 3D may not look as good when it’s output to video. For 
example, an action that spans 25 frames would take one second in PAL; changing 
the frame rate to suit North American video at 30 fps would cause the same 25 
frames to span 0.83 seconds. As a result, you should make sure to preview your 
animation at the same frame rate that will be used in the final format.

Setting the Default Frame Format and Rate

You can set up the default frame format and rate for your scene using the 
options in the Time property editor.

To set the scene’s default format and frame rate:

1. Click the Options button in the tools and options panel, then click the 
Time button in the toolbar to open the Time property editor.

2. Select a Frame Format and Frame Rate.
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c Frame formats are overridden by the Format parameter in the Render 
Options property editor. For more details on setting your scene’s format 
and frame rate, see “Specifying the Format Options” on page 385.

The frame format you select must match the intended final destination of 
your animation. For example, you would use 24 fps for film, 29.97 fps for 
NTSC video, and so on.

The default Frame Format is NTSC at 29.97 frames per second. You can 
also choose PAL, Film, 30fps, or specify a custom frame rate.

If you select Custom as the frame format, you must specify its frame rate. 
For example, if you want a frame rate of 12.5, enter 12.5 in the Frame 
Rate text box.

n The Time Display Format options are used to set the timeline display—see 
“Setting the Timeline Display Format” on page 271.

Displaying the Playback Frame Rate

To toggle the display of the rate at which your animation is being played:

t Click in a viewport while pressing Ctrl+R.

The displayed rate is updated during playback.

The current frame rate changes 
as you play the animation.
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If the playback rate is lower than the scene’s default frame rate, there are steps 
you can take to get a more accurate playback rate. For more information, see 
“Optimizing Playback” on page 275.

Marking Parameters for Animation

Marking parameters is a way of selecting which parameters you want to use 
for a specific animation task. For example, you can mark parameters so that 
only their animation is copied or removed.

Marking parameters is also one of the most common and useful tools for 
setting keys. By marking only the parameters you need, you can keep the 
animation information small and precise. For more information on keying, see 
“Keyframe Animation” on page 277.

You can mark parameters only for selected objects. As well, the same 
parameters remain marked for an object even if the selection changes. For 
example, if you select a sphere and mark its scaling parameters, then select a 
cube, the scaling parameters are also marked on the cube. However, any 
marked parameters that do not apply from one object to the next are ignored.

Marking Parameters

You can mark parameters from any property editor or on-screen parameter display.

n Press Shift+click to mark multiple parameters and Ctrl+click to toggle 
their marking.

To mark parameters in a property editor:

1. Select the element whose parameters you want to mark.

2. Open a property editor with the parameters you want to mark, or expand 
the appropriate on-screen parameter display, if any.

3. Click the parameter name to mark it or Shift+click to mark multiple 
parameters.

Animatable parameters are indicated by an animation button beside their 
names (see page 266). You can also mark non-animatable parameters.

The parameter name is highlighted in yellow, indicating that it has 
been marked.
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Marking Transformation Parameters

By default, when you activate any of the transformation tools (scale, rotate, or 
translate) from the control bar or using their hot keys, all three of their 
corresponding local transformation parameters (for the X, Y, and Z axes) are 
automatically marked. If you only want to set keyframes on one particular 
axis, you must explicitly mark the parameter you want in the Local Transform 
property page.

Clearing (Unmarking) Marked Parameters

To clear all marked parameters:

t In a property editor or on-screen parameter display, right-click a 
parameter’s animation button and choose Unmark All Parameters. 

n If you hold down the supra key while using a transform tool, your existing 
marked parameters will only be temporarily unmarked. After you release the 
supra key, they will be marked again.

The Animation Button

In the animation tree and in almost any property editor, you can see a little 
green button beside any parameter that can be animated. This is called the 
animation button and it lets you do a number of things.

• Click it to set or remove a key for that parameter at the current frame.

• Right-click it to use commands specific to the parameter.

Animation buttons 
indicate animatable 
parameters with various 
animation statuses and 
ways of animation.
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Depending on the status of the parameter’s animation, the appearance of the 
button changes:

• Default green and small: the parameter is animatable, but not currently 
animated.

• Red with a curve: the parameter is keyed at the current frame.

• Green with a curve: the parameter is animated but the current frame is not 
a keyframe.

• Yellow with a curve: the animated parameter’s value has been changed but 
not yet set as a keyframe. If you change the current frame without 
keyframing the parameter’s new value, the parameter reverts to its 
interpolated value.

Expressions are mathematical formulas used to control any parameter that can 
be animated, such as translation, rotation, or scaling. Avid 3D uses 
expressions to perform certain animation functions, such as math presets. You 
cannot modify expressions, nor can you change or keyframe values on 
parameters using expressions.

These buttons indicate expressions of different types:

• With a letter C: the parameter has an expression that keeps the parameter 
at a constant value.

• With an = sign: the parameter has an expression that makes the parameter 
equal to another one (links them).

• With an arrow: the parameter has any type of expression on it other than a 
constant value or an “equal” link.

n You can also use animation buttons on the on-screen parameters—see 
“Modifying and Animating the On-screen Parameter Values” on page 90.
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Ghosting Animation Objects

Animation ghosting, also known as onion-skinning, is a viewing mode that lets 
you display a series of snapshots of animated objects at frames or keyframes 
behind and/or ahead of the current frame. This lets you easily visualize the 
motion of an object, which can help you improve its timing and flow.

Ghosting has its roots in cel animation, where animators use translucent sheets 
of paper containing the previous and next keyframes as a reference while 
drawing. This gives the animator a feel for the motion of the object and serves 
as a guide when editing keyframes.

Ghosting works for any object that moves in 3D space, either by having its 
transformation parameters (scaling, rotation, and translation) animated or by 
having its geometry changed by animated deformations.

Ghost images are updated automatically when you change the object’s 
animation. You cannot select or modify ghosts, and they cannot be rendered. 

Ghosting works in conjunction with any of the display types for the viewports, 
such as Wireframe, Shaded, and Textured. The ghost shapes themselves, 
however, are always drawn in wireframe.

When ghosting is activated, you can see ghost shapes in any viewport set to a 
camera or user view.

To toggle ghosting display on or off:

t Click the Display Options button in the tools and options panel, then 
click the Show Ghost Animation button.
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Copying Animation

You can easily copy and paste animation between individual parameters from 
a property editor or an explorer that displays animatable parameters, such as 
the function curve editor’s animation tree. You can also use the function curve 
editor to copy a whole function curve or just certain keyframes (key points) on 
it (see “Cutting, Copying, and Pasting in the Graph” on page 308).

Using a Property Editor or On-Screen Parameters

Another way in which you can copy animation is at the parameter level using a 
property editor or on-screen parameters. Animation can be duplicated between 
different parameters for the same object or for different objects. For example, 
you could copy the X rotation values from one object to the Y scaling of 
another object.

To copy animation in a property editor:

1. Open a property editor or on-screen parameter display.

2. Right-click the animated parameter’s animation button and choose Copy 
Animation. Then right-click the target parameter’s animation button and 
choose Paste Animation.

Removing Animation

You can remove animation from selected objects or marked parameters using a 
variety of commands from property editors or the Animation Tools panel. You 
can also delete animation using the function curve editor—see “Deleting 
Keys” on page 303.

You can also delete individual keyframes from an object’s animation—see 
“Methods for Setting and Removing Keys” on page 278.

Using the Animation Tools Panel

To remove animation from an object:

1. Select the object or mark the parameters from which you want to 
remove animation.

2. From the Animation Tools panel, do one of the following:
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t Click the Remove Animation on Marked Parameter button to 
remove all keys from the selected object’s marked parameters.

t Click the Remove All Animation on Selected Object button to 
remove all animation from all parameters on selected objects.

Using a Property Editor or On-Screen Parameters

To remove animation from parameters:

1. Display the property editor from which you want to remove animation.

2. Mark the parameters whose keys you want to delete. 

3. In a property editor or on-screen parameter display, right-click the 
animation button of the parameter whose animation you want to remove 
and choose Remove Animation.

Playing Animation

The main way of playing back animation is by moving the playback cursor on 
the timeline or by using the playback controls below the timeline. You can also 
set the timeline’s playback range, play back in real time, and optimize the 
playback in different ways.

Setting the Start and End Frames

Before you play back an animation, you should set the appropriate start and 
end frames. These define the range of frames that you can play in the scene.

To set the start and end frames for the timeline:

t Set the frame numbers in the Start and End Frame boxes at either end of 
the timeline (see below).

Using the Timeline

The timeline is used to display the current playback position of the animation 
and to manually move between different frames. The current frame (or time 
position if you’ve changed the format to milliseconds) is indicated by the 
position of the playback cursor in the timeline and in the current frame box in 
the playback controls (see “Using the Playback Controls” on page 273).
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• Clicking anywhere in the timeline changes the frame. You can also scrub 
(drag) the playback cursor back and forth. The current frame box displays 
the current frame at which the cursor is located.

• Middle-clicking+dragging the playback cursor moves to the selected 
frame but does not update the viewports until you release the button. This 
means you can quickly drag to the required frame while avoiding lengthy 
refresh time.

• Right-clicking+dragging the playback cursor also moves to the selected 
frames but does not update the scene. The cursor and frame number in the 
current frame box turn green. To refresh the scene, click the cursor.

By right-clicking on frames, you can key the same values at multiple 
frames. For more information on this, see “Keying Current Values at a 
Different Frame” on page 279.

Setting the Timeline Display Format

By default, the timeline is set to display frames but you can change this to 
display other options. When you change these settings, they also affect the 
timelines found in the function curve editor.

To set the timeline display:

1. Click the Options button in the tools and options panel, then click the 
Time button in the toolbar to open the Time property editor.

2. Select a Frame Format and Frame Rate.

The playback cursor indicates which frame is currently displayed in the 
viewports. Drag the cursor to a specific frame, or use the left- and 
right-arrow keys to move back or forward through frames one at a time.

Start Frame box: Sets the 
first frame of the timeline.

End Frame box: Sets the 
last frame of the timeline.
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3. Select the Use Custom Display Format option, then select a format from 
the Display Format list.

Setting the Timeline Range for Playback

The timeline range control lets you see and adjust the frame range in which 
you are working relative to the overall scene’s frame range. For example, if 
you are working with an animation sequence that is very long, it’s useful to be 
able to focus on a smaller range of frames for specific tasks.

To set the timeline range:

1. Do one of the following:

t Click the range button at the right end of the timeline.

t Alt+click in the timeline.

The button changes and the range control appears as a gray box with the 
start and end frames displayed (such as 1/100).

2. To change the range, do one of the following:

t Drag on the left or right handles to adjust the playback’s in/out time.

t Drag in the range’s middle to slide the time range in the timeline.

To toggle between the regular timeline and the range:

t Click the range button again or Alt+click in the timeline area.
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Using the Playback Controls

The playback controls at the bottom of the Avid 3D window allow you to view 
and play animation in a variety of ways:

To play forward:

t Click the Play button to play from the first frame on the timeline.

t Middle-click the Play button to play forward from the current frame.

To play backward:

t Click the Play Backward button to play from the last frame on the timeline.

t Middle-click the Play Backward button to play backward from the 
current frame.

To stop the playback:

t Click the Play or Play Backward button again.

t Click any mouse button anywhere in the timeline.

t Press the down-arrow key.

To go to the first/last frame of the timeline:

t Click the First/Last Frame button.

t Press the Home/End key.

Previous/Next Frame 
buttons
Moves the currently 
displayed frame 
forward/backward by 
predefined increments 
(default is 1).

First Frame/Last 
Frame buttons
Resets the 
displayed frame to 
the beginning/end 
of the timeline.

Play Forward/Play Backward buttons
Plays/stops the animation.

Current Frame box
Displays/sets the current frame.

Loop button
Repeats the 
animation in a 
continuous loop.

All/RT button
Toggles between playing back 
frame by frame (All) or in real 
time (RT).

Audio Mute button
Toggles sound on/off during 
playback.
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To move forward/backward one frame:

t Click the Previous/Next Frame button.

t Press the left/right-arrow key.

To repeat the animation in a continuous loop:

t Click the Loop button. When you do this, two yellow bars appear in the 
timeline at the first and last frames to indicate the start and end frames of 
the loop (see below).

Looping the Playback

With looping, you can play back the animation in a continuous loop. This can 
be handy when you want to test out a small area of the animation but don’t 
want to play back all of it.

To activate looping:

t Click the Loop button in the playback controls.

To set the loop playback range:

t Drag the yellow loop markers at either end of the timeline to set the loop 
range, or Ctrl+click in the timeline at the frames where you want them.

By default, the loop in and out frames match the scene’s start and end 
frames. If the loop range matches the scene’s range and you change the 
scene’s start or end frame, the loop range automatically updates to match 
the scene’s new frame range.

Yellow loop markers define 
the range of frames to be 

repeated in a continuous loop 
when you play the animation.
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Playing Back All Frames or Playing in Real Time

Avid 3D can play all frames of an animation or it can play the animation in 
real time. When playing all frames, Avid 3D displays every frame in the 
animation, regardless of how much time it takes to compute and display each 
frame. In some cases, the scene may even play back too quickly!

Avid 3D accomplishes real-time playback by choosing the frames to display 
based on the elapsed time. For instance, if it takes half a second to display the 
first frame in a 30–fps animation, frames 2 through 15 will be skipped and 
frame 16 is displayed next. In other words, when it comes time to display a 
frame, the frame that should be shown at that moment is displayed.

To play back all frames:

t Set the All/RT button to All.

To play back frames in real time:

t Set the All/RT button to RT.

Optimizing Playback

The more you can see of the animation’s essentials, the better the visual feedback 
you have to work with. Ultimately, this helps you produce better animation.

You may not always be able to play back each frame at the correct rate, 
however. At every frame, Avid 3D must check if positions, orientation, 
scaling, geometry, visibility, and many other animatable parameters have 
changed. If they have changed, Avid 3D must then calculate the extent of the 
change, calculate the effects of the change, and then draw the new image. The 
more calculations to be done, the longer it will take to display each frame.

If playback is too slow, you must decide what aspect of the animation is 
critical for display and eliminate the extraneous elements that may be limiting 
the playback speed. For example, if you’re just verifying that your phantom’s 
coloring is shimmering properly, you can display the shifting color but not the 
phantom’s translation. Since there is less to calculate, the scene will play back 
faster—especially if the phantom’s animation was very complex.
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Some factors that slow down playback are inevitable. For instance, the more 
objects in a scene, the slower the playback, but even that can be minimized. 
However, most causes can be easily remedied, such as:

• Other tasks running on your computer.

• The number of active viewports. Muting non-essential viewports speeds 
up playback in the remaining viewports. To do this, middle-click the 
viewport’s letter (A, B, C, or D) so that it turns orange or right-click it and 
choose Mute. You can also hide the viewport’s grid (press G).

• The method of displaying models in the viewports. Using options such as 
textures and shaded models significantly slows playback. For more 
information, see “Display Types” on page 68.

• Select objects you don’t currently need and set them to be not visible, or 
use the display filters to hide certain types of objects. For more 
information, see “Hiding and Unhiding Objects” on page 74.

Playing Back Audio with Your Animation

If you need to synchronize your animation with sound, you can import an 
audio file into Avid 3D. Using the standard timeline and playback controls, 
you can play back the audio on a frame-by-frame basis, if need be—just like 
traditional animators have done for almost a century.

To import an audio file:

1. Set the current frame to the frame where you want the audio to start.

2. Drag a WAV or AIFF file from a browser or Windows explorer window 
onto the background of a viewport or onto the function curve editor graph.

Playing the scene’s animation or scrubbing the timeline will play the 
audio. You can view the audio waveform by opening the function curve 
editor (see “Working in the Function Curve Editor” on page 286).

n Click the All/RT button in the animation controls for real-time playback of 
your audio file.
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Keyframe Animation

Keyframing (or keying) is a process for animating values over time. 
Traditional hand-drawn animation is generally created using keyframes—an 
animator draws the extreme (or critical) poses at the appropriate frames, 
creating “snapshots” of movement at specific moments.

Keyframes are the cornerstone of convincing animation. The drawings 
themselves determine what a figure looks like at specific moments in time, the 
frames chosen for the keyframes determine the timing and weight of a figure, 
and the number of keyframes can reflect the complexity of the movement. The 
frames in between the keyframes are added in afterward. This filling-in 
process is called in-betweening.

As in traditional animation, a keyframe in Avid 3D is also a “snapshot” of one 
or more values at a given frame, but unlike traditional animation, Avid 3D 
handles the in-betweening for you, computing the intermediate values 
between keyframes by interpolation.

When you set keyframes to animate a parameter, a function curve is created. A 
function curve (or fcurve) is a graph that represents the animation of a 
parameter. You can display and edit the resulting function curve in the 
function curve editor (see “Editing Function Curves” on page 285). When you 
edit a function curve, you change the animation.

Keys set at frames 1, 50, and 100. Intermediate frames are interpolated automatically.
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Setting Keys

You can set keys for any animatable parameter in any order and at any time. 
When you add a new key, Avid 3D recalculates the interpolation between the 
previous and next keys. If you set a key for a parameter at a frame that already 
has a key set for that parameter, the new key overwrites the old one.

An important part of the keying process is to mark parameters before keying. 
This lets you choose exactly which parameters you want to key—for more 
information on this, see “Marking Parameters for Animation” on page 265.

Methods for Setting and Removing Keys

There are a number of ways in which you can set keys in Avid 3D, depending 
on what you want to key and where.

To delete keys, go to a frame where there is a key and use any methods 
described in this section.

n After you’ve set your keys, you can always easily add or remove keys on the 
resulting function curve (see “Adding and Deleting Keys” on page 301).

If you want to set keys on fractional frames (between frames), add or move the 
keys on a function curve. You can set them at any frame or value as you like.

To set keys for marked parameters:

t Go to the frame where you want a key, mark the parameters, and do one of 
the following:

t Press the K key.

If you press Shift+K when you’re at a keyframe, it removes all keys 
on marked parameters.

t Click the keyframe button in the animation controls. The keyframe 
button is red when there’s a key at the current frame (see “The 
Keyframe Button’s Color” on page 281).

If you click the keyframe button when you’re at a keyframe, it 
removes keys on all marked parameters.

Keyframe icon
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To set keys for parameters in a property editor or on-screen parameters:

t See “Keying Parameters in Property Editors” on page 280.

To set keys for transformation parameters:

t See “Keying Transformations” on page 283.

To set keys automatically:

t If you are keying a great deal, you can automatically set keys for 
individual parameters as you modify their values—see “Setting Keys 
Automatically” on page 284.

Keying Current Values at a Different Frame

As you’re setting keys, you can right-click the playback cursor on the timeline 
to go to a different frame without updating the scene. This technique can also 
be used if you’ve made the mistake of changing the animated values before 
moving the playback cursor to a new key position.

To key current values at a different frame:

1. With the animatable values set at the current frame, right-click+drag the 
playback cursor to its new position on the timeline. The scene does not 
refresh, so your object’s values do not change.

The playback cursor is green, indicating that it is waiting for the key to be 
set. The key time is also shown in green in the current frame box.

2. Set the key using any method as described in “Methods for Setting and 
Removing Keys” on page 278, such as pressing K.

Once the key is set, the red playback cursor jumps to the same position as 
the green playback cursor and a key is created at this frame. The standard 
frame display is shown in white again.

Key in red
Right-click and drag key to 
copy to new frame (in green).

Key frame number in green.
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Moving between Keys

There are a number of ways in which you can move between keys for all 
parameters of a selected object, marked or not.

• If the selected object has marked parameters, the commands move 
between the keys for only those parameters.

• If nothing is marked, the commands move between keys for all parameters 
of the selected object.

To move between keys of a selected object’s parameters:

1. Select or branch-select an object.

2. Do one of the following:

t Press Ctrl+left arrow or Ctrl+right arrow for previous or next keys, 
respectively.

t Click the Previous Key or Next Key buttons in the animation controls.

To move to the first or last keys of a selected object’s parameters:

1. Select or branch-select an object.

2. Press Ctrl+up arrow or Ctrl+down arrow for first or last keys, respectively.

Keying Parameters in Property Editors

Every property editor lets you set keys for any or all of its animatable 
parameters. An animatable parameter is identified by an animation button (little 
green box) beside it. These methods can also be used with on-screen parameters.

To set a key a parameter in a property editor:

t Click a parameter’s animation button to key only that parameter.
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n When keying a color value, the alpha channel is also keyed, even if no alpha 
channel information is visible in the property page.

Keying Marked Parameters

To key marked parameters on a property page:

1. Move the playback cursor on the timeline to a frame where you want a key 
and open the property editor.

2. Display a property page with parameters you want to animate.

3. Mark the parameters you want to animate (click their names so they turn 
yellow) and set their values.

4. Click the keyframe button in the animation controls, or press K.

This sets keys (or removes a key if there is already one at the current 
frame) for the corresponding parameters on the property page.

Move the playback cursor to another frame where you want a key.

5. Set the values of the marked parameters and click the keyframe button again.

The Keyframe Button’s Color

The keyframe button’s color changes, depending on the status of the property 
page’s marked parameters.

• Gray: no marked parameters have been animated.

• Red: a key is defined for a marked parameter on the current property 
editor page.

Click the animation icon 
to set or remove keys for 
only that parameter.

A marked parameter is 
indicated by its name 
being marked in yellow.
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• Green: a marked parameter is animated but the current frame is not 
a keyframe.

• Yellow: an animated marked parameter on the current property page has 
been modified but is not yet keyed.

n If a property editor’s marked parameters have different animation buttons, the 
keyframe button’s color is based on priority:

• It is red only if there are no yellow animation buttons.

• It is green only if there are no yellow or red animation buttons.

Keying Specific Parameters

To key specific parameters on a property page:

1. Open the property editor and display the property page with the 
parameters you want to animate.

2. Move the playback cursor to a frame where you want a key.

3. Set the value for a parameter you want to animate and click the animation 
button to the left of its name, or right-click it and choose Set Key. Doing 
this sets keys for the parameter whether it is marked or not.

4. Repeat steps 2 and 3 for all the parameters you want to animate in the 
property editor.

n If you want to key parameters in other property pages or property editors at 
the current frame, display them and repeat these steps.

Moving between Keys in a Property Editor

There are several ways to move between keys defined for parameters on the 
currently displayed property page.

• If there are marked parameters on the property page, the commands move 
between the keys for only those parameters.

• If nothing is marked, the commands move between keys for all parameters 
on the property page.

To move between keys for parameters on a property page:

t Click the Previous Key or Next Key buttons in the animation controls.
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t Right-click a parameter’s animation button and choose Previous Key or 
Next Key.

t To go to the first or last keys defined, right-click the keyframe button and 
choose First Key or Last Key. The keyframe button changes color to help 
you navigate among keyframes—see “The Keyframe Button’s Color” on 
page 281 for more information.

Removing Keys in a Property Editor

To remove all keys from a parameter:

1. Display the property editor from which you want to remove animation.

2. Right-click the parameter’s animation button and choose Remove Animation.

To remove a single key from a parameter on a property page:

1. Open the property editor from which you want to remove a key.

2. Move the playback cursor to the keyframe you want to remove.

3. Click the parameter’s animation button, or right-click it and choose 
Remove Key.

Keying Transformations

Keying transformations (scaling, rotation, and translation) is something that 
you’ll probably do a lot. As such, there are a number of ways in which you can 
key the transformation of scene elements.

To key transformations:

1. Select one or more objects.

2. Move the playback cursor to a frame where you want a keyframe.

3. Use any of these methods to set the transformation values:

- Use the SRT controls in the control bar, as shown on the left.

- Press the shortcut keys for scaling, rotation, or translation (X, C, 
or V, respectively).

- Use the 3D transform manipulators (press B to display them).

- Open the Local Transform property editor for an object.

- Set a key using any method as described in “Setting Keys” on page 278.



Chapter 10 Animating in Avid 3D

284

4. Move the playback cursor in the timeline to another frame where you 
want a key.

5. Transform the elements and set another key.

n Camera rotation in the X and Y axes cannot be keyed because the camera is 
constrained to point at the camera interest. You can animate a camera’s Z 
rotation by modifying its Roll parameter. For more information, see “Direction 
Constraints” on page 321.

Keying Transformations Quickly

The best method for quickly keying all axes for each type of transformation is 
to use the keyboard shortcuts found on the number pad (at the right of your 
keyboard), as mapped out here: 

Setting Keys Automatically

If you frequently animate objects and properties, you can automatically set 
keys as you adjust the object’s properties. Instead of clicking an animation 
button in a property editor each time you want to add a key, you can let the 
autokey mode automatically record the adjustments that you make.

To set keys automatically:

1. Move the playback cursor to a frame where you want a keyframe (where 
you want the animation to start).

2. Open the property editor and set the properties to the values you want or 
transform the objects as you want.

3. Click the auto button in the animation controls.

4. Move the playback cursor to where you want the next keyframe and 
change the animated properties again. Every time you change a property 
value, it is keyed.

Repeat this step as often as you need.

Scaling X, Y, Z Press 7

Rotation X, Y, Z Press 4

Translation X, Y, Z Press 1
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5. When you have finished, click the auto button again to turn autokey 
mode off.

n Remember that selecting any transformation tool automatically marks the 
corresponding scale, rotate, or translate parameter. Therefore, using a 
transformation tool after activating auto sets a key for the transformation.

Editing Function Curves

When you set keyframes to animate a parameter, a function curve is created. A 
function curve, or fcurve, is a representation of the animation values as a graph 
in the function curve editor.

• Time is shown plotted along the X axis (horizontal).

• The parameter’s value is plotted along the Y axis (vertical).

• The shape of the fcurve shows how the parameter’s value changes over time.
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On the fcurve, keyframes are represented by key points (also referred to as 
simply keys) and the interpolation between them is represented by segments of 
the fcurve linking the key points.

The handles of each key let you define the fcurve’s slope in the same way that 
control points define Bézier curves, while the slope of the fcurve determines 
the rate of change in the animation. For example, if the slope inclines toward a 
key, the animation is accelerating; a decline means a deceleration.

Working in the Function Curve Editor

The function curve editor is where you control the animation of the currently 
selected element using a number of different editing tools.

View area
Displays and allows manipulation of property 
animation using the graph.

Toolbar 
Contains commands and tools for saving, editing, and 
viewing animated properties (such as fcurves).

Animation tree
Displays the animatable 
properties of selected elements.
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Opening the Function Curve Editor

To display the function curve editor:

1. If the multi-purpose editor is not visible, click the Open/Close Multi-
Purpose Editor button in the control bar.

2. Click the Function Curve Editor tab in the multi-purpose editor.

The function curve editor responds to the currently selected elements. 
While it is open, it displays the animation of the elements you select.

n To open the function curve editor with specific elements already selected, 
see“Opening the Function Curve Editor with Specific Fcurves Selected” on 
page 290.

Using the Animation Tree

The animation tree in the function curve editor is actually an explorer (see 
“The Scene Explorer” on page 76 for general information). It displays the 
animatable properties of the currently selected elements (these have the 
animation button beside their name).

The parameters in the tree are similar to what’s shown in the scene explorer, 
but in this tree, parameters are displayed using Avid 3D’s internal naming 
scheme. For example, the tree below shows the object name and its animated 
parameters beneath it (kine, then local, and rotx selected).

You can use the tree to choose which properties (parameters) to display in the 
fcurve graph.

Animatable 
parameters have 
animation icons.
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To select parameters in the tree:

t Click the name of the parameter so that it is highlighted in purple.

t Select a branch of parameters by clicking on their parent node. For example, 
click the local node to select all position, rotation, and scaling parameters.

To expand and collapse an animation tree:

t To expand an item in an animation tree, click its plus sign (+). The 
elements, properties, and subproperties below it are listed.

t To collapse an item in an animation tree, click its minus sign (–). The 
items below it are no longer listed.

To reset the tree’s layout:

t Press the R key. This resets the layout of the animation tree to what it was 
when you first opened it.

To hide the tree:

t Click the little arrow on the bar that divides the tree from the view area 
fcurve graph. Click the arrow to redisplay the tree.

Using the Function Curve Editor’s Timeline

By default, the red playback cursor is displayed in the function curve editor’s 
timeline and over the view area. This lets you easily scrub through the 
animation and go to the exact frame you want.

As well, you can see and move loop markers in the function curve editor’s 
timeline when you click the Loop button in the playback controls.

Note that the playback cursor is always available in the timeline area, so long 
as it’s visible.

Drag the red playback cursor to move frames. 
You can also drag the yellow loop markers.
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Commands and Tools for Editing Fcurves

The function curve editor toolbar contains the tools you need for editing fcurves.

Hiding Parts of the Toolbar

The toolbar is divided into several sections, each of which can be hidden 
or displayed.

To hide or display areas of the toolbar:

t Right-click anywhere in an empty area at the top of the window and toggle 
the appropriate section on or off (a check mark means that it’s displayed).

Buttons

A number of commonly used commands are represented on the toolbar as 
buttons for quick access.

Select
fcurves or

keys.

Edit Key

Pan and zoom
Add/Remove Key

Linear/Spline 
Interpolation 
of fcurve.

Region selects 
rectangular 
area of fcurves.

Zoom

Frame frames 
selected keys or 
fcurves.

Horizontal/Vertical Pan 
pans and zooms across 
or up-and-down.

Select Curve

Select Key

Stretch Keys scales 
keys using a pivot point. Unified Slope 

Orientation/Handle Length

Constant/Gradient Extrapolation 
and Cycle/Relative Cycle set 
extrapolated and repeated fcurve 
segments.
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Opening the Function Curve Editor with Specific Fcurves Selected

When you select an object and open the function curve editor, you can view all 
fcurves created for that object. However, you usually want to home in on 
specific fcurves.

To open with marked parameters selected:

t Mark some parameters and then open the function curve editor. The 
marked parameters are automatically added to the selection in the editor.

For example, if you have the position parameters marked and you open 
the function curve editor, it automatically selects the marked parameters 
(in the tree and graph).

Setting Up the Function Curve Graph

Setting the Time Format (X Axis)

Setting the main Avid 3D timeline’s format also sets the format for the 
timeline in the function curve editor. See “Setting the Timeline Display 
Format” on page 271 for more information on how to set the timeline.

Setting the Graph’s Grid and Rulers

To show or hide the grid:

t Position the mouse pointer over the function curve editor and press G.

To selectively show or hide the X-axis or Y-axis grid lines:

1. In the tools and options panel, select the Function Curve Editor tab.

2. On the Editor page, select Display Grids > Show for the X and/or Y axes.

To set the size of units for the grid:

t Specify a value in the Display Grids text boxes for the X and/or Y axes.

To selectively show or hide the X-axis or Y-axis rulers:

t On the Editor page in the FCurve Editor property editor, select Rulers > 
Show for the X and/or Y axes.

To set the units for the ruler:

t Specify a value in the Ruler text boxes for the X and/or Y axes.
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Undoing and Redoing Fcurve Modifications

Like any other operation in Avid 3D, you can use the standard shortcut keys to 
undo or redo fcurve modifications:

• To undo any modifications to an fcurve, press Ctrl+Z.

• To redo the modification you just undid, press Ctrl+Y.

Viewing Function Curves

The graph in the function curve editor is where you manipulate the fcurve of 
any animatable parameter. You can edit the keyframed values by adjusting the 
keys on a selected fcurve.

The graph’s horizontal axis (X) displays the time scale in frames or 
milliseconds (see “Setting the Time Format (X Axis)” on page 290). The 
vertical axis (Y) displays the values of the animated parameter.

n Fcurves for X, Y, and Z parameters are red, green, and blue, respectively. For 
example, an fcurve for scaling in Z is blue, whereas scaling in X is red.

The slope handles at each key 
indicate the rate at which an fcurve’s 
value changes. You can change the 
curve’s slope by manipulating these 
handles (see “Editing a Function 
Curve’s Slope” on page 310).

Curve and axis labels indicate the 
type of curve and the affected axis. For 
example, this fcurve represents the 
object’s rotation on the Z axis. The axis 
label is in the graph’s lower-left corner.

Keyed values on fcurves are indicated by keys. 
Selected keys are red, and unselected keys are blue.

By default, fcurves use 
spline interpolation to 
calculate intermediate 
values (see “Choosing a 
Function Curve Interpolation 
Type” on page 309).

Values for the
parameter are shown

on the Yaxis.

Time is shown
on the X axis.

Key coordinates indicate the exact frame 
number (on the X axis) and value (here on the 
Y axis) of the most recently selected key.
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Hiding and Displaying Fcurves

You can hide one or more fcurves in the graph. Hiding fcurves does not 
remove them from the view, so any key selections are retained and available 
once you display the fcurve again.

To hide fcurves:

t Select one or more fcurves and choose press H to hide them. This also 
deselects the fcurves.

To display all hidden fcurves

t Do one of the following:

t Press Shift+H.

t Select the parameter name from the animation tree.

Hiding and Displaying Fcurve Information

You can choose to view extra fcurve, key, and slope information while you’re 
working in the graph. However, if you have many fcurves displayed in your 
graph, you may want to hide a certain amount of fcurve information to keep 
the view uncluttered.

From the View page in the FCurve Editor property editor, choose any or all of 
the following:

• View > Keys on Unselected Curves to show or hide keys on all 
unselected fcurves in the graph. If you choose this option, you can select 
keys without having to first select the fcurve. 

If you don’t choose this option, you must select an fcurve before being 
able to select keys on it. This prevents you from accidentally manipulating 
keys, which can be a problem if there are many fcurves and keys.

• View > Slopes on Unselected Keys to show or hide the slope handles of 
all unselected keys on a selected fcurve.

Zooming, Panning, and Framing in the Graph

You can use the Zoom, Pan & Zoom, and Frame tools (available from the 
toolbar buttons and supra keys) to view a specific area of the graph.

To deactivate any viewing tool, press Esc or choose another tool.
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Zooming

Interactively increase or decrease the magnification of the graph by pressing C 
or clicking the Zoom button in the toolbar. The cursor turns into a small 
magnifying glass:

• To zoom in (increase magnification), drag in the graph to define a region 
to enlarge, or hold down the left mouse button.

The region you draw defines the center of the region you want to see.

• To zoom out (decrease magnification), Shift+click and drag. Drawing a 
larger region zooms out less while drawing a smaller region zooms out more.

• To pan, middle-click and drag.

• To interactively increase and decrease the height of the view, right-click 
and drag up and down.

To increase and decrease the width of the view, right-click and drag right 
and left.

• To reset the zoom factor, click once in the graph.

You can also zoom in and zoom out by clicking the Pan button in the toolbar 
or pressing Z.

• To zoom in, hold down the middle mouse button. The zoom-in continues 
until you release the mouse button.

• To zoom out, hold down the right mouse button. The zoom-out continues 
until you release the mouse button.

• To pan, drag with the left mouse button. The pan continues until you 
release the mouse button or the Z key.

Panning

You can pan to scroll the area shown in the graph by clicking the Pan button in 
the toolbar or pressing Z.

• To pan, click+drag in the graph.

• To pan along the X axis, drag to the left or right.

• To pan along the Y axis, drag up or down.

n You can set the Pan button to be the default “pan and zoom” tool by selecting 
it as the Pan & Zoom Mode on the View page in the FCurve Editor property 
editor in the tools and options panel.
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Panning and Zooming Vertically or Horizontally

You can pan and zoom in the graph either only vertically or horizontally:

• To pan and zoom horizontally, press X or click the Horizontal pan & 
zoom button in the toolbar.

• To pan and zoom vertically, press S or click the Vertical pan & zoom 
button in the toolbar.

Framing

Framing sets the zoom and pan so that the fcurves or keys fit in the graph 
within a specified range.

• To frame keys, select the keys and click the Frame button or press F. If no 
keys are selected, the selected fcurves or regions are framed.

• To frame a region, highlight the region to be framed and click the Frame 
button or press F. If no region is selected, the selected fcurves are framed.

• To frame selected fcurves, click the Frame button or press F. If nothing is 
selected, then all fcurves are framed.

• To frame all displayed fcurves, click the Frame button with nothing 
selected, or press A.

• To frame all the fcurves within the time span specified by the timeline, 
press R.

Selecting Function Curves

When you select an fcurve, any modifications you perform are done to it. To 
select fcurves and their associated keys, select mode must be on. When 
selected, fcurves are highlighted in white and their keys are blue.

The selected fcurve is 
white with unselected keys 
in blue.
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n If your fcurve has lots of keys on it, use the animation tree to select an fcurve. 
This prevents keys on the other fcurves from being moved accidentally, and 
also lets you retain previously selected keys if you deselect the fcurve and then 
reselect it later.

To select both fcurves and keys:

t Do one of the following:

t Press Y.

t Click the Select button in the function curve editor’s toolbar.

To select only fcurves:

t Do one of the following:

t Click the Select Curve button in the function curve editor’s toolbar.

t Press the space bar.

This tool selects only fcurves without changing the key selection.

n You can select an fcurve while any tool is activated by clicking the parameter 
name in the animation tree.

To select and move fcurves:

t Press N.

To select a single fcurve:

Make sure the appropriate select tool is active, then do any of the following:

t If the fcurve is visible in the function curve editor, click it.

t If the fcurve is not visible in the function curve editor, click the fcurve’s 
associated parameter in the animation tree.

n To keep an fcurve selected while deselecting keys, middle-click+drag around 
the keys to deselect them.
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To select multiple fcurves:

There are several ways to select multiple fcurves. First activate the appropriate 
select mode, then do one of the following:

t Shift+click the associated parameters in the animation tree or the 
parameters’ fcurves in the graph to add them to the existing selection.

t Ctrl+click the associated parameters in the animation tree or the 
parameters’ fcurves in the graph to toggle their selection.

t Drag the mouse pointer across a range of fcurves in the graph; the red 
selection box indicates the region you are covering. Any fcurves that pass 
through the box are selected.

Deselecting Fcurves

To deselect fcurves:

t Click in an empty area of the graph. This deselects all fcurves.

If there were any selected keys on the fcurves before you deselected them, 
they are “remembered” when you select the fcurves again.

t Ctrl+click to toggle the selected fcurve.

If there were any selected keys on the fcurves before you deselected them, 
they are “remembered” when you select the fcurves again.

Selecting (Tagging) Keys

You can select one or more keys on fcurves. Selected keys are highlighted in 
red and their exact coordinates are displayed on the X and Y axes of the graph.

In addition, keys using spline interpolation have slope handles to modify the 
slope orientation and length (see “Editing a Function Curve’s Slope” on 
page 310 for more information).

Selected keys are red 
with slope (tangent) 
handles displayed.
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To select both fcurves and keys:

t Press Y.

To select only keys:

Do one of the following:

t Click the Select Key button in the function curve editor’s toolbar.

t Press T.

This tool cannot select keys on unselected fcurves.

To select one or more keys:

Make sure the appropriate select tool is active, then do any of the following:

t To select a single key, click it.

t To select multiple keys, Shift+click the points you want to select or drag a 
red rectangle around unselected points.

n When you select an fcurve and then drag a red rectangle, only the keys on the 
selected fcurve are selected.

t To add or remove a key from the current selection, Ctrl+click the key point.

To move between keys on the selected fcurve:

t Click the previous key (back arrow) or next key (forward arrow) buttons 
on the toolbar.

t Press the , (comma) and . (period) keys.

Deselecting Keys

To deselect keys:

t To deselect keys, click an empty spot in the graph. This also deselects all 
the fcurves. When you do this, any keys that were selected before are 
“remembered” when you select the fcurve again.

t To deselect multiple keys while keeping the fcurve selected, middle-
click+drag a rectangle around them.
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Selecting Keys by Region

Using the region tool, you can select regions of points, making it easy to edit a 
large number of points at one time. You can edit a region by moving, 
stretching, or compressing all the keys within the region as a group.

To move or scale regions, see “Moving Keys by Region” on page 300 and 
“Scaling Regions Interactively” on page 306.

To select a region of points:

1. Select the fcurves you wish to modify.

2. Click the Region button in the toolbar or press Q, then drag the mouse 
pointer horizontally across a section of the fcurves. This selects all points 
on the selected fcurves in the region.

3. Hold down the Alt key while dragging to snap the left and right edges of 
the region to keyframes. The selected area is highlighted in light gray.

n If you want to extend or shrink the region you have selected, press Shift while 
you drag.

You can also toggle fcurves and individual keys within the region by 
Ctrl+clicking them.

Inside the region, between the maximum and minimum values of the selected 
keys and the first and last keys of the selected fcurve, is a highlighted selection 
area. This region is bounded by four handles.

The region stays visible even if you change selection tools; however, it 
disappears when you click outside the region. As well, the last region you 
created for the fcurves is remembered the next time you select the same 
fcurves and activate the region tool.
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To deselect a region of points:

t Click anywhere outside the region.

Moving Function Curves, Keys, and Regions

When you move fcurves or keys in X, you change the keys’ time; when you 
move in Y, you change the keys’ values.

You can move fcurves, keys, and regions interactively or with numerical 
precision. You can also select a specific region of an fcurve in the graph and 
move, stretch, and compress the fcurve’s keys within that region as a single unit.

Moving Whatever is Selected

You can move either selected fcurves or keys using the Translate tool. It moves 
whatever is selected, with keys having the priority. For example, if fcurves are 
selected, it moves only those fcurves; if both fcurves and keys are selected, it 
moves only those keys.

To move selected fcurves or keys:

1. Select fcurves or keys.

2. Press V, then drag the selected fcurves or keys to a new location.

- To move only vertically, middle-click+drag.

- To move only horizontally, right-click+drag.

- To move multiple fcurves, first rectangle-select (Ctrl+drag) the 
fcurves you want, then press N and drag.

A handle bounds each side 
of the region. Drag these 
handles to resize the 
region.
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Moving Fcurves

To move fcurves interactively:

t Press N, then click+drag the fcurve to a new location.

- To move only vertically, middle-click+drag.

- To move only horizontally, right-click+drag.

- To move multiple fcurves, first rectangle-select (Ctrl+drag) the 
fcurves you want, then press N and drag.

Moving Keys

When you move a key, you can change either the frame or the value of that 
key. Moving keys horizontally changes the frame, while moving vertically 
changes the value.

n Because moving points interactively can be imprecise, you might want to have 
your keys snap to specific frames, time, or value intervals. For more 
information on snapping to the grid, see “Snapping Keys” on page 304.

To select and move keys:

1. Press M.

2. Select the points and drag them to a new location.

To snap keys while moving:

t Press the Shift key while you drag selected keys to snap them to the Snap 
Grid coordinates that are specified in the FCurve Editor property editor 
(see page 290).

- Middle-click+drag to move only vertically.

- Right-click+drag to move only horizontally.

Moving Keys by Region

To move keys by region:

1. Select the region of the fcurves you wish to modify (click the Region 
button in the toolbar or press Q).

2. To change the frame position or values of the fcurve region, click 
anywhere within the highlighted region and drag the region:
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- Dragging the region horizontally adjusts the frame position of the 
region (the animation occurs earlier or later in the timeline). You can 
also right-click+drag to move the region only horizontally.

- Dragging the region vertically changes the values of the entire region. 
All neighboring keys remain in their original positions. You can also 
middle-click+drag to move the region only vertically.

Moving Fcurves, Keys, and Regions Precisely

You can accurately move fcurves, keys, and regions to a specific location 
using the Frame and Value boxes in the function curve editor’s toolbar.

To move fcurves, regions, or keys with the Frame and Value boxes:

The Frame and Value text boxes show the frame and value of the currently 
selected key.

1. Select the keys or region you want to offset. To offset the entire fcurve, 
select the fcurve and leave the keys unselected.

2. Enter the amount of the offset in the Frame or Value text box, followed 
by a + (addition) or – (subtraction) sign.

For example, to advance several keys by two frames, you would select the 
keys and enter 2+ in the Frame text box. To decrease the value by two 
points, you would select the keys and enter 2- in the Value text box.

n You can also type in the exact frame number or value that you want. For 
example, if you know you want the selected key to have a value of 85, type this 
number in the Value text box—likewise for setting frames.

You can also use the Frame and Value text boxes for scaling—“Scaling 
Function Curves, Keys, and Regions” on page 305.

Adding and Deleting Keys

When you add or delete keys on an fcurve, it is the same as adding or deleting 
keyframes. Avid 3D recalculates the interpolation and draws new fcurve 
segments reconnecting the keys.
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n If you add a point on the same frame as an existing key, the old point is replaced.

Adding Keys Interactively

To add keys interactively:

1. Select the fcurves to which you want to add points.

2. Do one of the following:

t Activate Add Key mode by clicking on the Add Key button in the toolbar 
or by pressing I. On the fcurve, click where you want to add keys.

t Click the Edit Key button or press Shift+E. Then middle-click to 
add keys.

Because adding points interactively can be imprecise, you might want to have 
your keys snap to specific time or value intervals. For more information on 
snapping to the grid, see “Snapping Keys” on page 304.

Inserting Keys Without Changing the Fcurve Shape

You can insert a key anywhere on an fcurve without changing the shape of the 
fcurve. This is especially useful with fcurves that have few keys, or fcurves 
that have sharp peaks and valleys where adding a key as usual would change 
the shape of the fcurve.

1. Click the Add Key button in the toolbar or press I.

2. Hold down the middle-mouse button and drag the red vertical bar that 
appears. The small box on the bar follows the shape of the fcurve as you drag.

n Press Ctrl while dragging to snap to the increments set in the FCurve Editor 
property editor (see page 290).

3. Release the middle mouse button at the place where you want to add the 
key. The key is added without changing the shape of the fcurve.

Drag red box along the 
curve to where you 
want to add the key.
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Deleting Keys

When you delete keys from an fcurve, it is the same as deleting a keyframe 
from your animation. Avid 3D recalculates the interpolation and draws a new 
fcurve segment connecting the remaining keys.

To delete specific keys using the Delete Key tool:

1. Select the fcurves from which you want to delete points.

2. Click the Delete Key button on the toolbar or press D.

3. Left-click the keys you want to delete.

To delete specific keys using the Edit Key tool:

1. Click the Edit Key button or press Shift+E.

2. Right-click the keys you want to delete.

To delete multiple keys:

1. Select the fcurve or fcurves from which you want to delete keys.

2. Select all the keys you want to delete.

3. Press Delete.

Removing Animation from Fcurves

When you delete all the keys on an fcurve, you remove the animation of the 
associated property and the property’s fcurve reverts to a flat line, but remains 
in the graph.

For more information on removing animation in general, including removing 
fcurves from marked parameters, see “Removing Animation” on page 269.

To delete all keys on selected fcurves:

1. Select the fcurves whose points you want to delete.

2. Press Backspace.

n When you have removed keys from multiple fcurves, undoing (press Ctrl+Z) 
only has an effect on the first fcurve you selected—the other fcurves remain 
flat-liners.
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To delete fcurves:

t Right-click the animation button of an animated parameter in the 
animation tree and choose Remove Animation. This deletes all fcurves 
on that parameter completely.

If you mark parameters and then choose Remove Animation, all 
animation is removed for all marked parameters.

Snapping Keys

When you’re moving or adding keys, you can make them snap to time and/or 
value coordinates on the fcurve graph grid’s X/Y axes.

To set up the snapping coordinates:

1. In the tools and options panel, click the Function Curve Editor tab.

2. On the Editor page in the Snap Grid controls, set the X (Time) in frame 
increments and the Y (Value) in value increments for the grid.

If more than one key is selected and translated, only the translation 
amount is snapped to the grid. The keys that were on the grid remain on 
the grid and the others remain outside of it. For example, if you have set 
the X (Time) grid to 5, you would only be able to translate keys 
horizontally in increments of 5 frames.

3. Select the Snap option below the X and/or Y options, depending on the 
coordinates to which you want the keys to snap. For example, if you want 
keys to snap only to frames, select only the Snap option below X (Time).

To snap keys to the grid:

t Do one of the following to have keys snap to the grid’s X (time) and Y 
(value) coordinates as specified by the Snap Grid coordinates in the 
FCurve Editor property editor:

t Press the Shift key while you drag selected keys.

t Middle-click+drag to snap only vertically.

t Right-click+drag to snap only horizontally.
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Scaling Function Curves, Keys, and Regions

You can change the timing of your animation by scaling fcurves, keys, or 
regions of them. When you decrease the length of the fcurve or region (X 
axis), you speed up the animation; conversely, increasing the length slows 
down the animation. You can also scale fcurves, keys, and regions on the Y 
axis, which changes the animation values (the pivot point is 0).

Scaling Precisely

To scale precisely, you can use the Frame and Value text boxes in the function 
curve editor’s toolbar.

To scale keys, fcurves, or regions:

1. Select the keys, fcurves, or region you want to scale:

- If you scale keys in time (X axis), the pivot point is the left-most key’s 
time on the fcurve.

- If you scale keys’ values, the pivot point is 0.

2. Enter the amount of the scaling in any of these text boxes:

- To change the length of the fcurve or the position of the key, enter a 
value followed by a * (multiplication) or / (division) sign in the Frame 
text box. For example, to double the length of an fcurve, enter 2*.

- To change the value of the fcurve or key, enter a value followed by a * 
(multiplication) or / (division) sign in the Value text box. For 
example, to divide the value in half, enter 2/.

Selected curve before scaling. Selected curve after scaling by 2. Notice the ghosted 
fcurve in black showing the previous scale.
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Scaling Regions Interactively

You can scale an fcurve region in time (horizontally) or by value (vertically).

To scale a region interactively:

1. Select the region of the fcurves you wish to modify (click the Region 
button in the toolbar or press Q).

2. Do one of the following:

t To stretch or compress the region using the opposite boundary as the 
pivot, left-click+drag a handle.

t To stretch or compress the region symmetrically, using the center as a 
pivot, middle-click+drag a handle.

Dragging horizontally shortens or extends the region over time. Dragging 
vertically increases or decreases the range of values in the region.

The region cannot be stretched any farther than neighboring keys.

For information on how to move regions, refer to “Moving Keys by Region” 
on page 300.

Left-click+drag a handle to use the 
opposite border of the region as the pivot.

Middle-click+drag a handle to use the 
center of the region as the pivot (scale in 
symmetry), as shown on the right.
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Scaling with a Pivot

You can stretch selected keys as you do with a region except that you can set a 
pivot point anywhere in the graph area. When you move your mouse, the keys 
are scaled according to where you clicked (the pivot point). For example, if the 
pivot point is directly between keys, you can scale in symmetry.

You can also select a single key and scale with a pivot, which is especially 
useful if you’re scaling the values on an fcurve (scaling vertically). When you 
scale a key with a pivot point, you don’t need to reorient the key’s handles 
because they are correctly scaled with the key.

To scale with a pivot point:

1. Select one or more keys in an area of the fcurve you want to scale.

2. Do one of the following:

t Press B.

t Click the Stretch Keys button in the toolbar.

3. Click where you want the pivot point to be: red crosshairs and a “target” 
shows the spot. The pivot location is displayed on the status bar at the 
bottom of the Avid 3D window.

4. Click+drag the mouse to scale the keys:

- Left-click+drag to scale either horizontally or vertically. You can 
scale in only one direction at a time. The direction is determined by 
which way you initially move the mouse (horizontally or vertically).

- Middle-click+drag to scale only vertically.

- Right-click+drag to scale only horizontally.

Pivot point between 
two selected keys to 
scale in symmetry.
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Cutting, Copying, and Pasting in the Graph

You can cut, copy, and paste keys, an fcurve region, or entire fcurves, using the 
standard keyboard shortcuts for the cut, copy, and paste functions: Ctrl+C 
(Copy), Ctrl+X (Cut), and Ctrl+V (Paste).

Function Curves

To cut, copy, and paste an fcurve:

1. Select the fcurve you want to cut or copy.

2. Copy the fcurve to the clipboard by pressing Ctrl+C or cut it by pressing 
Ctrl+X.

3. Select a parameter (or its fcurve) as the target to which you want to paste.

4. Paste from the clipboard by pressing Ctrl+V.

You can continue pasting the clipboard contents to other fcurves.

Keys

To cut, copy, and paste keys:

1. Select the keys you want to cut or copy.

2. Copy them to the clipboard by pressing Ctrl+C or cut them by pressing 
Ctrl+X.

3. Select an fcurve or region as the target onto which you want to paste:

- To paste the new keys starting at a specific frame on the fcurve, drag 
the playback cursor in the graph to the frame.

- To paste the new keys in a specific region of the fcurve, select the 
region using the Region tool.

4. Paste from the clipboard by pressing Ctrl+V.

If the target is a region, the clipboard contents are scaled to fit the number 
of frames in the selected area.

You can continue pasting the clipboard contents to other fcurves or regions.

n You can also copy animation quickly in the animation tree by dragging an 
animated parameter’s name to another parameter. Pressing Shift while 
dragging and dropping moves the animation instead of copying it.
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Regions

When you cut or copy a region, Avid 3D can cut or copy just the selected keys 
or the fcurve segment in the region itself. This is determined by the method 
used to select the region before copying or cutting.

1. Do one of the following depending on what you want to cut/copy:

t To cut or copy the keys within a region, use the Region tool (press Q) 
or select a series of keys on the fcurve.

t To cut or copy the fcurve segment in the region, use the Select tool 
and drag a rectangular selection over the fcurve.

2. Copy them to the clipboard by pressing Ctrl+C or cut them by pressing 
Ctrl+X. A black line appears in the graph.

3. Select an fcurve or region as the target onto which you want to paste:

- To paste the new region starting at a specific frame on the fcurve, 
click in the graph to move the black line to the frame.

- To paste the new keys in a specific region of the fcurve, select the 
fcurve region using the Region tool.

4. Paste from the clipboard by pressing Ctrl+V.

If the target is a region, the clipboard contents are scaled to fit the number 
of frames in the selected area.

You can continue pasting the clipboard contents to other fcurves or regions.

n If you want to paste the region after performing other functions in the function 
curve editor, you can use the playback cursor to determine where the region 
will be pasted.

Choosing a Function Curve Interpolation Type

Fcurve interpolation is a way of estimating how animation progresses between 
keys. When you set two or more keys for a parameter, Avid 3D determines the 
interpolation between them.

By default, fcurves use a spline interpolation which creates a smooth ease-in 
and ease-out transition at each key. However, if you want to change the nature 
of the animation, you can switch to linear interpolation.
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To set the interpolation type:

1. Do one of the following:

t Select individual keys. The interpolation setting will be applied to the 
fcurve segments immediately following the selected keys.

t Select an fcurve. The interpolation setting will be applied to the 
entire fcurve.

2. Do either of the following:

t Click the Spline Interpolation button on the function curve editor 
toolbar. It uses a curved spline interpolation that accelerates and 
decelerates into (ease in) and out of (ease out) each keyframe, 
resulting in a smooth transition.

The degree of acceleration and deceleration before and after the 
keyframe is determined by the slope handles associated with the key. 
For information on the slope, see “Editing a Function Curve’s Slope” 
on page 310.

Spline interpolation is the default form of interpolation used in Avid 3D.

t Click the Linear Interpolation button on the function curve editor 
toolbar. Linear interpolation connects keys by straight line segments. 
The movement is characterized by constant speed with sudden 
changes at each key, creating a mechanical feel to the animation.

This may be useful for animating lights and colors, where you don’t 
need the ease-in and ease-out that a spline interpolation offers.

Editing a Function Curve’s Slope

The fcurve’s slope determines the rate of change in the animation. By 
modifying the slope, you can change the acceleration or deceleration in or out 
from a key, thus making the animation change rapidly or slowly, or even 
reversing it. The steeper the slope’s orientation, the faster the values change.

You can change the slope of any fcurve that uses spline interpolation by using 
the two handles (called slope handles) that extend out from a key. By 
modifying the handles’ length and direction, you can define the way the fcurve 
moves to and from keys.
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By default, the slope handles are tangent to the fcurve at their key. This keeps 
the acceleration and deceleration smooth, but you can also “break” the slope at 
a certain point to have a sudden animation acceleration or deceleration, or 
change of direction altogether (see “Breaking and Unifying the Slope Angle” 
on page 312).

Slope handles are hidden until a key is selected, which prevents you from 
accidentally manipulating them.

Changing the Handles’ Length and Angle

The length of the slope handles determines the weight of the key’s influence 
on the fcurve. The longer the handle, the more the key influences the 
connecting fcurve segment. By having control over the handle length, you can 
also draw more complex fcurve shapes with fewer keys.

As you change the orientation and length of the slope handles, you can also set 
how the handles move: the left and right handles can be manipulated 
independently, together, or locked in place.

For more information, see “Breaking and Unifying the Slope Angle” on 
page 312 and “Controlling the Length of the Slope Handles” on page 313.

Slope handles displayed on 
each selected key. 

You can change the length and 
angle of each handle in unison 

The same fcurve, with short, medium, and long slope handles. Notice 
how the length of the handle changes the shape of the curve.
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To change the slope handles interactively:

1. Select one or more keys on an fcurve with spline interpolation—slope 
handles appear on each selected key.

2. Click the end of one slope handle and drag it to a new location, changing 
the length and/or angle of the handle. All the other slope handles move in 
the same way as this one.

You can use the mouse buttons as follows:

- Left-click+drag to change both the angle (orientation) and length of 
the handle.

- Middle-click+drag to change only the angle of the handle.

- Right-click+drag to change only the length of the handle.

n If you are having trouble selecting a slope handle’s end point because it is in 
the same location or too close to a key, press the P key to give priority to the 
end point.

Breaking and Unifying the Slope Angle

When slopes are unified (default), any change you make to one side of the 
slope at a key is reflected on the other side. However, you can “break” a slope 
at a key so that you can change either slope independently.

You may want to break the slope to create a sudden change in motion at a key, 
such as an object hitting a wall or a bouncing ball hitting the ground and then 
bouncing up again.

To control the orientation of the slope:

t Select keys and do one of the following:

t Press Shift+O.
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t Click the Unified Slope Orientation button in the function curve 
editor toolbar.

When the Unified Slope Orientation button is active, it keeps the slope 
handles of the selected keys unified as you move them, keeping a 
constant angle between them. Unified slopes provide smooth, 
unbroken function curve segments, as values ease into and out of keys.

When the Unified Slope Orientation button is not active, you can 
break the slope to control the slope’s shape on either side of the key 
individually. Depending on the slopes you define, the transition in the 
rate of the parameter’s change at the keyframe can be as smooth or as 
abrupt as you like.

When the slope is broken, you can drag the slope handle in any direction. 
You can also middle-click+drag to change only the slope handle’s angle, 
or right-click+drag to change only the slope handle’s length.

Controlling the Length of the Slope Handles

Like a Bézier curve, you can set the length of the slope handles on both sides 
of the key to be equal or not.

To control the length of the handles:

t Select keys and do one of the following:

t Press Shift+L.

t Click the Unified Slope Length button in the function curve editor toolbar.

If this command is active, both handles are kept the same length. This 
is the case even if the slope orientation is broken.

Unified Slope Orientation is 
active. Notice the smooth curves.

Unified Slope Orientation is not 
active. Notice the sharp breaks in the 
curve.
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If this command is not active (default), the length of each slope 
handle is independent.

Snapping Slope Handles

You can snap slope handles in two different ways:

• Snap the handle’s length to a specific number of units (default is 1), from 
0.01 to infinity.

• Snap the handle’s angle to a particular degree (45 is the default), between 
1 and 90.

To snap the slope handles in length or angle:

1. In the tools and options panel, click the Function Curve Editor tab.

2. On the Editor page, set the Snap Slope > Length in units and/or Angle 
in degrees.

3. Click in the appropriate Snap checkbox to activate Length and/or Angle.

4. Select one or more keys.

5. Press the Shift key while you drag a slope handle to snap it in the 
increments you set. This temporarily activates the Snap Slopes command.

- Middle-click+drag to snap only the handle’s angle.

- Right-click+drag to snap only the handle’s length.

Extrapolating Function Curves

The extrapolation controls let you modify the shape of an fcurve before the 
first key and after the last key. Extrapolation extends the fcurve’s ends based 
on the position of these two extreme points.

To apply extrapolation to an fcurve:

1. Select an fcurve.

2. Click either the Constant Extrapolation or Gradient Extrapolation 
button in the function curve editor toolbar.

For spline interpolation, the slope of the first or last key is used. This 
results in a continuation of the motion at the same speed.
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- Constant extrapolation flattens the fcurve after the end points, adding 
no animation. It extrapolates the value of the Y axis from the first frame 
to the first key, and the value of the Y axis from the last key to the last 
frame. This results in a hold of motion before and after the movement.

- Gradient extrapolation makes the fcurve continue in the direction of 
(tangent to) the end keys’ slope handle angle. It extrapolates an 
increment based on the first key’s slope orientation and applies it 
from the first frame to the first key. Then it extrapolates the increment 
calculated between the last and previous-to-last keys and applies it 
from the last key frame to the last frame. This has the effect of the 
fcurve continuing on this slope indefinitely.

Creating Function Curve Cycles

The Cycle commands in the function curve editor’s toolbar provide you with 
several quick ways to repeat animation. By using these controls, you can 
create repetitive motion including bouncing, spinning, or oscillation effects. 
You can create basic endless cycles or you can have relative cycles that are 
progressively offset (such as for creating a walk cycle).

With constant extrapolation, the values before the first keyframe 
and the values after the last keyframe remain constant.

With gradient extrapolation, the values before the first keyframe and 
the values after the last keyframe are determined by the slope. Note 
the slope handles’ relation is tangent to the extrapolated values.



Chapter 10 Animating in Avid 3D

316

When you create cycles, only the original fcurve retains its keys: the resulting 
cycles don’t have any. However, there is a “relational” link between the 
original keys and their counterparts on the resulting fcurves. 

This means that you can change a key in the original segment and those 
changes are automatically reflected in the cycles (you can add or delete points, 
move points, change the slope, etc.—it’s all updated in the cycles). You can 
also switch between different types of cycles at any time.

Tips for Creating Seamless Cycles

• If the first and last keys points on the fcurve segment you want to repeat 
do not have the same value, there will be some jumping in the animation 
as the object snaps from the last frame to the first one of the next cycle. 
You can make seamless cycles by setting the first and last key to precisely 
the same value. 

To do this, enter the same values for the keys in the Value box in the 
function curve editor’s toolbar or right-click either the first or last 
keyframe in the timeline and drag to the other end keyframe to copy the 
values exactly.

• If you have one or more keys on your fcurve that are not on a frame, this 
can produce unpredictable effects because the cycle is evaluated at each 
frame and not on an intermediate time.

Creating a Basic Cycle

The Cycle commands in the function curve editor’s toolbar repeats the fcurve 
shape as defined by its keys. This means that the part of the fcurve as defined 
by its first and last keys is cycled endlessly in both directions in time (X axis). 

To create a basic cycle:

1. Select one or more fcurves whose shape you want to repeat (that is, the 
shape between the first and last keys).

2. Click the Cycle button in the function curve editor’s toolbar.

3. The fcurve segment is repeated continuously in both directions in time.
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Creating a Relative Cycle (Offset)

The Relative Cycle button repeats the fcurve shape (defined by its first and 
last keys) by making each cycle start with the same value as the last key of the 
previous value. This results in an fcurve cycle with a progressive offset.

Setting a progressive offset is particularly important when you want to create a 
simple walk cycle. For example, animating a foot translation in a repeated 
cycle on the Y axis generally requires no offset, but cycling animation on the 
X axis without an offset would make the character look like he’s walking 
without moving forward.

To create a relative cycle:

1. Select one or more fcurves whose shape you want to repeat.

2. Click the Relative Cycle button in the function curve editor’s toolbar.

Deleting Fcurve Cycles

Since a cycle’s repeated information is not actually added to the fcurve, you 
can delete the cycle completely while leaving the original keyframes intact.

The original keys are indicated between the dashed lines. Notice how 
the resulting cycles have no keys.

The original keys are indicated between the dashed lines. Again, 
note how the resulting cycle has no keys.
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To delete the cycle information:

t Select one or more cycled fcurves and click either the Constant 
Extrapolation or Gradient Extrapolation button in the function curve 
editor toolbar.

For more information on extrapolation, see “Extrapolating Function 
Curves” on page 314.

Function Curve Presets

You can quickly create simple fcurves for specific types of motion without 
having to modify slope handles by using fcurve presets. By using presets to 
automatically set up the right kind of fcurve, you can concentrate on the 
timing and values of the keyframes themselves.

To apply an fcurve preset:

1. Mark the parameter you want to animate.

c Creating an fcurve using the presets will replace the parameter’s 
existing animation.

2. In the tools and options panel, click the Animation Tools tab and click one 
of the following Fcurve Presets buttons:

- The Decelerating Curve preset creates an fcurve that drops off 
sharply from its maximum value and gradually approaches zero. The 
Accelerating Curve preset is its opposite.

- The Ease In Curve preset creates an fcurve that starts at zero, 
accelerates, and then decelerates as it approaches its final keyframe 
value. The Ease Out Curve preset is its opposite.

- The Constant Speed (Linear Curve) preset creates an fcurve that 
starts at zero and increases at a constant rate until it reaches the 
final keyframe.

- The Gaussian Curve preset creates an fcurve that begins and ends at 
zero with a maximum value keyframed at the midway point. The 
fcurve eases into and out of each keyframe.

The resulting animation can be modified by adding or deleting keyframes. See 
“Methods for Setting and Removing Keys” on page 278 and “Commands and 
Tools for Editing Fcurves” on page 289 for more information.
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Animating with Constraints

Constraining is a way of increasing the speed and efficiency in which you 
animate. It’s a way of animating one object via another one’s animation. You 
constrain different properties, such as position or direction, of one object to 
another object. Then when you animate the constraining object (sometimes 
known as the constrainer), the other object’s constrained properties are 
animated as well.

In terms of saving time, the value of constraining objects is considerable. 
Suppose you want to animate a group of people at an air show watching a 
plane fly overhead. If you used keyframes to animate, you would have to 
generate function curves for each head movement as well as the plane. With 
constraints, however, you constrain each spectator’s head to the direction of 
the plane and then animate only the plane itself.

A more specialized form of constraint is the path constraint, which allows you 
to use a curve object as a guide for a constrained object by moving the object’s 
center along the curve over time.

n The constraint overrides any related local transformations previously applied 
to a constrained object. For example, a direction constraint overrides the 
object’s existing rotation parameters.

You can have more than one constraint applied to a particular object at the same 
time. When more than one constraint is active at the same time on an object, all 
constraints are used but the constraint that is applied last takes priority.
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Position Constraints

You can constrain one or more objects to the position (location) of another 
object. This can be any type of object that has a center, including all standard 
geometric objects as well as nulls, lights, cameras, and lattices. The Position 
constraint constrains an object’s center to the constraining object’s center, 
which moves the constrained object to that location.

To constrain an object’s position:

1. Select the object to be constrained.

2. In the tools and options panel, click the Animation Tools tab. 

3. Click the Position Constraint button and pick the object to act as the 
constraining force.

The constrained object’s center is repositioned to the center of the 
constraining object.

4. When you transform the constraining object, the constrained object’s 
center remains aligned to it.

Because this constraint puts the objects directly “on top” of each other, you 
usually need to offset the constrained object in the constraint’s property editor. 
You can also choose to have the constraining object control the orientation of 
the constrained object.

To set position constraint parameters:

1. Select the constrained object, then open the multi-purpose editor.

2. Click the Geometry and Deform Properties tab in the multi-purpose 
editor, then click the object’s Position Cns node.

• You can set an offset between the centers of the constrained and constraining 
objects by entering values for the X, Y, Z sliders for either of them.

See “Creating Offsets between Constrained and Constraining Objects” on 
page 329 for more information about offsets.
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• You can select Affected by Orientation for either the constrained or 
constraining object. If you do so, the object rotation is included as part of 
the constraint for that object.

For example, if you select Affected by Orientation for the constrained 
object, its position is affected by the orientation of the constraining object.

• The Affected by Scaling option operates in a similar manner for scaling.

Direction Constraints

You can constrain an axis of one or more selected objects to another object 
without changing the location of the constrained objects. The aligned axis (the X 
axis by default) of each constrained object always remains facing the center of 
the constraining object, thus affecting the orientation of the constrained object.

The position constraint is calculated according to the 
constraining object’s center, which is offset on the X axis by 1.
(An offset has already been applied to the position of the 
constrained object’s center.)

If Affected by Orientation is selected for the 
Constrained Object, the airplane is influenced by 
the orientation (rotation) of the magnet.

Enter the axis offset of the constraining 
object’s center in the Attach Point - 
Constraining Object axis controls.
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To constrain an object by direction:

1. Select the object to be constrained.

2. In the tools and options panel, click the Animation Tools tab. 

3. Click the Position Constraint button and pick the object that is to act as a 
target (constraining object). The constrained object rotates so that its X 
axis (default axis) faces the constraining object’s center.

4. Translate either the constraining object or the constrained object:

- If you translate the constraining object, the constrained object rotates 
so that its specified axis always faces the constraining object, like a 
sunflower facing the sun. 

- If you translate the constrained object, its specified axis continues to 
face the constraining object from its new location like a 
geosynchronous satellite; that is, it is always pointing toward the 
same location on earth as it follows the earth’s orbit.

To set direction constraint parameters:

1. Select the constrained object, then open the multi-purpose editor.

2. Click the Geometry and Deform Properties tab in the multi-purpose 
editor, then click the object’s Direction Cns node.

Radar dish constrained by direction to the plane
The X axis of the radar dish continually points in the direction of the plane’s center.
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3. In the Direction Constraint property editor, use the Align Axis controls to 
specify the axis to point along—X is the default. If two or more values are 
non-zero, the object points along the resulting vector.

- You can also add a Target Offset on any axis of the constrained 
object. This is a rotational offset in degrees from the constraining 
(target) object (see “Creating Offsets between Constrained and 
Constraining Objects” on page 329 for more information). 

- You can also control the roll of the constrained object—its rotation 
about its local Z axis—by setting the Roll to Active and setting its 
angle of rotation.

Path Constraints

A path provides a route for an object to follow in order to get from one point to 
another. The object stays on the path because its center is constrained to the 
curve for the duration of the animation.

After you’ve created path animation, you can modify the animation by 
changing the path curve itself or by changing the timing of the object on the 
path. See “Modifying the Path Curve” on page 327 and “Modifying the Path 
Timing” on page 325, respectively.

Setting Objects on Paths

The quickest and easiest way of animating an object along a path is by using 
the Set Object on Motion Path button in the Animation Tools panel and 
picking the curve to be used as the path. When you use this command, the 
animation is created for you. There’s no need to set keyframes—just set the 
start and end frames.

A percentage function curve is created with your choice of spline 
(ease-in/ease-out) or linear interpolation. After you have created path 
animation, you can modify the timing by editing this function curve in the 
function curve editor (see page 285) or you can change the path curve itself to 
change the animation (page 327).
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To animate an object along a path:

1. Create a curve by dragging a curve object from the Object Library into 
a viewport.

2. Edit the curve as desired—see “Modifying Points and Polygons” on 
page 170.

3. Select the object you want to animate.

4. In the tools and options panel, click the Animation Tools tab, then click 
the Set Object on Motion Path button.

5. Pick the curve to use as the path. Keys are created at each end of the path 
(corresponding to the first and last frames on the timeline range), and the 
object’s intermediate position along the path is interpolated.

To set path constraint parameters:

1. Open the PathCns property editor by selecting the object and choosing the 
Geometry and Deform Properties tab in the multi-purpose editor and 
clicking the PathCns property.

• The Path %age (percentage) slider is especially important for controlling 
how much of the curve is used as a constraining force on the selected object.

Controls the object’s roll. See
the following steps.

Toggles activeness of
path constraint.

Percentage of curve used as
constraining force for

constrained object.

Sets an offset distance on XYZ
axes between object and path.

Keeps object tangent to
path—see next step.
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• If you want the object’s X axis (by default) to stay aligned with the path’s 
slope, select Tangent (the default). The constrained object’s axis is 
repositioned to point in the direction of the curve’s slope. As the object moves 
along the path, its X axis follows the curve’s slope. For more information on 
tangency constraints, see “Tangency Constraints” on page 327.

You can also set the X, Y, and Z values to define a vector along which the 
object’s center is aligned (the default is X). Set the appropriate slider to 1 
to keep that axis tangent to the path.

• You can control the roll of the constrained object—its rotation about its 
local Z axis—by setting the Roll to Active and setting its angle of rotation.

• To modify the path timing, see “Modifying the Path Timing” on page 325; to 
modify the path curve itself, see “Modifying the Path Curve” on page 327.

Creating a Path from Path Keys

You can also define path animation by moving an object and saving path keys 
at different frames. The path curve is created automatically as you go, with 
each key representing a percentage of the path length.

To create a path by setting path keys:

1. Move the playback cursor to the frame where you want the animation to 
begin and select the object you want to animate and translate it to where 
you want it to start.

2. Click the Save Path Key button in the Animation Tools panel, or press N.

A key is set corresponding to a percentage of the path’s length.

3. Change frames, move the object, and repeat step 2. Avid 3D automatically 
updates the curve and timing information. Continue until you have 
completely defined the path.

Modifying the Path Timing

After you’ve created path animation, there are two ways in which you can 
modify the timing:

• Set keys for the Path percentage in the PathCns property editor.

• Edit the Percentage fcurve in the function curve editor.
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Setting Keys or Editing the Path Percentage

To edit the Path Percentage parameter or function curve:

To modify the path timing, you can directly adjust the Path Percentage in the 
PathCns property editor and set keys at different frames or edit the Percentage 
function curve in the function curve editor.

1. Select the object on the path.

2. Adjust the path percentage by doing one of the following:

t Display the PathCns property editor and adjust the Path %age values.

t Open the function curve editor and click the perc parameter.

The percentage (perc) function curve is displayed with key points 
representing keys on the path.

3. Set new keys for the Path %age parameter or edit the perc function curve 
as you would any other function curve (see “Editing Function Curves” on 
page 285 for information).

With either of these methods, you can set keys with values below 0% or 
higher than 100% of the path. Avid 3D extrapolates path percentages outside 
of the 0 to 100% range, depending on the type of curve used as a path:

- On a closed curve, such as a circle or a square, using path percentages 
less than 0% or greater than 100% will continue to translate the object 
on the curve, with increasing percentages resulting in clockwise 
movement (relative to the local front of the object). 

For example, if an object were keyed to start at 0% of a circular path 
and end at 150%, the object would make one complete clockwise 
revolution of the circle and continue for another half a revolution. If 
the end were at –150%, the object would travel the same distance 
counterclockwise.

- On an open curve, such as a spiral or an arc, keys below 0% place the 
object at the curve’s starting point; keys above 100% place it at the 
curve’s endpoint.
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Modifying the Path Curve

To modify the path, you can edit the curve itself or translate the object 
constrained to the path. For more information on editing curves in general, see 
“Modifying Points and Polygons” on page 170.

To modify a curve:

t Move, add, or remove points on the curve as you would to edit any curve.

Modifying a path curve may change the path animation’s timing because 
the same keyed percentages would correspond to different locations on 
the curve.

Tangency Constraints

The tangency constraint makes the X axis of a constrained object tangent to a 
direction or curve. This is particularly useful for having an object follow a 
path’s direction, such as a roller coaster car following the tracks, or pitching an 
object (especially a camera) on a path.

Tangency is not a “real” constraint per se, but is available as a property for the 
Path constraint.
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To set a tangency constraint:

1. Select an object that is constrained to a path.

2. Under the Tangency option in the constraint’s property editor, select the 
Active option.

3. Use the Axis to Align controls to specify the axis to point along—X is the 
default. You can either click the axis buttons (positive and negative X, Y, 
Z) or enter 1 or -1 in the axis text boxes.

If two or more values are non-zero, the constrained object points along the 
resulting vector.

The plane in the top figure is animated on a path but is not constrained to be tangent 
to the path. It remains oriented this way, regardless of its position on the path.

In the bottom figure, the plane’s Y axis has been constrained to be tangent to the 
path. Note that the nose of the constrained plane does not always rest on the path 
because the constraint uses the object’s center to set tangency.
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Creating Offsets between Constrained and Constraining Objects

When you constrain an object to another, you often need to offset it in some 
way from the constraining object. For example, if you position-constrain one 
object to another without an offset, both objects end up sharing the same 
coordinate points and seem to be on top of one another.

You can set offsets between the constrained and constraining objects in the 
constraints’ property editors. For example, you can offset the constrained 
object’s distance from the constraining object for a position constraint, or 
offset the rotation for a direction constraint.

To create an offset to a position constraint:

1. Select the constrained object, then open the multi-purpose editor.

2. Click the Geometry and Deform Properties tab in the multi-purpose 
editor, then click the object’s Position Cns node.

3. Using the X, Y and Z sliders for either the constrained object or 
constraining object parameters, set how far (in distance units) along the 
global axes you want to separate the objects.

You can also create an offset for a direction constraint by modifying the 
Target Offset so that the constrained object points to a spot a specified 
distance from the constraining object.

Position constraint without offset
The position of the constrained 
object’s center matches that of the 
constraining object’s center.

Position constraint with offset
An offset is applied to the position 
of the constrained object’s center.

Constrained object 
(airplane)

Constraining object 
(magnet)
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n Unlike position constraint offsets, direction constraint offsets use the 
constraining object’s local axes as their frame of reference.

Activating and Deactivating Constraints

You can temporarily deactivate a constraint and reactivate it later by opening 
the constraint’s property editor and toggling its Active option.

Automating Animation with Math Presets

Math presets provide a quick and easy way to animate parameters 
mathematically—without having to do a shred of math yourself.

Math presets apply mathematical expressions to the selected parameter. This 
means that there is no fcurve for you to edit, but it’s easy to make changes to 
the entire animation by adjusting a few parameters on a property page. These 
parameters can also be keyframed, so that the effects of the preset can increase 
or decrease over time.

To apply math presets to a parameter:

1. Mark the parameter you want to animate.

2. In the tools and options panel, click the Animation Tools tab, then click 
one of these Math Presets buttons:

- The Constant Speed preset changes the value of the parameter at 
regular increments at each frame.

- The Sine preset oscillates between two values at regular intervals, 
easing into and out of each extreme. The resulting animation is 
characterized by a pulsing or swinging effect.

- The Jitter preset changes the parameter to a random value at 
regular intervals.

n Applying a math preset replaces any existing animation on the 
parameter—even another math preset.
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Editing Math Presets

When you first apply a preset, it applies default parameters to the expression. 
Changing or keyframing these parameters allows you to fine-tune the animation.

To edit a parameter’s math presets:

t Select the object and open its Animation Controls property editor in the 
multi-purpose editor.

Deleting Math Presets

To delete a parameter’s math presets:

t Do one of the following:

t Right-click the parameter’s animation button and choose Remove 
Animation from the context menu.

t If the parameter is marked, click the Remove Animation on Marked 
Parameter button in the Animation Tools panel.

Animating the Camera

You can animate a camera’s movement through space the same way as any 
other object—by marking its transformation parameters and keyframing them 
at specific points on the timeline, or by using constraints or math presets. 

You can also independently animate the camera’s interest using any of these 
methods, changing not only where there camera is, but also where it’s looking. 
By animating one or the other (or both) you can create dynamic scenes, such 
as a bird’s-eye view of flight through a cityscape or a vertigo-inducing roller 
coaster ride.

You can animate the camera or its interest in one of two ways:

• By looking at your scene through another camera or a spotlight, you can 
position the camera or its interest in relation to other objects in the scene 
and animate them using any of the methods mentioned above.
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• By looking through your camera, you can control exactly what the camera 
sees at a particular frame. You can control the camera’s view by using the 
orbit, dolly, zoom, and pan controls (see “Navigating in Viewports” on 
page 71) and animate according to what you see in the viewport. You can 
also animate spotlights this way.

n Regardless of which method you choose, it’s generally a good idea to make the 
camera and its interest visible by clicking the Toggle Show Cameras in 3D 
Views button in the Display Options panel. If you’re animating a spotlight 
through a viewport, click Toggle Show Lights in 3D Views.

Animating a Camera from a Viewport View

You can keyframe a camera or spotlight’s parameters while you are looking 
through it by using the Camera buttons in the Animation Tools panel. You 
must be looking through the camera or light in viewport B for the keyframing 
and selection options to take effect.

To animate a camera or spotlight through a viewport:

1. In viewport B, select the camera or spotlight you want to animate from the 
Views menu.

2. Go to the frame where you want to set a key.

3. Do any of the following to adjust the camera view:

t Move the camera interest using the translate tool or from its Local 
Transform property editor.

t Move the camera from its Local Transform property editor.

t Dolly, zoom, orbit, or pan the camera.

n To move the camera or its interest, you may need to select them using the 
Select Active Camera or Select Active Camera Interest button in the 
Animation Tools panel.

4. Set keys on the camera and interest’s positions, the camera’s position, or 
the camera’s roll and zoom parameters using the appropriate Camera 
button in the Animation Tools panel.

5. To create another key, repeat steps 2 through 4.
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Previewing Animation in a Flipbook

No matter how talented an animator is, it’s a rare day that one can get it 
exactly right the first time. Animation is usually a process of creation and 
repeated testing and tweaking until everything is just right. In Avid 3D, you 
can create a preview of your animation—a simplified version at a lower 
resolution or with less detail that renders quickly. You can then play your 
preview in the flipbook. Unlike animation played back using the playback 
controls, a flipbook always plays back at the defined frame rate, provided you 
have enough memory for the cached images.

You can export flipbooks in a variety of standard formats, such as AVI and 
QuickTime (see “Exporting a Flipbook” on page 339).
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Creating Your Preview Animation

To create a preview of your animation:

1. Click the Render Low-Quality button in the render and preview controls.

2. The Render Options dialog box opens. Render type and quality are already 
set; the other settings are based on the current global rendering options.

- You can further speed up rendering by creating a simplified version of 
your scene. In the Render Type tab, set the Render Type to 
Wireframe, Hidden-line removal, or Shaded to see the scene’s 
geometry’s shape, but in less detail.

- Turning off unnecessary effects greatly speeds up render time. In the 
Render Type tab, deselect any Mental Ray Effects you don’t need for 
your preview.

3. Set the file options in the Frames Output tab, then click OK.

See “Setting Global Rendering Options” on page 383 for more details on 
rendering options.

Loading Animation in the Flipbook

You can use the standalone flipbook to view cached images as a flipbook. 
The standalone flipbook is useful for viewing high-resolution images that 
use a lot of RAM.

To launch the flipbook:

1. Click the Launch Flipbook button in the render and preview controls.

2. In the Open Images dialog box that appears, specify the path and File 
name of the images you want to load—click the browser button (...) to 
open the browser.

n For more information on any of these options, refer to the Online Help by 
clicking the Help button in this dialog box.

You can also open this dialog box later by choosing File > Open Images or 
pressing Ctrl+O in the flipbook.

If you’re constantly making changes and testing the same image sequence, 
leave the flipbook open and press Ctrl+O and then Enter to reload the 
sequence. This way, all the settings in the dialog box stay the same.
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3. Select whether to load a complete Image/Movie file or just a specific 
range of frames of the Sequence, including the Step and playback Rate 
(NTSC, PAL, Film, etc.).

4. If you want to pad the numbers to allow you to match up image 
sequences, specify the number of frames in the Padding list. The default 
syntax is [fn].#[ext] where fn is the base file name, ext is the file 
format extension, and # is the frame number.

5. Set the Zoom Factors, if you like. The values for each of these must 
be integers:

- Shrink on load divides the image resolution by a value that you 
specify. For example, if you enter 2, the images are loaded at half the 
original resolution.

- Magnify on display multiplies the image resolution by a value that 
you specify. For example, if you enter 2, the images are loaded at 
twice the original resolution.

6. Set the memory and playback options:

- Keep images in memory caches the images in memory so that they 
can be played back in real time.

- Preload before playing loads the entire image sequence into memory 
instead of loading frames on demand.

- Select Real Time to play the image sequence in real time. For 
example, if you have a 1-second loop, it takes exactly 500 seconds to 
loop the sequence 500 times. When you select this option, the RT 
button is activated on the Playback panel below the timeline and you 
can see the frame rate displayed.

n If you have an Avid Mojo installed, you can view the flipbook animation on a 
monitor connected to the Mojo by selecting Digital Output (Avid Mojo) in the 
Open Images dialog box. See “Configuring Avid 3D to Output to an Avid 
Mojo” on page 70 for information on installing an Avid Mojo.

7. Click OK to load the image sequence and open the flipbook window.

The flipbook window is resized if the loaded image is larger than the 
current size.
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Setting Up the Flipbook View

In the flipbook window, you can set up how you want the images to appear 
using commands from its View menu:

• Display different RGB or alpha channels using the commands in the 
View > Channel menu. Press the R, G, B, A, and C (all channels) keys to 
display the respective channels.

• Set the zoom factors using the options in the View > Zoom menu.

• You can have non-square pixels appear correctly on the computer monitor, 
which has square pixels by choosing View > Correct Aspect Ratio. For 
example, NTSC images have a pixel ratio of 0.9, meaning the pixels are 
not square.

To set the flipbook’s background color:

• Choose View > Background Color to open the color property editor in 
which you can set the color.

To pan in the flipbook:

• Click+drag across the view area. This pans the image when it is bigger 
than the display area.
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Playing the Flipbook

After you’ve loaded the images and set up the flipbook, you can play back the 
images using the playback controls, as well as set up and adjust the playback rate. 

When you play back the flipbook, the current frame number is shown below 
the image, at the right edge of the window.

To set the playback rate:

t Choose Tools > Rate (NTSC, PAL, FILM, etc.) or press Ctrl+R.

You can also choose View > Play Real-time or press T to display the 
images in realtime.

To play the animation:

These controls are the same as in the playback controls in the main Avid 3D 
window, as described in “Using the Playback Controls” on page 273.

t Click the Play button on the flipbook’s playback controls or press the 
up-arrow key.

You can also move forward or backward frame by frame, go to the first or 
last frame, stop, and loop the playback (loop is automatically selected).

Playback controlsRange control Current frame number
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To adjust the playback rate:

You can adjust the playback rate by 1-fps (frame per second) increments 
within the range of 24 and 30 fps.

• Choose Tools > Increase Rate or press + (plus) on the number pad to 
increase one frame per second.

• Choose Tools > Decrease Rate or press - (minus) on the number pad to 
decrease one frame per second.

To play the animation in ping-pong style:

1. Choose View > Ping Pong or press P. This changes the directions of 
playback at the ends of a looped sequence. 

2. Click the Loop button in the flipbook’s playback controls.

3. Play the sequence: at the first and last frame, the sequence changes directions.

4. To stop the playback, press the space bar.

To go to a particular frame:

t Choose Tools > Go to Frame or press Ctrl+G.

To change the playback range:

t Use the range control below the timeline:

- Click+drag either end to change the start/end frames.

- Click+drag in its middle to slide the time range.

- Double-click in it to reset it back to the entire range.

To clear the flipbook window of the current cached images:

t Choose File > Clear Flipbook.

To close the flipbook window:

t Choose File > Exit or press Alt+F4.

Range control
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Exporting a Flipbook

You can export a flipbook using a number of file formats.

n Before you export a flipbook, make sure that you have enough room on the 
disk to where you’re exporting. A warning message will not be displayed if you 
run out of space.

To export a flipbook:

1. In the flipbook window, load the sequence you want to export.

2. Choose File > Export in the flipbook’s command bar or press Ctrl+E.

3. In the Export dialog box, specify the File name you want to export and 
also the Source Range of frames to export.

4. Select the File Type in which you want to export the file. The list on the 
left shows the possible export formats supported.

5. Set these optional parameters:

- If you have a specific compressor (coder-decoder) you want to use for 
movie files, click the Codec button.

- To export an accompanying Audio File with the images, click the (...) 
button to open the browser and search for the audio file.

- If you want to pad the numbers to allow you to match up image 
sequences, specify the number of frames in the Number Padding list. 
The default syntax is [fn].#[ext] where fn is the base file name, 
ext is the file format extension, and # is the frame number. 

6. In the Destination Frame Offset text box, specify the number of frames 
to add to the destination images. For example, you can offset the image 
sequence before using another tool.

7. Click OK.
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Chapter 11
Particles

Particles allow you to create many different types of particle-based effects, 
such as snow and rain, clouds and smoke, fire, or fairy dust. As well, you can 
attach images to particles (sprites) to create a host of other effects.
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Particles in Avid 3D

Avid 3D makes it easy to simulate all types of phenomena that can be based on 
particles, such as fireworks bursting in the night sky, or snowflakes falling 
gently over a meteorologist’s weather map.

Particles are affected by forces that you can apply to them. These forces 
include gravity, wind, a fan, and turbulence. As well, particles can interact 
with objects in the scene when you set them to be obstacles with which the 
particles collide and bounce off. 

What Makes Up a Particle System?

A particle system is an assembly of different parts that work together: the 
particle simulator, the emitter, the particle type, and the effects. Forces and 
obstacle objects also affect the particle simulation, but are not directly a part of 
the particle system’s structure. 
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• The particle simulator is the operator that generates the particles, as 
represented by the particle cloud. This operator controls how the particles 
evolve and are affected by forces and obstacles. You can have multiple 
particle clouds in a scene.

• The emitter is associated to a particle cloud, and is a combination of 
two things:

- The object from which the particles are emitted.

- The set of properties defining how the particles are emitted, such as 
their rate (density), speed, and spread angle.

• The particle type is associated with each emitter and particle cloud. 
Particles types are like the “recipes” or templates that describe what the 
set of particles looks like (mass, size, color, etc.). You can change a 
particle system’s particle type while keeping the same emitter object and 
emission properties.

• The particle effects define the rendered look of the particles, letting you 
determine the basic shape of the particles and set the color, shadows, or 
color burn, as well as other properties.

Particle cloudParticle emitter

Particle type defines the 
particles’ physical characteristics.

Render region previews the 
results of the particle effects for 
the final rendered look.
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Creating Particles

To create a particle simulation, you can either drag and drop a particle system 
preset from the library panel, or you can create your own particle system from 
an object you select to be the emitter. You can have any number of particle 
clouds in a scene.

When you create a particle cloud, you define the global characteristics of the 
particle simulation, which are generated by the particles operator. It generates 
and updates the particles for the cloud, considering the emitting object and its 
properties, forces, and obstacles.

To create particles from a preset:

1. Click the Object Library tab in the library panel and select Particles. 

2. Drag and drop a particle preset into any viewport. 

A particle cloud appears in the viewports, close to the global origin, and 
some particles are displayed coming from the emitter object. You can 
move the emitter object away from the particle cloud, but it is not 
recommended to move the particle cloud away from the global origin.

When you play the simulation (see “Playing Particle Simulations” on 
page 352), the particles are emitted. 

Particle cloud
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To create particles from scratch:

1. Select an object that will be the particle emitter.

You can use any type of object as an emitter, including an animated object.

2. Click the Create Particles on Selected Object button in the Particle 
Tools tab.

A particle cloud appears in the viewports, close to the global origin. When 
you play the simulation, the particles are emitted from the object you selected.

Editing the Particles

After you have created particles, you can edit their properties. For example, 
you could change the particles’ color, increase the number of particles being 
emitted, or change the length of the whole particle simulation, to name just a 
few things.

In the multi-purpose editor, you can see and edit the properties for all the parts 
of a particle system.

To open property editors for particles:

1. Select the particle cloud in a viewport and open the multi-purpose editor.

2. In the left tree pane, click the name of the particle element to open its 
property editor in the right pane. 
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Here, for example, GoldDust (the particle type) is selected and its 
property editor appears in the pane on the right side.

Geometry and Deform Properties

Click the Geometry and Deform Properties tab to see these property editors 
for the selected particles. 

• The cloud is the root for all the particle pieces. Click it to open the Cloud 
property editor in which you can give a name to the particle system.

• ParticlesOp is the particle simulator operator. Click it to open the 
ParticlesOp property editor that contains parameters about the length of 
the simulation (see “Setting the Length of the Particle Simulation” on 
page 353), as well as the percentage of particles being emitted (see 
“Setting the Number of Particles Emitted” on page 355).

• Emission (name of object_emission) is the particle emitter properties, 
which define how the particles are emitted. Click it to open the Emission 
property editor (see “Setting Up the Particle Emission” on page 354).

• PType is the particle type, which defines the look and physical 
characteristics of the particles. The particle type often has other names 
depending on the preset you have loaded, such as GoldDust, Snow, Rain, 
etc. Click this name to open the Particle Type property editor (see 
“Particle Types” on page 358). 
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• Gravity, Wind, Fan, and Turbulence are forces that can be attached to 
particle clouds (see “Applying Forces to Particles” on page 366).

• Obstacle (name of object_obstacle) is an object that has been defined as 
an obstacle with which the particles collide and bounce off (see “Creating 
Particle Collisions with Obstacles” on page 371).

Materials and Fx Properties

Click the Material and Fx tab to see the effects property editors for the 
selected particles. 

You can use different effects for the particles to define their look. For example, 
the Particle Billboard and Particle Shape effects are attached to most particles to 
define their rendered look. If you use a sprite image on particles, you can set its 
properties in the Particle Sprite property editor. As well, some particle presets 
use the Particle Gradient to set the rendered particle color with a gradient.

For more information, see “Changing the Look of Particles with Effects” on 
page 377.

Selecting Particles

You can select particles in two ways. When particles are selected, a white 
outline appears around them. 

To select particles, do one of the following:

t Click on the particles or the particle cloud in a viewport.

t Open the scene explorer and select Particle Clouds. Then click the 
appropriate cloud item on the tab below. This is useful if you have several 
particle clouds in the scene and it’s not clear which particles belong to 
which cloud.

Selected particles 
appear with a white 
outline around them.
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Deforming Particles

You can apply almost any of the standard deformation tools (such as lattices, 
cages, Push, Twist, or Taper) to particles. This is a powerful way of making 
complex particle systems, such as a whirling tornado of particles within a 
twisted and tapered lattice.

For information on how to use the deformations, see “Modifying Object 
Geometry” on page 139.

To deform a particle cloud:

1. Select the particles you want to deform.

2. Choose any of the deformations from the Deformation Tools panel in the 
Tools and Options panel.

Deleting Particles

Deleting a particle simulation removes the particles and their emitter object, 
but you must remove the emitter object separately if you created a particle 
system from scratch.

To delete particles:

t Select the particles or particle cloud in a viewport or from the scene 
explorer and press Delete.
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Viewing Particles in the Viewports

Creating particle simulations is a visual process that requires many ways of 
viewing. There are a number of display types in which you can visualize 
particles. As well, you can draw a render region over particles for which you 
want to see the rendered image. However, the Textured display type allows 
you to see a very close approximation of the rendered look.

n To see many of the particle shapes and the transparency better, make the 
viewport’s background black by clicking the Background Colors > Black 
button on the Display Options panel.

Selecting a Display Type

You can view particle simulations using any display type from the display type 
menu in a viewport (see “Display Types” on page 68). These are some of the 
most useful ones.

• In Wireframe display, the particles are shown as camera-oriented 
hexagonal outlines the size of the particle’s radius, and colored with the 
particle’s color at the appropriate frame. The playback of the particle 
simulation is very fast with Wireframe display.

• In Shaded or Constant display, the particles are shown as flat (constant) 
colored hexagons, the size of the particle’s radius, and colored with the 
particle’s color at the appropriate frame. The camera orientation for the 
particles is the same as for Wireframe display.
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• In Textured display, you can preview most particle options so that you 
don’t always need to draw a render region. The playback is slower for 
Textured display than for Wireframe or Shaded display because of the 
extra information.

The particles are displayed as alpha-blended bitmaps that use the color 
and alpha information defined for the particles. As well, you can see what 
sprites, images, and shapes will essentially look like in the final render. 
The particles are also properly integrated with scene objects in depth.

Previewing Particles in the Render Region

While the Textured display shows you the rendered look of the particles in 
many cases, the render region lets you preview exactly what the particles will 
look like in the final rendered image.

To create a render region:

t In a viewport, press Q and drag over the area of the particles you want 
to preview. 

Particles with Wireframe display. Particles with Shaded display. Particles with Textured display.
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You can resize the render region using the little blue boxes in its corners or on 
the sides and set the amount of aliasing by dragging the little slider on the right 
side of the region. 

Displaying and Hiding Particles

You can display or hide all particles in the viewports. When you hide particles, 
the simulation is muted which makes it faster to play the scene. This is useful 
if you want to keep the particles in the scene, but you’re not working on them 
at the moment.

To view or hide particles in a viewport:

t Toggle the Display Filters > Particles button in the Display Options 
panel. 

Press Q and drag to create a 
render region on the particles. 

Inside this region, you see 
what the particles will look like 
in the final rendered image. 

Drag the aliasing slider up to 
set the highest quality image.

Resize the region by dragging 
any of its little blue boxes. 
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Playing Particle Simulations

As with animations, you can play back a particle simulation in the same way. 
However, particle simulations are a little different because they always require 
the previous frame to know how they should be simulating. At the first frame 
of a simulation, no particles are emitted. One frame later, particles are emitted 
but not updated. One frame after that, the previously emitted particles are 
updated and new ones are emitted, and so on for the rest of the simulation.

This is done so that an animated particle emitter object is at the same frame as 
the particles it’s emitting. If particles were updated at the same frame they 
were emitted, the particles would be one frame ahead of the emitter.

For more information on the different playback options, see “Using the 
Playback Controls” on page 273.

To play and stop a simulation:

t To play the simulation, click the Play button in the playback panel below 
the timeline or press the space bar. 

- You cannot play the simulation backwards. 

- If you edit the particle properties while you’re playing the simulation, 
they are not recalculated until the simulation starts again at its first frame.

t To stop the simulation from playing, click the Play button or press the 
space bar again.

t To continue playing the simulation from the current frame (such as if 
you stopped at a frame in the middle of the simulation), middle-click the 
Play button.

t Click the Loop button in the playback panel to have the simulation play 
continuously.

To go to a particular frame in the simulation:

t Drag the playback cursor in the timeline to that frame number or enter it 
in the Current Frame box beside the playback controls. This must be a 
frame that is later in the simulation than the current frame.

The simulation is calculated up to that frame. You can click Cancel on the 
progress bar that appears to cancel its calculation.
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t To advance the simulation by single frames, click the Next Frame button. 
You cannot click the Previous Frame button to return to a previous frame 
of simulation.

n To increase the speed of the playback, mute any viewport that you’re not using 
by middle-clicking its letter identifier (A, B, C, or D). You can also hide the 
default grid in any viewport (press G) to increase the playback speed.

Setting the Length of the Particle Simulation

By default, a particle simulation length is 100 frames. However, you can easily 
change the length of the particle simulation using these parameters in the 
ParticlesOp property editor (see “Editing the Particles” on page 345). 

To match the simulation’s frames to the scene’s:

t Click the Copy From Scene button to copy the scene’s first and last frame 
defined for the timeline to the simulation. This is a quick way of having 
the simulation play for the whole length of the scene. 

To set the simulation’s length:

t Set the number of frames for the Duration. This is the total number of 
frames over which the particle simulation is played.

To offset the simulation’s starting frame:

t Enter the number of frames for the Offset. This is the amount by which 
you want to offset the start of the simulation. 

For example, if you want the particle simulation to start only after the 
animation has played 20 frames, set the Offset to 21. The particle 
simulation starts 20 frames after the first frame in the scene’s timeline, 
whatever that frame number is (frame 1, in this case).
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Setting Up the Particle Emission

Once you create a particle system, you can set up how the particles are 
emitted. Particle emission is composed of two things:

• The object from which the particles are emitted.

• The properties that define how the particles are emitted: their rate 
(amount), speed, origin, direction, and spread angle.

By default, particles are emitted from the emitter object which you can move 
to another location in the scene. However, if you move the particle cloud 
(which is not recommended), the emitted particles are offset with respect to 
their natural emission point.

Editing the Particle Emissions

Once you have created a particle cloud, you can edit the emission properties in 
the Emission property editor. The emission properties are automatically 
named based on the emitter object’s name.

To open the particle emission property editor:

1. Select the particle cloud and open the multi-purpose editor (see “Editing 
the Particles” on page 345).

2. Click the Geometry and Deform Properties tab and select the name with 
the _emission suffix.

3. Set the parameters in the Emission property editor, as described in this section.

Adding Variation to Emission Parameters

Many parameters on the Emission property editor have Var (Variance) 
parameters which allow you to add randomness to their associated parameter’s 
value. The Var parameters define the range in which the random numbers are 
generated. By adding variation to a parameter’s value, you have ultimate 
control over its specific effect.

Variance can also be animated (as indicated by their green animation buttons), 
allowing you to have different animations for the parameter’s variance and its 
value. For information on animating parameters, see “Keyframe Animation” 
on page 277.



Setting Up the Particle Emission

355

Setting the Number of Particles Emitted

The Rate parameter in the Emission property editor is the amount (density) of 
particles being emitted per second. The higher the value, the greater the 
number of particles being emitted.

You can choose to display only a percentage of this rate by setting the 
Particle% value in the ParticlesOp property editor.

You can set the Particle% to a low value for faster playback while editing, 
then to the full amount you want when you’re ready to view the final state of 
the simulation. You can also overshoot the values for Particle % by entering a 
higher value, such as 200% to double the number of particles emitted.

Particles emitted at 
5 per second.

Particles emitted at 
100 per second.
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Particle Speed

Set these two parameters in the Emission property editor to control the 
particle speed:

Speed defines the speed of the particle emission in distance units per second.

Inherit is the percentage of velocity that the particles inherit from an animated 
emitter object at emission time. 

Origin and Direction of Particle Emission

You can determine how the particles are emitted from the emitter object in 
terms of their origin of emission and their direction by setting these 
parameters in the Emission property editor.

Generation sets the point of origin from where the particles are emitted 
according to different geometry components of the emitter object. 
For information on geometry components, see “Basic Scene Elements” on 
page 100.

Particles emitted at 
1 unit per second.

Particles emitted at 
10 units per second.
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The following images show the different generation possibilities:

Direction sets the direction of particles emitted from the emitter object. 
Emission direction can be relative to the emitter object’s Local or Global 
reference or relative to the direction of the emitter object’s Normals.

Point: Particles originate from points on 
the emitter object.

Line: Particles originate from the edges 
of the emitter object.

Surface: Particles originate from the 
surface (flat areas) of the emitter object.

Volume: Particles originate from within 
the volumetric boundaries of the 
emitter object.
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Particle Spread

The Spread parameter in the Emission property editor is the diameter of the 
aperture through which the particles are emitted from the emitter object, with a 
range of 0 to 180 degrees. 

The angle value you enter is calculated from the point of emission and 
includes only “one side” of the emission. However, the result is double the 
angle value to include both sides of the emission. 

For example, if you specify a value of 15 degrees, the particles are actually 
spread over a total angle area of 30 degrees. 

Particle Types

In addition to the particle emission properties (see previous section), you can 
also edit the physical characteristics of particles. These characteristics are 
collectively referred to as the particle type.

Particle types are like the “recipes” or templates that describe what each group 
of particles looks like. They define the particles’ physical characteristics such 
as their mass, size, and life span, as well as their color and noise.

15o
Spread is set to 15o. The 
result is a total emission 
spread of 30o.
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You can apply any particle type to any emitter object in any scene, one at a 
time. As well, you can have any number of emitters in a scene that use the 
same particle type. 

Editing the Particle Type

Once you have created a particle cloud, you can open the Particle Type 
property editor to edit the particles.

To set up the particle type properties:

1. Select the particle cloud and open the multi-purpose editor (see “Editing 
the Particles” on page 345).

2. Click the Geometry and Deform Properties tab and select the particle 
type. Depending on which particle type is being used for the simulation, 
it can have different names such as PType, Snowflake, Gold Dust, or Rain, 
for example.

3. Set the parameters in the Particle Type property editor, as described in 
this section.

Adding Variation to Particle Type Parameters

Many parameters in the Particle Type property editor have Var (Variance) 
parameters which allow you to add randomness to their associated parameter’s 
value. The Var parameters define the range in which the random numbers are 
generated. By adding variation to a parameter’s value, you have ultimate 
control over its specific effect. 

The Color parameters also have additional variance parameters that let you 
add randomness to the individual Hue, Luminance, Saturation, and Alpha 
parameters separately—see “Setting a Particle’s Color” on page 361.

Variance can also be animated (as indicated by their green animation buttons), 
allowing you to have different animations for the parameter’s variance and its 
value. For information on animating parameters, see “Keyframe Animation” 
on page 277.



Chapter 11 Particles

360

Changing Particle Types

When you change the particle type, the new particle type takes on the existing 
simulation and emission properties that have been defined for the particle 
cloud and its emitter. For example, if the particle emission Rate for the 
existing particles is 200, the new particles for the particle type are emitted at 
this same rate.

To select a new particle type:

1. Click the Material and Fx Library tab in the library panel and select Particles. 

2. Drag and drop a particle type from the Particles tab onto existing particles 
in a viewport.

This automatically associates the new particle type to this particle cloud 
and its emitter. The particle type inherits the particle cloud’s simulation 
and emission properties.

Setting the Particle’s Lifetime

You alone have the power to decide how long a particle lives by using these 
parameters in the Life section in the Particle Type property editor:

• Max Life controls the maximum length of time (in seconds) that the 
particle exists once it is emitted.
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• Live Forever makes the particles live for such a long time that it seems like 
forever (69,999 frames, to be exact). This option is useful when you want to 
have the particles always available as you’re tweaking their parameters.

Setting the Particle’s Mass and Size

Set these two parameters in the Particle Type property editor to control the 
particle size and mass:

• Size controls the size of the particle when it is born, in distance units. The 
farther away a particle appears in the viewing area, the smaller it appears 
when it is rendered. 

• Mass specifies the mass of particles, which determines how swiftly they 
react to forces applied to them. The more massive a particle, the more 
difficult it is to change its motion. Therefore, to make a change in a 
particle’s motion, you need to apply stronger forces to a particle with 
more mass than to particle with less mass.

Gravity, however, is a little different from the other forces. Gravity is a 
force directly proportional to the particle mass. The more massive the 
particle, the stronger the gravity force applied to it. As a result, several 
particles of different masses will all have the same motion if the only 
force acting upon them is gravity.

Setting a Particle’s Color

The particle color that you see in the viewport is defined using the Color 
parameters in the Particle Type property editor. However, you can override this 
color with the color of a sprite image (see “Attaching Sprites and Images to 
Particles” on page 374) or you can set the color for the rendered particles 
using the Particle Billboard (see “Changing the Look of Particles with Effects” 
on page 377).

You can change the particles’ color including using color variance or animated 
colors by using the Color parameters and controls.

To set the color for particles:

t Drag the arrows in the Color sliders in the Particle Type property editor. If 
you press Ctrl as you drag one arrow, you can drag all three arrows at once.
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You can also click the color model button to switch between RGB, HLS, 
or HSV color models. See “Defining Color Properties” on page 92 for 
more information about using all the color controls.

Animating the Color Parameters

You can add realism to your particle simulation by animating particle color 
values. Particle values can change as a function of their own lifetime or as a 
function of the lifetime of the particle simulation itself. This lets you create 
effects such as making particles change color as they age.

For any of the animation controls to have effect, you must first animate the 
parameter (that is, you must first key its values to create a function curve). The 
different animation reference control modes only define how to interpret that 
function curve. For information on animating parameters, see “Keyframe 
Animation” on page 277.

The Animation Reference control modes let you specify how the RGB and 
Alpha values can be animated: Birth, Age, Age %, or Absolute.

• In Birth mode, the value of the parameter’s function curve at birth time is 
kept constant over its lifetime (Max Life value).

For example, particles retain whatever color is defined at time of their 
birth and stay that color until they die. Using this method, you could layer 
different colors by setting different lifetimes for each colored particle.

Click the model button to 
change color models 
(RGB, HLS, or HSV).

Drag the arrows in the 
sliders to change the color 
values. Press Ctrl while 
dragging to move them all 
at the same time.

Click the color box to 
open the color editor 
and select a color there.

Select an animation mode 
for animated RGB and 
Alpha parameters—see the 
following section.

Add variance to the HLS 
color and Alpha 
parameters—see “Adding 
Color Variance” on 
page 364.
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• Abs(olute) is the same as Birth mode, but instead of keeping the value 
parameter constant, it evolves according to its function curve over the 
particle’s lifetime (Max Life value). This means that all particles get the 
same value over time, regardless of their age.

All of the particles change at the same time, no matter where they are in 
their lifetime. Think of filming some smoke with a regular lens on your 
camera, then adding a blue lens filter: all the smoke particles change color 
at the same time.

• In Age mode, when the particle is born, the value of the parameter that 
corresponds to the function curve at the start frame of the simulation is 
used. Then the associated value evolves according to its function curve 
over the particle’s lifetime (Max Life value).

Transitions that you key happen at the frame you key them and continue to 
change throughout the lifetime of the particle. It happens based on the 
particles’ individual ages and occurs separately for all of them.

Also, Age lets you have transitions that do not happen if the frame they 
are keyed at does not fall within the particle’s lifetime. For example, if you 
key a transition at frame 50 but the particle dies at frame 35, you would 
have to increase the lifetime or move the key to be within the lifetime to 
see that transition.

• Age % uses function curve values defined by the particle type Color’s 
RGB and/or Alpha controls to map a shift range between 0 and 100% (a 
percentage of the particle’s lifetime). This creates a color shift effect over 
a particle’s lifetime (Max Life) that corresponds to the values defined by 
the keys. It refers to the percentage of the particle’s age as opposed to a 
particular keyframe, as Age does. For example, a particle could be born 
with the color red and die with the color blue. 

When you use Age %, keying the color over 100 frames gives you more 
predictable results because each frame represents a percentage point (one 
percentage point for every 10 frames). Then, for example, if you want the 
particle to change color halfway through its lifetime, you would key it at 
frame 50.

n If you want to use Age % as the animation reference mode, always key the 
color parameter’s values in another animation mode and then switch to Age % 
when you’re done.
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Adding Color Variance

The Color - Variance parameters allow you to add variance to the H (hue), L 
(luminance), S (saturation), and Alpha parameters’ values. The values for 
parameters define the range in which the random numbers are generated.

The distribution method of the variance can be Uniform or Gaussian: 

• With Uniform, random numbers are distributed uniformly around the 
parameter’s value using the Variance value. The parameter will always be 
in the range [ Value - Variance; Value + Variance ], never outside of it.

• With Gaussian, random numbers are distributed as a bell curve around the 
parameter's value using the Variance value. Most numbers will be in the 
range [ Value - Variance; Value + Variance ], but they may be outside of 
that range with [Value - Variance], and they will be outside of that range 
with [Value + Variance]. Values using Gaussian distribution will have 
greater variations than the ones using a Uniform distribution.

If you have the same value for both the parameter itself and the Variance 
parameter, different numbers result depending on the type of distribution you 
select. Numbers using Gaussian distribution will have greater variations than 
the ones using a Uniform distribution.

Original particle color for gold dust. Variance - Hue value set to 1 using the 
Gaussian distribution method.
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The seed parameter (the text box with no label to the right of the 
Uniform/Gaussian parameter) allows you to change the effect on the variance 
without changing either the parameter's value or its Var value. The seed 
defines which numbers will be generated in the range that the Var parameter 
specifies. It allows you to have very fine control over the parameters, changing 
them slightly without having to change the parameter’s value or its Var value.

The Seed parameter works only if you have a value other than zero for the 
Variance parameter to which it is associated.

Adding Noise to Particles

You can apply noise to each particle type to make random variations in the 
particles’ spacing and movements. Noise is also known as jitter.

The simplest way to think of noise is as a “random walk”. Instead of having a 
totally random value at each frame, you offset the previous value by a random 
step amount. In the case of particles, this is a random 3D vector direction and 
scale. This offset is applied to whichever Noise Intensity parameter you 
specify: Position, Velocity, or Acceleration.



Chapter 11 Particles

366

To add noise to particles:

t Set the following Noise Intensity parameters in the Particle Type 
property editor:

- Position: amount of noise to be added to particles’ position (in 
distance units).

- Velocity: amount of noise to be added to particles’ velocity (in 
[spatial units]/[time units])

- Acceleration: amount of noise to be added to particles’ acceleration 
(in [spatial units]/[time units]^2)

You can animate the Noise Intensity parameters using the standard particle 
type animation controls: Birth, Absolute, and Age (see “Animating the Color 
Parameters” on page 362).

Applying Forces to Particles

You can add realism to a particle simulation by having its movement affected 
by forces. There are four types of forces you can apply to particles: gravity, 
wind, fan, and turbulence. Each force is represented in the scene by its own 
control object, which you can select, transform, rotate, and scale like any other 
object in an Avid 3D scene. 

For example, you can animate the rotation of a fan, or you can defy the laws of 
physics by inverting the gravity control object’s direction so that it’s pointing 
up. Scaling a force’s control object changes its strength (the Amplitude 
parameter’s value) accordingly.

Each particle cloud can have multiple forces applied to it. As well, you can 
have the same force applied to a number of particle clouds in a scene. 

Types of Forces

There are four types of forces you can apply to particles: gravity, wind, fan, 
and turbulence.
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Gravity

Gravity is the most common type of force that you will use, for obvious 
reasons. It simulates the effect of a gravitational force. By default, its 
amplitude (strength) is set to simulate earth’s gravity (98.1), but you can set it 
to anything you like, including a negative value.

The default value of 98.1 is set as such to simulate particles properly when 1 
distance unit equals 10 cm. Depending on the scale of your scene, you may 
need to adjust this value to get particles falling as they should.

Wind

The wind force controls the effect of wind blowing on the particles. You can 
control the wind’s amplitude, which is the strength of the force.

Gravity control object

Wind control object
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Fan

The fan creates a “local” effect of wind blowing through a cylinder so that all 
particles inside the cylinder are affected. The fan’s wind direction follows the 
cylinder’s axis.

You can control the fan’s amplitude, which is the strength of the force. To 
control the fan’s area of influence, you can adjust the size of the radius and 
drop length of its cylinder.

Turbulence

The turbulence force builds a wind field to let you imitate real-life turbulence 
effects, such as the violent gusts of air that occur when an airplane lands. 
Turbulence is a complex force that is made up of a number of parts. A wind 
field is created by superimposing a small scale random field over a large scale 
deterministic field. Intensity is then applied to the whole wind field.

You can set the amplitude (strength) of the turbulence using either positive or 
negative values. This value acts as a constant multiplicative factor that is 
applied to the whole wind field (small and large scale fields combined).

Fan control object
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The eddies (small scale field) within the turbulence force are responsible for 
how “gusty” or turbulent the effect on the particles will be. 

Creating a Natural Force

You can create natural forces using the Force commands on the Particle Tools 
panel. You can apply any number of forces to a particle cloud. As well, you 
can have the same force applied to any number of particle clouds in a scene.

To create and apply a force to a selected particle cloud:

1. Select one or more particle clouds to which you want to apply a force. 

2. Click one of the Forces buttons in the Particle Tools panel: gravity, wind, 
fan, or turbulence. 

The corresponding force control object appears at the origin in the 
viewports and is automatically applied to the selected particle clouds.

Turbulence control object

Gravity

Turbulence

Fan

Wind
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3. You can open the force’s property editor to edit its settings. To do this, 
select the particles to which the force is associated and open the multi-
purpose editor (see “Editing the Particles” on page 345). 

In the Multi-purpose Editor, click the Geometry and Deform Properties 
tab and select the appropriate force: Gravity, Wind, Fan, or Turbulence.

To apply an existing force to a particle cloud:

If there is already a force in the scene, you can apply it to other particle clouds 
in your scene.

1. Select one or more particle clouds to which you want to apply the force. 

2. Click the Environment > Apply Force button in Particle Tools panel. 

3. In a viewport, pick the force object you want to apply to the particle 
clouds, then right-click to end your selection.

Displaying and Hiding Force Control Objects

You can display or hide all force control objects in the viewports. This is 
useful if you want to keep the forces in the scene, but you don’t need to see 
them. Although the forces are hidden, they still have an effect on the particles.

To view or hide force control object in a viewport:

t Toggle the Display Filters > Control Object and Rig Handles button in 
Display Options panel. 
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Muting Forces

When you mute a force, you temporarily deactivate it so that it’s not calculated 
as part of the particle simulation. Muting forces is useful to do if, for example, 
you have multiple forces in a scene and you want to test and tweak the results 
of each force individually. 

To mute a force:

t Select the Mute option in a force’s property editor (see “Editing the 
Particles” on page 345). 

t You can animate the Mute option to do such things as having a wind 
suddenly blow, then disappear.

Creating Particle Collisions with Obstacles

You can define any number of standard Avid 3D geometric objects in your 
scene to act as obstacles that block the path or collide with particles. Particles 
bounce off any obstacle that gets in their way.

Particles colliding and 
bouncing off an object set 
as their obstacle.
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Setting Up Obstacles

To select objects as obstacles and set up a collision:

1. Select the particle clouds that you want to have collide with the obstacles. 

2. Click the Particle Tools tab in the Tools and Options panel and then click 
the Environment > Apply Obstacle button.

3. Pick one or more objects in the viewport that will act as obstacles for the 
particles. Right-click to end the picking session. 

4. Set the general and physical parameters in the Obstacle property editor to 
set up the obstacle and control the collision’s behavior. To do this, select 
the particles that are colliding with the obstacle and open the multi-
purpose editor (see “Editing the Particles” on page 345). 

In the multi-purpose editor, click the Geometry and Deform Properties tab 
and select the appropriate item with the _obstacle suffix. 

When you play the simulation, the particles collide with the obstacle. 

Setting the Obstacle’s Collision Geometry

The General parameters in the Obstacle property editor let you set the 
obstacle’s collision geometry. You can determine the geometry used during 
collisions, regardless of the obstacle object’s actual geometry.

• Obstacle Type can be a bounding box, plane, or sphere, or the actual 
shape of the obstacle’s geometry. 

If you are using primitive shapes like spheres, grids, and boxes (or 
geometries with close enough approximations to these shapes), use the 
bounding shapes for obstacles rather than the actual shape. This can save a 
lot of calculation time.
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• Animatable Deformation correctly detects collisions when the obstacle 
is animated by deformations (see “Modifying Object Geometry” on 
page 139). It is only needed if the geometry is deforming over time: it is 
not required for transformations (scale, rotate, translate).

You should keep this option off unless you really need it because it can 
use a lot of memory.

• Double-Faced Collision detects collisions for both faces of a two-sided 
object, such as a flag or the inside and outside of a container. Keep this 
option off unless you really need it because it consumes a lot of memory. 

Setting the Collision’s Physical Behavior

The Physical parameters in the Obstacle property editor let you set the 
obstacle’s properties to determine the particles’ reaction to it. 

• Set the Friction to a high value if you want the particles to stick to the 
obstacle. A low value causes the particles to slide off the obstacle with 
little resistance. 

• Set the Elasticity to a high value if you want the particles to bounce off 
the obstacle with great vigor. You can enter values higher than is shown by 
the slider.

• The Push Length is the offset between the obstacle’s surface and its 
collision point. This creates an invisible buffer between the obstacle and 
the particles.

• The Tolerance value is the degree of accuracy set for all the physical 
parameters. The higher the value, the more accurate the collision but the 
more time it takes to calculate.

Muting Obstacles

When you mute an obstacle, you temporarily deactivate it so that it’s not 
calculated as part of the particle simulation. Muting obstacles is useful to do if, 
for example, you have multiple obstacles in a scene and you want to test and 
tweak the results of each obstacle individually. You can also animate the Mute 
option to have it active or inactive at different frames.

To mute an obstacle:

t Select the Mute option in the obstacle object’s Obstacle property page. 
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Attaching Sprites and Images to Particles

When you use sprites, you can use any textured image file or animated sequence 
and apply it to the particle type so that the particles look like that image. You can 
use any of the sample sprite images from the Still Images Library, as well as any 
other of the items in the Flat Pictures section of this library.

To attach a sprite image or sequence for the particle shape:

1. Click the Still Images tab in the Library panel and select Sprites or any of 
the other Flat Pictures options.

2. Drag and drop a sprite image from the tab below onto the particles in a 
viewport. The new sprite appears on the particles.

Original particle simulation with a 
snowflake sprite attached to the particles.

Bubble sprite is dropped onto the 
particles to replace the snowflake sprite.
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3. Edit the sprite’s properties. To do this, select the particles and open the 
multi-purpose editor (see “Editing the Particles” on page 345). Click the 
Material and Fx tab and select Particle Sprite.

Setting the Sprite’s Output Color

You can set the sprite’s color and alpha using the Output Color parameters in 
the Particle Sprite property editor.

To set the sprite color:

t Select From Sprite to use the color from the sprite image you have 
attached to the particle type. 

t If you deselect this option, the color is taken from either particle type’s 
color itself or the Billboard.

To modulate the particle’s alpha values:

t Select one of the Alpha Modulation options to multiply the particle 
color’s alpha channel by the sprite’s alpha channel or RGB intensity, or 
nothing at all. 

t Select Inverted to invert the alpha calculated from the sprite before 
multiplying with the incoming alpha. For example, if the sprite appears 
with a border around it, toggling this option usually gets rid of it.

Original bubble sprite image

Color taken from the sprite image. Color taken from the particle type.
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Setting Up Sprite Image Sequences

If you have attached a sprite image sequence (not just a single image), you can 
decide how it is used during the simulation using these parameters in the 
Sprite property editor.

To set up the sprite sequence:

t Set the Start Sequence (%) value, which is the percentage value where in 
the sprite sequence you want to evaluate the frame. It uses the value 0 to 
mean the beginning of the sequence and 1 to mean the end of the sequence. 

t Select or deselect Looping to determine how the Start Sequence % values 
are marked:

- With Looping on, the fractional value of Start Sequence % indicates 
the frame. This means that if, for example, you animate the value to 
go from 0 to 5 over 100 frames, you will see the sprite animation 
looped five times over those 100 frames. 

A whole number (integer value) always marks the first frame, and the 
last frame is the number just before the next whole number.

- With Looping off, values less than or equal to 0 mark the first frame, 
and values equal to or greater than 1 mark the last frame. 

This means that any values outside the range are clipped to the 
start/end point for less than 0 and greater than 1 respectively.

Alpha is inverted for this sprite image. Toggling the Inverted option inverts the 
alpha value and the border disappears.
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Changing the Look of Particles with Effects

In many basic ways, rendering particles is similar to rendering any other object 
in Avid 3D. You can use all standard lighting techniques and set shadows. 
Unlike other objects in Avid 3D, however, there are special effects designed 
specifically for particles that let you make them look the way you want in the 
rendered output. These effects let you change the shape of the particle, set the 
color, edit a sprite image attached to the particle, and many other options.

Editing the Particle Effects

To open the effect property editors:

1. Select the particles and open the multi-purpose editor (see “Editing the 
Particles” on page 345). 

2. Click the Material and Fx tab and select Particle Billboard. 

Depending on the particle system you have set up, you may also see these 
effects on the same tab: Particle Shape, Particle Sprite (see “Attaching 
Sprites and Images to Particles” on page 374), or Particle Gradient.

For more details on each of the parameters available for each of these effects, 
refer to the Online Help (Help > Avid 3D Help) for Properties.

Particle Billboard

Particle Billboard provides a surface for making the particles look as you 
want, such as by using a sprite image or using a shape with the Particle Shape. 

When you create a particle cloud from scratch (see “Creating Particles” on 
page 344), the Particle Billboard is attached to the particle type, along with the 
Particle Shape. 

You can set the ambient and specular color, using either the existing particle 
color defined by the particle type or by overriding that with a color set here. 
You can also add color burn (additivity) to create specific glow or 
overexposure effects, or have the particles be self-shadowing. 



Chapter 11 Particles

378

If you have a shape defined for the particles using Particle Shape, this shape 
overrides the shape set in the Particle Billboard property editor. For example, 
the smoke shown below uses the Turbulence shape type using Particle Shape 
that is attached to the Particle Billboard. 

Particle Shape

When you’re defining the look of a particle type, setting its shape plays a 
significant role. The Particle Shape shader provides a variety of 2D shapes 
from which you can choose, including setting the shape’s position within the 
particle radius and setting its transparency falloff.

By default, the Particle Shape is attached to the Billboard when you create a 
particle cloud: the Particle Billboard creates the 2D surface while the Particle 
Shape provides the actual shape definition and look.

Smoke created by using 
the Turbulence shape.

Color burn created on this 
chemical concoction.



Changing the Look of Particles with Effects

379

In the Particle Shape property editor, you can choose from these shape types 
on the Shape page. As well, you can customize each shape type with its 
corresponding parameters.

Particle Gradient

The Particle Gradient effect is available only with a few particle presets (such 
as the Fire Ring and Fire in the Object Library) and the Shards particle type (in 
the Material and Fx Library). 

This effect lets you create a gradient (color ramp) that colors the particle 
according to its Age % (see “Animating the Color Parameters” on page 362). 
For example, this gradient slider in the Particle Gradient property editor shows 
how a flame’s colors will look over the lifetime of the particle, starting off 
blue, changing to yellow and orange, and then finishing off black:

Beam shape Star shape Noise shape

Sine shape Turbulence shape Fractal shape
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Rendering the Final Output

So it’s come to this. You’ve created your scene, animated your objects, added 
textures and lights, and positioned your camera. Now the culmination of all 
your work is at hand: you’re ready to render your work in all its animated glory.

Avid 3D uses the mental ray® renderer to create high-quality images. mental 
ray uses a process called raytracing to generate images. Raytracing calculates 
the light rays that are reflected, refracted, and obstructed by surfaces. 
Raytracing produces realistic and precise results, but it can be 
time–consuming.

In raytracing, each refraction or reflection of a light ray creates a new branch 
of that ray when it bounces off a solid object and is cast in another direction. If 
you have a scene containing reflections, refraction, transparency, or shadows, 
it will take a fairly long time to render; however, mental ray lets you render 
only the effects you want. For example, if you want to render without the 
reflections, you can deselect them.

Previewing a Single Frame

You can preview the current frame at fully rendered quality in a floating 
window. Unlike the render region, the frame is rendered with all of the defined 
global rendering options.

To preview a single frame:

t Click the Preview Render button in the render and preview controls.

Saving a Frame Preview

If you want to capture the contents of the preview render for later use, you can 
save the contents of the preview window as a still image.

To save the previewed frame:

1. Click the Preview Render button in the render and preview controls.

2. From the preview window, click the Save As... button. 

3. Using the browser that opens, select a directory, format and file name for 
your image.
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Rendering Your Scene

To render your scene:

1. Click the Render Low-Quality or Render High-Quality button in the 
render and preview controls.

2. The Render Options dialog box opens. Render type and quality are 
already set depending on the quality level you have selected; the other 
settings are based on the global rendering options.

n To view the sequence on an Avid Mojo when rendering is complete, check the 
Playback sequence after render option on the Frame Output tab.

For details on how to change the render options, see “Global Rendering 
Options” on page 383.

3. Click OK to start the render.

Global Rendering Options

Global rendering options apply to your final render and, to a lesser extent, to 
the render region. They include settings such as the rendered file name, format 
and frames, effects (such as motion blur, glows, and lens flares), and AAF and 
MXF output options. You can also toggle the rendering of certain effects.

Setting Global Rendering Options

To set rendering options:

t Click the Inspect Render Options button in the render and preview 
controls to open the Render Options property editor.

The following sections describe how to balance render quality and render time 
and get the look you want. For a complete description of every option in the 
Render Options property editor, refer to the Online Help.
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Setting Output File Parameters

Output file parameters specify the name of the output file, the range of frames 
to render, and the output files’ image format. Set these options from the 
Frames Output tab of the Render Options property editor.

To specify an output file:

1. Click the Render Options button in the render and preview controls to 
open the Render Options property editor

2. Click the Frames Output tab and in the Image Filename text box, type 
an absolute or relative path and file name for the output image. 

You can also click the browser button (...) to specify a file name and 
directory from a browser. The rendered images’ file name format is 
determined by the Frame Padding options, while the extension is 
determined by the selected File Format. See the next steps for more 
information on these options.

n If you are using frame padding, or have specified a file name that contains 
multiple periods (“.”), you must add a valid file extension (.pic, .tga, and so 
on) to the file name.

3. Choose a Frame Padding option from the list. This controls the format 
and placement of frame numbering in the file names of rendered frames. 
The following options are available:

This option Yields this result

(filename).#.(extension) foo.1.pic

(filename).##.(extension) foo.01.pic

(filename).###.(extension) foo.001.pic

(filename ####.(extension) foo.0001.pic

(filename)#.(extension) foo1.tga

(filename)##.(extension) foo01.tga

(filename)###.(extension) foo001.tga

(filename)####.(extension) foo0001.tga
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4. Set the Start value to the first frame you want to render and the End value 
to the last frame you want to render.

5. Set Step to the desired increment between rendered frames. This is useful 
for rendering a quick test. For example, if you set the Step to 2, every 
other frame is rendered. The default value of 1 renders every frame 
between the Start and End frames.

n You can use the Skip Rendered Frames option to skip over images that are 
already rendered in the directory.

6. Select a format for the image files from the Image Format list. The 
default is the PIC format.

The following is a list of the formats supported by Avid 3D:

Specifying the Format Options

The Format options in the Render Options property editor specify the picture 
standard and image resolution of the output image. You can select a standard 
picture format or specify your own custom format. Using custom formats, you 
can compensate for non-square pixels on the final viewing equipment.

To define the format:

1. Click the Inspect Render Options button in the render and preview 
controls to open the Render Options property editor.

2. Click the Format tab, then click the arrow button to the right of the 
Format text box to select the picture standard to which you want to output 
your render. The default is the NTSC D1 standard.

• .pic (Softimage) • .rla (Wavefront)

• .bmp (Microsoft Bitmap) • .jpg (Jpeg with maximum quality)

• .tif (TIFF) • .yuv (Quantel)

• .tga (TARGA) • .ct (Mental Images)

• .sgi (SGI) • .map (Memory Mapped Texture)

• .als (Alias)
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3. The Picture Ratio for the frame format cannot be edited unless you select 
Custom from the Format list. Editing this value changes the X and Y 
resolution of your output image(s).

To render with a custom resolution and aspect ratio:

1. Click the Render Options button in the render and preview controls to 
open the Render Options property editor

2. Click the Format tab and select Custom from the Format list.

3. Define the following resolution values:

- In the Image Resolution X text box, specify the width of the image in 
pixels or use the slider to set a value.

- In the Image Resolution Y text box, specify the height of the image 
in pixels or use the slider to specify a value.

n When you change the Picture Ratio setting, the Y value scales automatically 
to maintain a proportional picture ratio.

Activating Effects

When rendering, you can deactivate any effects that you do not require. This is 
especially useful for preview renders: the fewer effects that need to be 
computed, the faster the scene will render.

Setting Motion Blur Options

From the Render Type tab of the Render Options property editor, you can 
define whether or not the output image renders motion blur with the Motion 
Blur option. The Amount value provides the camera’s shutter speed, which 
controls the amount of motion blur.

• Longer (slow) shutter speeds (an Amount greater than 0.6) create a wider 
and/or longer motion blur effect, simulating a faster speed.

• Shorter (quicker) shutter speeds (an Amount of less than 0.3) create 
subtler motion blurs.

• Shutter speeds higher than 1 produce intense motion blurs, but may cause 
artifacts to appear in a rendered image.

n If you're using motion blur with particles, the Amount must be less than 1.
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Of course, all shutter speeds are relative to the speed at which the blurred object 
is animated. Objects that move from one end of a scene to another in a few 
frames produce a large amount of motion blur, regardless of the shutter speed.

Setting Effect and Map Options

You can deactivate camera effects, light effects, displacement maps, and 
environment maps to allow for faster preview rendering.

To set effects options:

1. Click the Inspect Render Options button in the render and preview 
controls to open the Render Options property editor

2. Click the Render Type tab. You can enable or disable:

- Displacement maps

- Camera effects

- Volume lighting effects

- Glows and lens flares

- Environment maps

For more information on effects and how to use them, see “Lights and 
Cameras” on page 203 and “Using Textures as Maps” on page 254.

Exporting AAF and MXF Files

The options on the Create Movie tab of the Render Options property editor 
allow you to create MXF files, and an AAF master clip that describes them, 
out of your rendered sequences. You can also create .AVI and QuickTime files.

In the first image (left), a quick shutter speed (< 0.1) is used, then a slower 
shutter speed (middle), and finally (right) a very slow shutter speed (> 0.6).
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About MXF Media Files and the AAF Master Clip

MXF (Material Exchange Format) is an industry-standard container format 
that encapsulates media and production metadata into a single file. MXF is 
supported as a common file format in a wide variety of applications such as 
Avid Xpress™ Pro, Media Composer®, Avid DS Nitris™, and Avid 3D. MXF 
files replace OMFI media files.

MXF media files are video files, similar to AVI or QuickTime movies, and can 
be used on their own. However, they are not directly seen by users but instead 
are referenced by master clips and managed by an editing application, like 
Avid Xpress Pro or Media Composer.

AAF (Advanced Authoring Format) is a cross-platform, multimedia file 
format that allows interchange of composition information between AAF-
compliant applications. AAF replaces OMFI compositions.

The purpose of the AAF file is to present the media files as a higher-level 
named clip for the destination application.

AAF Naming, Location and Auto-Import

You can create the AAF master clip in any location and import it into Avid 
editing applications.

In Avid Xpress Pro and Media Composer, if the current Avid project has a bin 
named “Avid3D InComing”, the application automatically imports AAF files 
found in a special directory named Avid3D OutGoing, either on startup or 
when switching between applications.

The Avid3D OutGoing directory must be located in the root of a local drive. 
By default, Avid 3D creates AAF files in the D:\Avid3D OutGoing directory, 
and will create the directory automatically if it doesn’t exist.

Both the bin name and the directory name must have proper spacing and 
capitalization for AAF Auto-Import to work correctly. Please verify your 
editing application’s documentation for AAF Auto-Import support.

n Auto-Import of AAF files is not supported in older versions of Avid Xpress Pro 
and Media Composer.
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MXF Naming and Location

Media files are usually put on a high performance hard disk for real-time 
playback in the destination editing application. Avid 3D always creates the 
MXF media files in the \Avid MediaFiles\VideoStorage\Avid3D folder on 
the selected media drive. If the directory doesn’t exist, Avid 3D creates it 
automatically.

The absolute path to the MXF Media Files is stored inside the AAF Master 
Clip. If the MXF files are produced on a different machine and moved onto the 
machine on which the Avid editing application is installed, they must be 
available from the same path on the same drive letter.

For example, if the media drive is D: in Avid 3D, when the AAF is created, 
and the AAF and MXF files are copied over to an Avid machine, the MXF 
files must be found on the D: drive, under the same directory tree structure. 
The AAF file itself can be located anywhere.

Avid 3D automatically generates a unique name for an MXF media file by 
combining the clip name and a globally unique identifier (GUID). It is not 
possible to explicitly name the MXF files. New MXF files are created every 
time the clip is re-rendered. Existing MXF files are never replaced, and their 
names will never conflict with other media files.

n It is up to you to explicitly purge unused media files once they are no longer 
used by any sequence or clip. In Avid editing products, this is done with the 
“Media Tool.” MXF files produced in Avid 3D are managed the same way as 
media captured directly in Avid editing applications.

MXF and Alpha Information

MXF media files are video material and therefore do not contain the alpha 
information an RGBA image sequence provides. If you export alpha 
information for compositing, two MXF files are produced, one for the color 
track and the other for the alpha. The AAF master clip will contain a simple 
composition with a “Matte Key” effect that recombines these two media files 
in the destination application.

n MXF files are created in the YCbCr601 color space or YCbCr709 for high-
definition files.
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Setting Camera and Field Rendering Options for AAF/MXF

MXF media files are created to be ready for real-time video playback in the 
destination editing application. Several compression codecs are offered.

Setting Camera Options

When you create AAF/MXF files, the render camera must be set to the image 
size the destination application expects. You should use one of Avid 3D’s 
camera presets, and the pixel aspect ratio should be set to the default.

For more information about setting the render format options, see “Specifying 
the Format Options” on page 385.

Setting Field Rendering Options

You can use field rendering for smoother motion in NTSC or PAL. The 
destination application for the AAF file generally ignores information about 
whether or not Avid 3D rendered the sequence in fields. However, you should 
make sure to use the field order expected by the destination format.

The options for the Field Order setting on the AAF and MXF Options tab of 
the Render Options property editor correctly identify the required field order 
for NTSC, PAL, DV, or HD. If Field Order is set to Lower Field First (NTSC 
and DV Formats), Avid 3D always creates correct NTSC files, regardless of 
whether the destination application has the reverse meaning for Odd and Even.

Creating Movies

To create AAF/MXF, AVI, or QuickTime movie files, set the options on the 
AAF and MXF Options tab in the Render Options property editor as described 
in this section.

When the Create Movie option is activated, the movie file is created 
immediately after the last frame of the render is created. A separate progress 
bar is displayed so you can monitor the movie creation progress.

n AAF/MXF files or movie files are created only upon successful completion of a 
render, and then only if all of the rendered images in the sequence have been found.
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You can activate the Skip Rendered Frames option on the Frames Output tab 
of the Render Options property editor to complete an incomplete render, or to 
create the AAF/MXF or movie file from the existing image sequence without 
re-rendering the scene.

To create a movie file:

1. Click the Inspect Render Options button in the render and preview 
controls to open the Render Options property editor

2. Click the AAF and MXF Options tab. To enable AAF/MXF creation, 
select the Create Movie option.

3. Enter a file name and path in the path text box. You can specify a relative 
or absolute path.

4. Specify a Format. This can be either AAF, AVI, or QuickTime. Changing 
the format updates the file extension in the path.

n If QuickTime is not installed, creating a QuickTime movie will fail.

5. Click the Codec button to open a dialog box from which you can select 
and configure a codec to use for the output movie.

6. Toggle the Delete Frame Sequence On Success option as desired. When 
it’s activated, the rendered sequence is deleted if the movie file has been 
generated successfully.

7. Toggle the Write Alpha Channel option as desired to output the movie 
file with or without an alpha channel.

When this option is activated, and the Format is set to AAF, two MXF 
files are generated—one for RGB and one for alpha. The AAF master clip 
contains the information necessary for recombining the tracks.

n If the sequence was rendered to an image format that doesn’t support alpha 
channels (.jpg for instance), then the alpha file is not generated, irrespective of 
the Write Alpha Channel setting.

In the case of AVI and QuickTime movies, note that most compressors do not 
support an alpha channel.
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8. If you set the Format to AAF, set the following options in the 
Options section:

- Project Name: this is the name that will appear with the clip in the 
Avid application’s Media Tool. It does not have to match the actual 
project name in the Avid application.

- Avid Media Drive: specifies a valid system drive on which Avid 
media files are stored. When the AAF and MXF files are created, they 
are stored on this drive in the Avid MediaFiles > VideoStorage > 
Avid3D directory. For example, if the drive is set to D: this path will 
be D:\Avid MediaFiles\VideoStorage\Avid3D.

Changing this setting updates the path.

- Compression: specifies whether the generated MXF files should be 
compressed and, if so, the type of compression to use.

Optimizing a Scene for Rendering

The rendering process usually involves a trade-off between rendering speed 
and image quality. This section provides some useful tips to consider when 
building your scene, which can help you reduce your render times. Some 
suggestions can improve speed dramatically without sacrificing image quality, 
while others may involve a small but acceptable reduction of quality.

Object Geometry

Keeping rendering in mind when you construct a scene can help you reduce 
rendering time.

• Try to reduce the number of objects in each scene. Using fewer objects 
keeps the rendering time down.

• The more geometric detail an object has, the longer it takes to render. Try 
to substitute some of an object’s geometric detail with a texture map. 
From a distance, the difference may not be distinguishable.

• The more particle systems in the scene, the longer the scene takes to render.
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Textures

2D Textures

In general, using large texture files or a high number of textures in a scene will 
slow down rendering. Each 2D texture file must first be loaded into memory. 
This can result in memory swapping (transferring data between RAM and 
disk), which increases rendering time. For more information about 2D 
textures, see “2D Textures” on page 245.

• Consider a texture to be “large” when it is over 1000 pixels in any direction.

• For preview renders, use small, low-resolution texture files. For the final 
render, swap the low-resolution textures files for their high-resolution 
counterparts.

3D Textures

Whereas 2D textures are created from an existing file, procedural or 3D 
textures are mathematically calculated on demand. As a result, they take 
longer to render than projected 2D textures. 

Procedural textures do give a better rendered result close up because pixels can 
be recomputed (rather than interpolated) at close proximity. For more 
information about procedural textures, see “3D Textures” on page 246.

Bump Maps and Displacement Maps

Bump maps and displacement maps affect rendering performance to varying 
degrees, depending on the number of calculations required to render them. 

Generally, bump maps take much less time to render since they do not actually 
modify the geometry of the objects to which they’re applied. For more 
information about bump and displacement maps, see “Bump Maps” on 
page 255 and “Displacement Maps” on page 257.



Chapter 12 Output Options

394

Lights

Rendering time is directly affected by the number and type of lights. By carefully 
configuring the lights in your scene, you can speed up rendering considerably. 
For more information about lights, see “Lights and Cameras” on page 203.

• Use the minimum number of lights necessary. Each light adds to the 
overall rendering time.

• Lights that don’t cast shadows have a much lower impact on rendering time.

• If a light doesn’t have to calculate its effect on a component, it renders 
faster. By default, all lights affect both the diffuse and specular 
components. If you want a light to affect only a material’s specular or 
diffuse component, open the light’s property editor and check the 
appropriate Light Contribution options (diffuse and/or specular).
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2D textures 245
3D space 59

Cartesian coordinates 59
global and local coordinate systems 61
origin 60
planes 60
XYZ axes 59
XZY coordinates 60

3D textures 246

A
AAF files

exporting as 387
access keys 54
AI files

importing 187
preparing 187

angles, cone of light 213
animating parameter values

using onscreen parameters 91
animation 262

camera 331
constraints 319
copying 269
cycles 315
function curves 285
ghosting 268
keyframes 277
marking parameters for 265
math presets 330

on paths 323
playing 270
previewing in flipbook 333
removing 269

animation button 266
animation tree in function curve editor 287
aspect ratio

rendering 386
attenuation See falloff
audio

exporting with flipbook images 339
playing with animation 276

autokeying 284
AVI files 390
Avid 3D interface overview 52
Avid Mojo

configuring XSI for 70
outputting views to 69

B
background color, viewports 64
bend deformation 144
beveling

text and logos 189, 198
bulge deformation 145
bump maps 255

C
cameras

animating 331
depth of field 229
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direction 221
field of view 225
fixed-camera scenes 36
free-camera scenes 36
interest 220
interest animation 228
output 44, 385
positioning 223
projection methods 226
property editor 224
redoing moves 224
resetting position 224
rig 220
roll, animating 228
selecting 222
undoing moves 224
viewpoints 220
views 222

Cartesian coordinates 59
clusters

on text and logos 193
transforming on objects 170

colors
color editor 93
full color editor 94
setting for scene elements 92
sliders in property editors 92
surface of objects 239

commands
repeating 57

components
transforming 170

cone angle in light 213
constraints 319

activating and deactivating 330
direction 321
offsets between objects 329
path 323
position 320

control bar 53
curve deformation 161
cycles

function curves 315

D
deformations

about 140
animating 141
applying 140
bend 144
bulge 145
by curve 161
lattice 148
modifying 141
muting 142
on hierarchies 142
particles 348
push 145
quickstretch 150
removing 142
resetting 142
shape jitter 148
shear 146
taper 146
twist 147
vortex 147
wave 154

Delaunay tesselation method 196
deleting

points 172
polygons 172

depth of field
creating 229

direction constraints 321
directional lights See lights, infinite
displacement maps 257
display filters, hiding types of scene elements 75
display types in viewport 68
distance units 62
dollying in viewports 73
dotXSI files 136, 137

E
editing

scene element properties 80
editing properties

onscreen parameters 88
elasticity with obstacle collisions 373
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EMDL files 136
environment maps 36, 259
environments 36
EPS files

importing 187
preparing 187

exiting Avid 3D 33
exploding text and logos 194
exporting

flipbook 339
models 138
scene as AAF files 387
scene as MXF files 387

expressions (math presets) for animation 330
extrapolation

function curves 314
extruding

text and logos 188, 197

F
falloff

light 211
fan force 368
fcurves See function curves
field of view, setting 225
file types

.emdl 136

.pic 385

.xsi 136
flares

lens, creating 216
flipbook

exporting 339
exporting audio with images 339
playing 337
previewing animation in 333
standalone 334

font attributes 184
forces

applying to particles 370
creating 369
fan 368
gravity 367
hiding 370

muting 371
on particles 366
turbulence 368
wind 367

frame format 262
frame rate 262
frames

previewing a single 382
rendering start and end 385
skipping rendered 385
step (increment) between rendered 385

framing
in function curve editor 292
objects in viewports 72

friction with obstacle collisions 373
function curve editor 286

animation tree 287
graph 290
navigating in graph (frame, pan, zoom) 292
timeline in 288

function curves 285
adding and deleting keys on 301
cutting, copying, and pasting 308
cycles 315
displaying information about 292
extrapolating slope shape 314
hiding 292
interpolation type 309
moving 299
moving keys on 299
presets 318
regions of keys 298
scaling 305
scaling keys on 305
selecting 294
selecting keys on 296
slope 310
slope handles 311
snapping keys on 304
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G
ghosting animation 268
gizmo See manipulators
global coordinate system 61
glow

creating 218
graph in function curve editor 290
gravity force 367
grid in viewport 66

H
handles See manipulators
hiding

objects in viewports 74
types of scene elements (display filters) 75

hierarchies
deforming 142

I
image formats, types 385
importing

dotXSI files 137
image clips 137
models 136
scenes 136

interface overview 52
interpolation

function curves 309

K
keyboard shortcuts 54
keyframes 277

moving between 280
removing 278
setting 278
setting automatically 284
setting for transformations 283
setting in property editors 280

keys
access 54
shortcut 54

L
language preference

command-line option 32
lattice deformation 148
lens flares 216
Library panel 76
lights

about 204
adding 208
color 209
color editor and 210
cone angle and spread 213
creating 207
default light rig 207
falloff 211
glow effects 218
intensity 210
manipulating 208
manipulators 212, 213
point 205
properties 209
rendering 394
spotlights 205, 213
spread angle 213
types of 204

local coordinate system 61
logos

about 174, 176
accuracy and smoothness 193
adding to scene 187
applying materials and textures 191
beveling 189, 198
creating clusters 193
exploding 194
extruding 188, 197
mitering 198
offsetting curves 193
overview 176
rounding 198
tessellating 195
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M
manipulators

light 212, 213
spotlight 208

maps for textures 254
marking parameters 265
materials 238

applying to objects 238
applying to polygons 248
on text and logos 191
overlapping clusters 249
reflectivity 243
refraction 242
surface color 239
transparency 240

math presets for animation 330
Medial Axis tesselation method 197
menu bar 52
Minimum Polygon Count tesselation method 195
mitering

text and logos 198
models

exporting 138
importing 136

Mojo See Avid Mojo
motion blur

setting 386
mouse

information and status line 53
movie files 390
multi-purpose editor

editing properties in 80
overview 79

muting
deformations 142
forces 371
obstacles 373
viewports 63

MXF files
exporting as 387

O
obstacles

collision geometry 372
elasticity and friction 373
muting 373
setting objects as 372

onion-skinning 268
onscreen parameters 88

animating parameter values 91
editing values 90
font size 89

orbiting in viewports 73
origin, 3D space 60
orthographic camera 226
output

file, for rendering 384
output of scene (rendering) 382

P
panning

in function curve editor 292
in viewports 72

particles
animating the color 362
changing the particle type 360
collisions with obstacles 371
color 361
creating 344
deforming 348
deleting 348
direction of emission 356
editing in property editors 345
effects 377
forces on 366
hiding 351
length of life 360
length of simulation 353
mass 361
noise (random movement) 365
number of emitted 355
origin of emission 356
overview 342
Particle Billboard 377
Particle Gradient color 379
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Particle Shape 378
particle types 358
playing simulation 352
previewing in render region 350
selecting 347
size of 361
speed 356
spread of emission 358
sprite images on 374
viewing 349

path constraints 323
paths 323
perspective cameras 227
picture ratio 386
planes (XZ, XY, YZ) 60
playback

animation 270
audio with animation 276
controls 273
looping 274
particle simulations 352
real-time 275
real-time in flipbooks 333
timeline 270

playing
animation 270
flipbooks 337

points
adding to profile curves 166
deleting 172
deleting from profile curves 167
editing proportionally 168
moving on objects 171
moving on profile curves 167
transforming on objects 170
transforming on profiles 168

polygons
applying materials and textures to 248
deleting 172
transforming on objects 170

position constraints 320
previewing

frames for rendering 382
Mojo, outputting preview render to 69
scene output in render region 234

profile editor 164

profiles
about 162
adding points 166
deleting points 167
displaying 164
editing points proportionally 168
modifying 165
moving points 167
transforming points 168

projections
camera 226
for textures 253

projects
about 37
adding to project list 39
creating 38
default 40
deleting 40
folder structure 37
invalid 40
opening 39
scanning for projects 39
types 36

property editors 80
proportional mode 168
push deformation 145

Q
quickstretch deformation 150
QuickTime files 390

R
ratio

aspect 386
picture 386

real-time playback 275
in flipbooks 333

redoing
camera moves 224
edits 58

reflectivity 243
refraction 242
renaming scene elements 77
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render region 234
particles 350

Render window
Mojo, outputting to 69

rendering
aspect ratio 386
custom resolution 386
effects 386
end frame 385
global options 383
image format 385
motion blur 386
optimization 392
output file 384
previewing a frame 382
scene 382
start frame 385
step (increment) 385
to AAF and MXF files 387
to AVI files 390
to movie files 390
to QuickTime files 390

repeating commands 57
resetting

camera position 224
deformations 142

resolution
custom 386

rigs
light 207

rolling in viewports 73
rounding

text and logos 198
RTF files

exporting 185
importing 185

S
scene explorer 76
scenes

about 41
autosaving 47
backing up 48
correcting external file paths 46

creating 41
creating first project 32
deleting 44
importing 136
opening 42
recovering 49
resolution 44
saving 44
types 36

selecting
elements in scene explorer 77
function curves 294
keys on function curves 296

shadows
creating 214

shape jitter deformation 148
shear deformation 146
shortcut keys 54

sticky and temporary (supra) modes 56
snapping

keys on function curves 304
spotlights

3D manipulators 208
cone angle and spread 213
setting 213
spread angle 213
view from 214

spread, cone of light 213
sprite images on particles 374
standalone flipbook 334
starting Avid 3D

command-line 31
creating first project 32
shortcut 30
Start menu 30
startup options 31

sticky key mode for shortcut keys 56
support objects for textures 253
surfaces of objects

materials 238
textures 245
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T
tangency constraint for paths 327
taper deformation 146
temporary (supra) mode for shortcut keys 56
tessellating text and logos 195
text

about 174, 175
accuracy and smoothness 193
adding to scene 179
alignment 185
applying materials and textures 191
beveling 189, 198
character spacing 186
creating a rig 200
creating clusters 193
editing 181
exploding 194
exporting RTF files 185
extruding 188, 197
fonts 184
formatting 181
importing RTF files 185
mitering 198
offsetting curves 193
overview 175
rounding 198
size 186
tessellating 195

text rigs 200
texture clip viewer 247
texture maps 254
textures 245

2D 245
3D 246
applying to an object 246
applying to polygons 248
bump maps 255
displacement maps 257
environment maps 259
on text and logos 191
projections and supports 253
removing 248
rendering 393
repeating and tiling 247
texture clip viewer 247

transparency maps 258
timeline 270

in function curve editor 288
range 272

title bar 52
tools and options panel 78
transformations

setting keys for 283
spotlight 208

transforming
components 170
points on profiles 168

transparency 240
transparency maps 258
turbulence force 368
twist deformation 147

U
undoing

camera moves 224
edits 58

units, distance 62

V
viewing

captured animation 333
flipbooks 333

viewports 62
background color 64
camera views 66
display types (wireframe, textured, shaded, 

constant, etc) 68
dollying 73
framing objects in 72
grid 66
hiding objects 74
hiding types of scene elements 75
Mojo, outputting to 69
muting and soloing 63
orbiting in 73
panning 72
resetting the view 74
resizing 64
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rolling 73
spotlight view 68
User view 67
viewpoints (Top, Front, Right) 67
zooming 72

vortex deformation 147

W
wave deformation 154
wind force 367

X
XYZ axes 59
XYZ coordinates 60

Z
zooming

in function curve editor 292
in viewports 72
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